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The Rhapsody API—Introduction

The Rhapsody API allows you write applications that access and manipul ate Rhapsody model
elements. Two versions of the API are provided with Rhapsody:

¢+ COM

* Java

Information Available to the API

The Rhapsody API facilitates reading, changing, adding to, and deleting from all model elements
that are available in the Rhapsody browser. The browser displays the static elements of a model
including, but not limited to, the following:

¢ Model information

¢ Descriptions and other information within browser forms

+ Information describing the model hierarchy, components, and packages

¢ Configurations and profiles

+ Features and properties
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The Rhapsody API—Introduction

¢ File and directory names

¢ Diagramsin aform that can be printed or included in external files for printing, such as
Microsoft® Word®

Hierarchy of API Interfaces

The class diagram depicts the hierarchical relationships between the API interfaces. The
application (I RPAppl i cat i on) isthe top-level object of the Rhapsody abject model. The
hierarchy of the API interfacesis asfollows:

IRPApplication
IRPASCIIFile
IRPCollection
IRPExternalCodeGenerator
IRPExternalCodeGeneratorInvoker
IRPFlow
IRPGraphElement
IRPGraphEdge
IRPGraphNode
IRPGraphicalProperty
IRPModelElement
IRPAction
IRPAnnotation
IRPComment
IRPConstraint
IRPRequirement
IRPAssociationRole
IRPClassifierRole
IRPCollaboration
IRPComponentInstance
IRPConfiguration
IRPDependency
IRPHyperLink
IRPEnumerationLiteral
IRPExecutionOccurrence
IRPFile
IRPGeneralization
IRPGuard
IRPInteractionOccurrence
IRPInterfaceltem
IRPEvent
IRPEventReception
IRPOperation
IRPLink
IRPMessage
IRPMessagePoint
IRPStateVertex
IRPConnector
IRPState
IRPStereotype
IRPSwimlane
IRPTemplateInstantiation
IRPTemplateInstantiationParameter
IRPTransition
IRPTrigger
IRPUnit
IRPClassifier
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Hierarchy of API Interfaces

IRPActor
IRPClass
IRPAssociationClass
IRPFlowItem
IRPNode
IRPType
IRPUseCase
IRPComponent
IRPDiagram
IRPCollaborationDiagram
IRPComponentDiagram
IRPDeploymentDiagram
IRPObjectModelDiagram
IRPSequenceDiagram
IRPStatechart
IRPFlowchart
IRPStructureDiagram
IRPUseCaseDiagram
IRPPackage
IRPProfile
IRPProject
IRPRelation
IRPInstance
IRPBlock
IRPModule
IRPPort
IRPVariable
IRPArgument
IRPAttribute
IRPTag
IRPTemplateParameter
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Using the Rhapsody Java APl—Basic
Concepts

In terms of its capabilities, the Rhapsody Java API isidentical to the Rhapsody COM API. The
reference material for the COM API can be used to see what you can do with the Java API. The
names of the objects, attributes, and methods in the Java APl are more or less the same asthose in

the COM API.

For the details of the Rhapsody Java API, see the Javadoc output for the API, which can be found
at [rhapsody installation directory]\Doc\java_api\index.html.

A sample that uses the Java version of the Rhapsody API can be found in the directory:
[Rhapsody installation directory]\Samples\JavaAPI
A more advanced sample can be found in the directory:

[Rhapsody installation directory]\Samples\CustomCG
Samples\Satechart Smplifier Writer\Qatechart_Java Smplifier

Rhapsody API - Java Version

Beginning with version 7.0, Rhapsody includes a Java version of the Rhapsody API that can be
used for working with Rhapsody models. Since the Java APl can be used on both Windows and
Linux, this API alows you to write cross-platform applications.
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Using the Rhapsody Java APlI—Basic Concepts

Using the Java Version of the API

Rhapsody provides two files that can be found in the directory [installation directory] Share/
JavaAPI:

¢ Rhapsody.jar—contains the Java classes and interfaces

¢ Rhapsody.dll (or Rhapsody.so for Linux)—native implementation of the Java interfaces

The .jar file should be included in the CLASSPATH of the Java project, and the .dll (or .so file)
should be included in the lib path.

To access the Rhapsody application, you use the object Rhapsodyappserver. See the API javadoc
output for details.

Issues Specific to the Java Version of the Rhapsody
API

¢ Methodsin the Javaversion of the APl throw RhapsodyaPTException exceptions. You
can use the tostring method to get the description of the exception.

¢ IRPCollection providesamethod called toList that returns a native Javalist container
populated with the elements of the collection. Thisis the recommended method of
iterating over collections with the Java version of the API. (In Java 1.5, you can cast the
list to atypeslist and thus benefit from the for-each iterator.)

¢ Unlikethe COM version of the API, where you have to use the

IDispatch: :QueryInterface method, inthe Javaversion, you can use the native Java
operator instanceOf.

¢ To check whether two interfaces point to the same model element, you should use the
native boolean Object.equal s(Object) method.

Initializing Rhapsody Environment before Using
Rhapsody APl on Linux

Aninitialization script called rhp_env (located in the root of the Rhapsody installation directory)
must be run before using Rhapsody on Linux.

Thisis done automatically when Linux users launch Rhapsody as described in the documentation.
However, this script must also be run by Linux users who run Java applications that include use of
the Rhapsody API.
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Initializing Rhapsody Environment before Using Rhapsody APl on Linux

When you write a Java application that includes use of the Rhapsody API, make sureto inform the

users of the application that they must run the initialization script prior to running the Java
application.

Alternatively, you can try to automate this process for the users of your application, for example,
by having the script run as part of each users Linux startup process, or by including a call to this
script in the script file you provide for launching your Java application (provided, of course, that
Rhapsody is installed in the same location on each users computer).
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Using the Rhapsody COM API—Basic
Concepts and Examples

The Rhapsody Repository API consists of a set of COM interfaces that supports dual interfaces
(COM and automation). Thisalows accessfrom Visual Basic and any language implemented with

COM bindings. COM interfaces allow access from either Visual Basic® or VBScript, even when
type information is not available (for example, OLE automation).

Note

See http://www.urc.bl.ac.yu/manuals/vbscript/ch13fi.htm for acomparison of Visual Basic,
VBA, and VBScript.

Each interface represents a class in the Rhapsody repository, and the set of interfaces forms the
Rhapsody object model. Each instance in the Rhapsody repository returns areferenceto a
particular COM interface based on its metaclass. For example, access to an event in the Rhapsody
repository isviathe | RPEvent interface.

Using the API

The following sections describe how to use the Rhapsody COM API with the following tools and
languages.

¢ Using the APl with Visual Basic

¢ Using the API with Visual Basic for Applications

¢ Using the API with VBScript

¢ Using the APl with Visual C++

¢ Using the API with Java

Rhapsody 9
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Using the Rhapsody COM APl—Basic Concepts and Examples

Using the API with Visual Basic

Like all COM-based APIs, two components are required to create Rhapsody automation scripts:

¢ The Rhapsody COM typelibrary, r hapsody. t | b. COM type libraries are self-
documenting and easy to browse using COM object viewers.

+ A Rhapsody executable providing COM server functionality.

In Visua Basic, attach ther hapsody. t | b library to the project by selecting Project >
References. This familiarizes the VB environment with the Rhapsody API interfaces. No further
action isrequired. VB implicitly connects to the Rhapsody server (r hapsody. exe) oncethe VB
application is executed.

Example

The following VB program shows an example of how to traverse al the classes and add a serial
number property (initialized to 0) to each one.

Public Sub SetClassesInPackage (p As IRPPackage)
‘' Routine to add recursively a property to all classes in
‘a package

Dim allClassifiers As RPCollection
Set allClassifiers = p.nestedClassifiers
Dim ¢ As RPClassifier
For each ¢ in allClassifiers
isClass = c.isOfMetaClass ‘Class’
If isClass Then
On error resume next
If not c.addProperty(‘general:class:serialNo’,
‘int’, ‘0’) then
If not err.Number then
Print ‘class can’t be assigned a
property’, c.name
end if
Else ' Check for nested packages
isPackage = c.isOfMetaClass ‘Package’
If isPackage Then ‘' nested package case
Dim nestedP as Package

Set nestedP = ¢ ' cast classifier to package
SetClassesInPackage nestedP
End If
End If
Next

End Sub

‘' The main program

Dim Rph As Object

Dim ProjName As String

Dim Prj As RPProject

Dim Packages As RPCollection

Set Rph = CreateObject ("Rhapsody.Application")
ProjName = ‘D:\Rhapsody\Examples\PingPong.rpy’
Rph.OpenProject projName

10
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Using the API

Set Prj = Rph.activeProject
Packages = Prj.packages

Dim p As RPPackage

For each p in allProjectClassifiers

SetClassesInPackage p
Next

Using the API with Visual Basic for Applications

Visua Basic for Applications (VBA) isan OEM version of Microsoft Visual Basic, whichis
integrated as an automation engine into the Microsoft Office family and ultimately intended for all
Microsoft tools. It provides a complete application devel opment environment based on Visual
Basic.

With VBA, you can devel op automation and extensibility scripts that interact with the tool
repository that provides a full complement of user interface components (“forms’). Thereis
virtually no limit to application extensibility that can be achieved using VBA. Conceptually, it
would be possible to completely transform the hosting application into another application using
VBA extensibility.

The VBA Project File

A VBA project isafile container for other files and components that you use in Visual Basic to
build an application. After all the components have been assembled in a project and code written
for it, you can compile the project into an executable file.

Each Rhapsody project is associated with asingle VBA project that contains al VBA artifacts
(scripts, forms, and so on) that you created within the Rhapsody project. This project file has the
name <pr oj ect name>. vba andislocated in the same directory as the Rhapsody project file
(<pr oj ect >. r py). Thishinary file will be loaded (if present) with the Rhapsody project and
saved when you select Save from Rhapsody or the VBA IDE.

How VBA and Rhapsody Interact

The basic interaction between VBA and Rhapsody is facilitated through the Rhapsody COM API,
similar to the way Visual Basic interacts with Rhapsody using API external programs. Rhapsody
exports a set of COM interfaces that represent its metamodel objects, aswell asits application
operational functions. Through the COM interfaces, aVVBA macro can easily access al the
Rhapsody objects and manipulate them.

VBA Versus VB Programs

The major difference between writing API external programs with VB and writing VBA scripts
inside Rhapsody is the availahility of the Rhapsody root object, known as the Rhapsody
application. External VB programs need to create a Rhapsody application object; Rhapsody VBA
scripts have direct access to the already existing application object.
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Using the Rhapsody COM APl—Basic Concepts and Examples

Whether accessed by VB or VBA programs, operations of the Appl i cat i on object areidentical
in function. To the VBA user, however, it looks like all the methods of the root object are local
methods in the VBA context. For example, traversing the Rhapsody model always starts with
accessing the project object. The following example shows a VBA script that displays the name of
the project:

Dim a as Object
Set a = getProject
MsgBox a.name

Note
The method get Pr oj ect isafunction of the root object.

VBA Macros

Rhapsody allows you to program a script (or “macro”) in the Microsoft Visual Basic programming
language to perform automated activity.

To write a Visual Basic macro for Rhapsody, follow these steps:
1. LaunchtheVBA IDE in one of the following ways:

a. Select View > VBA Toolbar, then select the first icon from the | eft to launch the
VBA IDE.

b. Select Tools>VBA, then select Visual Basic Editor from the popup menu.

2. Edit the Visual Basic project file, <pr oj ect >. vba, to implement different macros. Once
you are finished editing, exit the VBA IDE and save the Rhapsody project. The VBA
project is automatically saved whenever the Rhapsody project is saved.

Later, you can run a Rhapsody VBA macro from the Macros dialog box or as a hel per in the Tools
menu. In addition, macros can be shared with other users through the macro exporting and
importing process.

Note that helper applications might not close the current document. This means that you should
not use the following API methods in aVBA macro that you specify as a helper:

Method Interface Object
guit | RPApplication
openProject | RPAppl i cation
close | RPPr oj ect
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Creating and Editing Macros

You can create a new macro or edit an existing macro in two ways:

+ Using the VBA Macros dialog box in Rhapsody

— To create amacro, type in a new name in the M acro Name field, then select
Create.

Note: Since VBA macros are contained in modules, you must first create a module
before creating your first macro. If you have not yet created a module, the
Create button will be grayed-out. Modules cannot be created from the Macros
dialog. You must open the VBA |IDE to do so.

— To edit amacro, highlight the existing macro in the Macro dialog box, then
select Edit.

¢ Launchthe VBA IDE and create and edit new macros there. There, you can do one of the
following:

— Select Tools > Macros to open the Macros dialog box.

Start typing the new macro with the line Sub xxxx () , where xxxx isthe name
of the new macro. The last line of the macro must be “End Sub.”

— Find an existing macro by expanding the Modules folder of the Project
window and double-clicking the appropriate module. You can scroll the code
window to the existing macro or select it in the right pull-down above the
code window.

Sample VBA Macro
Thefollowing isasimple VBA macro:

Sub GetNameOfProject ()
Dim a as Object

Set a = getProject
MsgBox a.name

End Sub

Once you have finished typing this macro, return to the Rhapsody window and run the new macro
through the Macros dialog box. You will see a small message box with the name of the currently
loaded project.
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Using the Rhapsody COM APl—Basic Concepts and Examples

VBA Macros Dialog Box
The VBA Macros dialog box enables you to run, edit, or delete a macro.

To open the Macros dialog box, use the VBA Toolbar shortcut or select Tools > VBA > Macros.
The following figure shows the Macros dialog box.

tacro name:

|

'
Macros in: | <&l Standard Modules and Docurmnentss ﬂ

Dezcriphion:

The dialog box contains the following fields:
+ Macro Name—Contains the name of the highlighted macro in the Macro Box field. This
field isblank if there are no macrosin the Macro Box.

¢ Macro Box—Liststhe available macrosin the VBA project selected inthe Macros|n
box.

¢ Macros | n—Liststhe available VBA projects that contain macros.
The dialog box contains the following buttons:

¢ Run—Runs the selected macro.
To run amacro, highlight a macro in the Macro box, then click Run.
+ Sep Into—Highlightsthefirst line of the macro and places the Current Execution Line
Indicator.

+ Edit—Opens the Code window with the selected macro visible so you can modify your
macro.

To edit amacro, highlight the macro in the M acro box, then click Edit.

¢+ Create—Opens amodulein the Code window so you can create a new macro.
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Using the API

To create amacro, type in anew name in the Macro Name field, then click Create.

Note: Since VBA macros are contained in modules, you must first create a module
before creating your first macro. If you have not yet created a module, the
Create button will be grayed-out. Modules cannot be created from the Macros
dialog. You must open the VBA |IDE to do so.
¢+ Delete—Removes the selected macro from your project.
To delete amacro, highlight a macro in the M acro box, then click Delete.
Saving Your Macros

Rhapsody VBA macros are saved automatically with your Rhapsody project. When you load the
project again, the macros you have created for it will be available.

Exporting and Importing VBA Macros

To export amodule’'s VBA macros from the VBA IDE, follow these steps:
1. Select amodule from the modulestree.
2. FromtheVBA IDE, sdlect File> Export File.

3. Inthe Export Files dialog box, browse to the correct location and enter the name of the
receiving file.

4. Select OK to dismissthe Export Files dialog.

Rhapsody also enables you to import an existing module or form to the project. To import VBA
macros, follow these steps:

1. FromtheVBA IDE, select File> Import File. The Import Files dialog box is displayed.
2. Browseto the correct location and select the file to import.

A copy of thefileis added to the project and the original fileisleft intact. If you import aform or
modul e with the same name as an existing form or module, the new form or module file is added
with anumber appended to its name.
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Using the Rhapsody COM APl—Basic Concepts and Examples

Using the API with VBScript

Most Rhapsody users on Windows platforms can use the Visual Basic IDE programming
environment or VBA, which are not available on a Solaris platform. However, Rhapsody users on
Solaris platforms can access the Rhapsody API using VBScript (Visual Basic Scripting edition), a
cross-platform development language.

Running VBScript
The setup for running VB Script scripts is done during installation. Note the following:

1. Beforerunning aVBScript script, you must run Rhapsody at least once for registration of
the COM interfacesin the registry.

2. Runthe VBS script located in the Rhapsody home directory.

3. Usethevbst est program by Mainsoft™ to run vbs programs.

VBScript samples are available in the Sanpl es/ Vbs directory of the Rhapsody installation.

Writing Files from VBScript

Some of the elements of Visual Basic are not included in VBScript, such as file input/output
functions. Rhapsody compensates for this with the addition of aFi | e object to the Rhapsody
COM library to facilitate reading and writing to files. To write to files, use code similar to the
following in your script:

rem Create a rhapsody object.

rem Create and open a file object.
Set F = CreateObject ("Rhapsody.RPASCIIFile")

rem Use it to open a file.
F.open "/tmp/show.txt"

rem Use is to write to the file with VB script commands.
F.write "Succeeded in opening project " + vbLf

rem Close the file when finished with it.
F.close
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Example VBScript

Thefollowing VB Script script dumps packages, classes, and events. It isincluded in the Rhapsody
installation.

Dim rappl

Dim appl

Dim p

Dim s

Dim ¢

Dim pack

Dim F

Set rappl = CreateObject ("Rhapsody.Application")
Set F = CreateObject ("Rhapsody.RPASCIIFile")
F.open "/tmp/show.txt"

F.write "Succeeded in opening project " + vbLf

MsgBox "Started Rhapsody"+rappl.version

s = "/diskl/RP/Samples/Pingpong/pingpong.rpy"
rappl.openProject s
Set p = rappl.activeProject

Set ¢ = p.components
For Each pack In c

MsgBox pack.Name
Next

dim NextPack, NextOperation

rem Lets send them to a file

level=1
ShowPackages p, level

F.close
MsgBox "Done listing the Project"

sub ShowPackages (p, levelPack)
CallLevelPack = levelPack + 1
Set Pk = p.packages
For Each Pack In Pk
PrintSpace levelPack
F.write"Package: "+pack.Name+vbLf
ShowClasses Pack, CallLevelPack
CallLevelClass = levelClass + 1
ShowEvents Pack, CallLevelPack
Next
End Sub

sub ShowClasses (Pack, levelClass)
CallLevelClass = levelClass + 1

set NextPack = Pack.Classes
PrintSpace levelClass
F.write"Classes::"+vbLf
For Each Class In NextPack
PrintSpace levelClass
F.writeClass.Name+"::"+vbLf
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ShowOperations Class, CallLevelClass
CallLevelClass = levelClass + 1
ShowAttributes Class, CallLevelClass
Next
End Sub

sub ShowOperations(Class, levelOperation)
CallLevelOperation = levelOperation + 1
set NextOperation = Class.Operations
PrintSpace levelOperation
F.write"Operations: :"+vbLf

for Each Operation in NextOperation
PrintSpace CallLevelOperation
F.write"::"+Operation.name+vbLf
CallLevelClass = levelOperation + 1
Next
End Sub

sub ShowAttributes (Class, levelAttribute)
CallLevelAttribute = levelAttribute + 1
set NextAttribute = Class.Attributes
PrintSpace levelAttribute
F.write"Attributes: :"+vbLf
for Each Attribute in NextAttribute
PrintSpace CallLevelAttribute
F.write"::"+Attribute.name+vbLf
Next
End Sub

sub ShowEvents (Pack, levelEvent)
CallLevelEvent = levelEvent + 1

set NextEvent = Pack.Events
PrintSpace levelEvent
F.write"Events: :"+vbLf

for Each RHPEvent in NextEvent
PrintSpace CallLevelEvent
F.write"::"+RHPEvent .name+vbLf
Next
End Sub

sub PrintSpace (levelPrint)
For x = 1 to levelPrint
F.write ""
Next
End sub

18
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Using the API with Visual C++

Like all COM-based APIs, two components are required to create Rhapsody automation scripts:

¢ The Rhapsody COM typelibrary, r hapsody. t | b. COM type libraries are self-
documenting and easy to browse using COM object viewers. One such viewer is provided
in the Shar e directory of the installation.

+ A Rhapsody executable providing COM server functionality.

The class wizard can create Rhapsody proxy objects by attaching to ther hapsody. t | b library.
This requires the VC++ project also to be COM-enabled.

The important steps in setting up the COM interface are as follows:

1. Includean#i nport statement. For example:

#import "C:\Rhapsody\rhapsody.tlb" no namespace
named_guids

This statement makes C++ recognize the various interfaces as C++ classes.

2. Invokether hapsody. appl i cati on object. For example:

IRPApplication apl = NULL;
hr = CoCreatelInstance (CLSID RPApplication,
NULL, CLSCTX ALL, IID IRPApplication, (void**)&apl) ;

3. Access elements of ther hapsody. appl i cat i on object through APl methods. For
example:

// Get project file name
IRPProjectPtr proj = NULL;
hr = apl-s>openProject (projectFileName, &proj) ;

// Get count of packages in project

IRPCollectionPtr collection;

hr = proj->get packages(&collection) ;

long elementsCollectionCount;

hr = collection->get Count (&elementsCollectionCount) ;

The following two examples demonstrate how to invoke Rhapsody from a C++ client using direct
COM cdllsto the Rhapsody API interface.

Rhapsody 19



Using the Rhapsody COM APl—Basic Concepts and Examples

Sample: Reading from the API

Thefollowing exampleisthe primary filein aVisual C++ workspace application that reads from a
Rhapsody project using the COM API interface.

//
// ReadAPI.cpp : Defines the entry point for the console
//application.

#include "stdafx.h"

#include <stdio.h>

#include <stdlib.h>

#include <atlbase.h>

// The following depends on the place that Rhapsody is
//installed

#import "F:\Documents\RiCPP_2.3MR1l\Rhapsody\rhapsody.tlb"
raw_interfaces_only, no namespace, named_guids

void printBSTR(BSTR errorMessage)

LPCWSTR tmpName = errorMessage;
char buf[1000];

int tmpNameLen = tmpName != NULL ? wcslen (tmpName) :0;
if (tmpNameLen != 0)
wcstombs (buf, tmpName, (tmpNameLen*2)+1);
printf (buf) ;
printf ("\n") ;

}

void printErrorMessageIlfError (HRESULT hr,
IRPModelElement* modelElement)
{

if (FAILED (hr))

BSTR errorMessage;
HRESULT tmpHr ;
tmpHr = modelElement
>getErrorMessage (&errorMessage) ;
} printBSTR (errorMessage) ;

}

int loadProject (const char* rpyFileName)

HRESULT hr;

CLSID clsid;

hr = CLSIDFromProgID (OLESTR ("Rhapsody.Application"),
&clsid) ;

if (FAILED (hr))

printf (_T("Failed to resolve CLSID. HR =
0x%8x") ,hr) ;
return 0;

// Create CoClass instance from ClassId, using
dispatch iid
IRPApplicationPtr apl;
hr = ::CoCreatelInstance( CLSID RPApplication, NULL,
CLSCTX_ALL, IID IRPApplication, (void**)&apl );
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if (FAILED (hr))

printf( T("Failed to create instance. HR =
0x%8x") ,hr) ;
return O;

int len = MultiByteToWideChar (CP_ACP, 0, rpyFileName,
strlen (rpyFileName), NULL, NULL) ;

BSTR projectFileName = SysAllocStringLen (NULL, len);

MultiByteToWideChar (CP_ACP, 0, rpyFileName,
strlen(rpyFileName), projectFileName, len);

IRPProjectPtr proj = NULL;

hr = apl-sopenProject (projectFileName, &proj) ;

SysFreeString (projectFileName) ;

IRPCollectionPtr collection;

hr = proj->get packages (&collection) ;

long elementsCollectionCount;

hr = collection->get Count (&elementsCollectionCount) ;

BSTR packageName;

VARIANT r;

for ( int 1 = 1; 1 <= elementsCollectionCount; i++)

IRPPackagePtr p;

hr = collection->get Item(i, &r);

hr = r.pdispVal->QueryInterface(IID IRPPackage,
(void**) &p) ;

hr = p->get name (&packageName) ;

printBSTR (packageName) ;

}

hr = apl->quit();
return 0;

void Usage ()
printf ("Usage: ReadAPI rpyFile\n");

// General remark: In the following, in most cases there
// is no check on the returned hr for readability.
int main(int argc, char* argv[])

HRESULT hr;
hr = CoInitialize(0);
if (FAILED (hr))

printf (_T("Failed to initialize COM")) ;
} return 0;
if (argc == 2)
loadProject (argv([2]) ;
else
Usage () ;
// loadProject ("D:\\Temp\\Project.rpy") ;
CoUninitialize() ;
return 0;

Rhapsody
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Sample: Writing to the API

The following exampleisthe primary file in a Visual C++ workspace application that writesto a

Rhapsody project using the COM API interface.

Note

Change the #i nport lineto match your own project.

//

// WriteAPI.cpp : Defines the entry point for the console

// application.

#include "stdafx.h"

#include <stdio.h>

#include <stdlib.h>

#include <atlbase.h>

// The following depends on the place that Rhapsody is

// installed

#import "D:\Rhapsody\rhapsody.tlb" raw_interfaces only,
no_namespace, named _guids

void printBSTR(BSTR errorMessage)

LPCWSTR tmpName = errorMessage;

char buf [1000];

int tmpNameLen =

if (tmpNameLen !=
wcstombs (buf, tmpName, (tmpNameLen*2)+1);
printf (buf) ;
printf ("\n") ;

}

}

void printErrorMessageIlfError (HRESULT hr,

{ IRPModelElement* modelElement)

if (FAILED (hr))

BSTR errorMessage;

HRESULT tmpHr;

tmpHr = modelElement->getErrorMessage (
&errorMessage) ;

printBSTR (errorMessage) ;

}

tmpName != NULL ? wcslen (tmpName) :0;
0)

int createNewProject (const char* userDirectoryName, const

char* userProjectName)
HRESULT hr;

hr = CoInitialize(0);
if (FAILED (hr))

printf (_T("Failed to initialize COM")) ;
return 0;

CLSID clsid;

hr = CLSIDFromProgID (OLESTR ("Rhapsody.Application"),

&clsid) ;
if (FAILED (hr))

printf( T("Failed to resolve CLSID. HR =

22
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0x%8x") ,hr) ;
return O0;

// Create CoClass instance from ClassId, using

// dispatch iid

IRPApplicationPtr apl;

hr = ::CoCreatelInstance( CLSID RPApplication, NULL,
CLSCTX ALL, IID IRPApplication, (void**)e&apl );

if (FAILED (hr))

printf( T("Failed to create instance. HR =
0x%8x") ,hr) ;
return O;

IRPProjectPtr proj = NULL;

int len = MultiByteToWideChar (CP_ACP, O,
userDirectoryName, strlen(userDirectoryName), NULL,
NULL) ;

BSTR projectLocation = SysAllocStringLen (NULL, len);

MultiByteToWideChar (CP_ACP, 0, userDirectoryName,
strlen (userDirectoryName), projectLocation, len);

len = MultiByteToWideChar (CP_ACP, 0, userProjectName,
strlen (userProjectName), NULL, NULL) ;

BSTR projectName = SysAllocStringLen (NULL, len);

MultiByteToWideChar (CP_ACP, 0, userProjectName,

strlen (userProjectName), projectName, len);

hr = apl->createNewProject (projectLocation, projectName) ;
hr = apl-sactiveProject (&proj) ;
SysFreeString (projectLocation) ;
SysFreeString (projectName) ;

IRPPackagePtr package;

BSTR packageName = SysAllocString(L"myPackage") ;
hr = proj->addPackage (packageName, &package) ;
SysFreeString (packageName) ;

IRPClassPtr newClass;

BSTR className = SysAllocString(L"myClass") ;
hr = package->addClass (className, &newClass) ;
SysFreeString (className) ;

IRPOperationPtr operation;
BSTR operationName = SysAllocString(L"myOperation") ;
hr = newClass->addOperation (operationName,
&operation) ;
SysFreeString (operationName) ;

IRPAttributePtr attribute;

BSTR attributeName = SysAllocString(L"myAttribute");

hr = newClass->addAttribute (attributeName,
&attribute) ;

SysFreeString (attributeName) ;

hr = proj->save();
hr = apl->quit();
CoUninitialize() ;
return 0;

}

void Usage ()

printf ("Usage: WriteAPI directoryName projectName\n") ;
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// General remark: In the following, in most cases there
// is no check on the returned hr for readability.
int main(int argc, char* argv[])

HRESULT hr;
hr = CoInitialize(0);

if (FAILED (hr))

printf ( _T("Failed to initialize COM")) ;
return 0;

}

if (argc == 3)
createNewProject (argv[2], argv[3]);
else
Usage () ;
// createNewProject ("D:\\temp\\Project", "Project");
CoUninitialize() ;
return 0;

Using the API with Java

Javavirtual machines do not communicate directly with the COM layer. In order to communicate
with COM servers from any Java program, including Rhapsody-generated Java programs, use
tools that bridge the two technologies such as

MS/J++ or FIntegra (http://iwww.intrinsyc.com). Refer to the M S J++ documentation (http://

support.microsoft.com/directory/default.asp) for more information.
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Manipulating Project Elements

The following sections describe how to create, modify, and delete Rhapsody project elements.

Creating a Project Element
There are two ways to add a new Rhapsody element:

+ Add anew object while the project is still open in Rhapsody using the method

addNewAgar 0n an owner object, supplying the metatype, name, and receiving the newly
created object.

The syntax for the call is as follows:
owner . addNewAggr ( et aType, nane);

In this call, nmetaType and nane are String expressions for the type
and name of an object with which to form an aggregation relation with
an owner object.

For example, if apackage p is present in your open model, you can execute the
following code in Visual Basic:

Dimc as RPC ass
¢ = p. AddNewAggr (" C ass","C'");

When finished, the new class C is added to package p.

¢ Thereareadso addObj ect methods available for every object. For example:

Dimcl as RPC ass
Dimattr as RPAttribute
Set cl = Package. Addd ass("C");

Set attr = Class. AddAttribute("att");

The objects created are connected to their owner. Even a new project
can be created using a special method.

Note: Do not use the VB methods cr eat eObj ect or cr eat el nst ance to create
new elements. The only correct way to create new elementsis with the
addNewAggr method or the specific addObj ect methods.
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Modifying an Element

When you attempt to modify an object through an API method, you call the appropriate method,
such asset Name( newNane) . Rhapsody checks the permissions, and returns one of the values
listed in the following table.

Return State Description

YES The operation is performed and returns without error.
For example, you want to name a class “A”.

NOOP The operation is not performed and returns without error.

For example, you want to name a class “A”, but it already
has that name.

NO The operation is not performed and returns with an error.
For example, you want to name a class “A”, but it is read-
only, or there is already a class named “A” present. The
error message RP_CANT_MODI FY is returned as the
error message for this method.

WARNING You can choose from two working modes:
* Force mode on? WARNING is regarded as YES.
» Force mode off? WARNING is regarded as NO.

MERGE The operation is not performed as if a NO is returned.
Merge routines are available.

Deleting an Element

The method deleteFromProject deletes an object from its package. In addition, there are
Del et e XXXX methods that del ete elements of a core object.

In the following examples, cl and att are wrappersto their core objects.

Package.DeleteClass(cl) ;
Class.DeleteAttribute (att) ;

Only cl =NULL andatt = NULL inaVisual Basic application will delete the wrapper itself.
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Handling Properties Using the API

Rhapsody model elements can have name/value pairs, known as properties, that extend the model
in some way. They provide, for example, instructions for code generation, additional application-
dependent properties, and so on.

The name (or key) part of the name/value pair isastring that must consist of three qualifying fields
separated by a period. For example:

<lang> CG.Configuration.Environment

Thefirst of the three fields designates a subject, such as code generation, reverse engineering, and
so on. The second field designates the metaclass (or stereotype) to which the property applies. The
third field designates the name of the property.

The value part of the name/value pair is a string that can be interpreted as either a string value, an
integer, a Boolean, or an enumerated type. For example, “Microsoft” is one of the enumerated
values “Microsoft, MicrosoftDLL, VxWorks, Solaris2, Borland, MSStandardLibrary, PsosX 86,
PsosPPC, MicrosoftWinCE, OseSfk, Linux, Solaris2GNU, QNXNeutrinoGCC,
QNXNeutrinoCW, OsePPCDiab” for the key <l ang>_CG. Confi gur ati on. Envi r onnent .

For a given property name, a Rhapsody model element can have either a specific value (avalue
givento it by either a user or Rhapsody), or a default value, which it finds by searching a
predefined search path. For some keys, it is possible to have no value at all.

Propagation of Default Property Values

To facilitate assignment of values to groups of model elements rather than a single model element
each time, Rhapsody implements a propagation mechanism where property values propagate
along the containment hierarchy. The propagation originates at the f act or y. pr p file, continues
to the project through the si t e. pr p file, and then on to the configuration and model containment
hierarchy.

For example, consider aclass C1 that is nested in a package P11 that is nested in a package P1.
Class Cl1 is denoted by the expression P1:: P11:: C1. Assumethat for all the classesin P11 the
statecharts should not be implemented (generated). To do this, the property

CG. O ass. | npl enent St at echart should be set to Fal se for package P11. By default, all
classeswithin P11 (recursively) “inherit” thisvalue, unless overridden. If thisbehavior isrequired
for the entire project, this property should be set to Fal se at the project level.

Note

The propagation mechanism referred to resembl es inheritance, although the word
“inheritance” isintentionally not used to avoid confusion.
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Methods for Manipulating Properties

The API provides a number of functions that enable you to add or modify Rhapsody properties.
These methods belong to the | RPMbdel El ement interface and include the following:

*

*

*

*

*

addProperty

getPropertyValue

getPropertyValueExplicit

removeProperty

setPropertyValue

You can use properties set in thesi t e. pr p file to create customized documentation. These
properties can a so be accessed by the API and changed as required.

Error Handling

All COM methods return a status of HRESUL T indicating the success status of the method. In
Visua Basic (VB), HRESULT is nhot visible and afailure status raises a VB error condition that, if

not handled, aborts the calling program.

Most of the API functions do not create side effects, and therefore there is no reason for them to
flag an error. However, the APl might flag errorsif permission on an update is not given.

The following table lists the methods that flag errors and might require error handling.

Method

Member Of

addProperty

| RPVbdel El enent

getPropertyValue

| RPVbdel El enent

getPropertyValueExplicit

| RPMbdel El enent

removeProperty

| RPVbdel El enent

setPropertyValue

| RPVbdel El enent

save

| RPPr oj ect

saveAs

| RPPr oj ect
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Catching an Error Condition in VB

Catching an error condition in VB is performed using an On Error statement. A practical way to
handle errors flagged by method calls is demonstrated by the following example:

On Error Resume Next

getSelectedElement .getPropertyValue ("no.property.exists")
Dim s As String

getSelectedElement .getErrorMessage s

MsgBox s

In this example:
¢+ Resune Next makesthe program continue to execute at the statement immediately
following the one that caused the error.

¢+ Themethod get Er r or Message, defined for every model element, fetches a message of
the most recent error occurrence. This message can be displayed to diagnose the error, as
shown in the example.

Error Codes

A return value of zero indicates success. The following table lists the non-zero values that
represent Rhapsody API error codes.

Error Description

RP_CANT_ADD AGGREGATE Could not add the element.

RP_CANT_MODI FY The item cannot be modified.

RP_CANT_DELETE The item cannot be deleted.

RP_NO_OPEN_PROJECT There is no open project with which to interface.

RP_DELETED OBJECT_ ERROR Indicates a reference to a deleted object.

RP_BAD_ENUVMERATED_ VALUE The enumerated type used does not exist.

RP_BAD PROPERTY_KEY_ERROR lllegal property key syntax (not in
<subj ect >. <net acl ass>. <nane>
format).

RP_M SSI NG_PROPERTY_ERROR The property requested does not exist.

RP_PROPERTY_EXI STS_ERROR Attempt to add a property that already exists.

RP_CONFI GURATI ON_NOT_I N_COVPONENT _ | Attempt to set an active configuration a

ERROR nonexistent one.

RP_OPERATI ON_FAI LED_ERROR Applying an operation that cannot be handled
by certain objects, although defined by its base
interface. An example is addPr operty,
which is defined for all model elements, but
currently generalization and reception cannot
apply it.
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Error Description
RP_SAVE FAI LED ERROR The save or save as operation failed, probably
because of lack of file writing privileges.
RP_CANNOT_WRI TE_TO FI LE_ERRCR The provided file name cannot be opened for
writing. Currently, this applies to the
get Pi ct ur e method of | RPDi agr am

Installing Custom Helpers

Helpers are custom programs that can be attached to Rhapsody to extend it. Hel pers can be either
external programs (executables) or VBA macros:

¢ Anexternal program helper istypically either aVB or a C++ program that uses the COM
API and connects to the Rhapsody instance viathe Get Obj ect COM service.

Note: Currently, Get Qbj ect isnot supported on Linux systems.

¢ A VBA macro helper isaVBA macro defined in aVBA module promoted to be a helper.
Helpers are attached to the Tools menu of Rhapsody using the Customize option.

Adding Helpers to Rhapsody

To add a helper, select Tools > Customize in Rhapsody. The Helpers dialog box is displayed. This
dialog box issimilar to the Visual Studio external tools menu. You manipulate the menu and create
new entries using the toolbar at the top of the dialog box, which includes the following tools:

¢+ New
¢ Deete
¢ MoveUp

¢ MoveDown
Refer to the Rhapsody User Guide for detailed information on using helpers.
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Rhapsody includes a unique interface tool for users who want to programmatically interact with
their Rhapsody projects for useful applications such as the preparation of custom reports. This
interface is referred to as the Rhapsody application programming interface (Rhapsody API or
simply API).

Without going into excessive detail, this lesson describes how to use the Visual Basic® API
examples that come with Rhapsody to make your own Visual Basic API applications.

This chapter describes how to perform the following tasks:

+ Generate areport using RPY Reporter.
+ Generate amodel tree using RPY Explorer.
+ View the Visua Basic source code for RPY Reporter and RPY Explorer.

The Rhapsody API Interface

The Rhapsody API functions through a set of methods and attributes that act as a set of Microsoft
COM interfaces. Using these methods and attributes, users of languages with COM bindings such
as C++, Java, and Visual Basic (VB) can programmatically access a Rhapsody project and all its
model elements. Currently, access is restricted to read-only access for model elements and write
access for model properties.

Rhapsody 31



Using the Rhapsody API

Rhapsody APl Examples

The Rhapsody distribution includes two example applications prepared in Visual Basic that access
Rhapsody projects through the Rhapsody API. The following sections describe these examplesin

detail.

RPYReporter Example

Run the RPY Reporter example, as follows:

1

Double-click on the executable file RPYRepor t er . exe inthe

Sanpl es\ CppSanpl es\ Api \ RPYReport er directory under your Rhapsody
installation directory. The RPY Project Reporter dialog box is displayed, as shown in the
following figure.

RPY Project Reporter

Froject |

About Reporter... E it

Click Load Project and browse for the Di shwasher project you completed in the
tutorial.

Select your Di shwasher project, then click OK. Rhapsody displays await screen while
the project is being |oaded.

Click Report on Project.

After preparing the report, the application displays the name and location of the text
file containing the report so you can accessit at any time.

Click OK to display the report in Notepad.

The report contains detailed information about your model, including data types
used, stereotypes, names of events, classes, operations, and so on.

Click File > Exit to close Notepad.
Click Exit to exit the application.
Click Yeswhen asked if you really want to quit.
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RPYExplorer Example

Run the RPY Explorer example, as follows:

1. Double-click the executable file RPYExpl or er . exe inthe
Sanpl es\ CppSanpl es\ API \ RPYExpl or er directory under your Rhapsody

installation directory. Rhapsody displays the RPY Explorer window, as shown in the
following figure.

w. RPY Explorer E|§|@
File Tools Settings Object Update Help
Address: |

Model Tree: Current Element's Properties and Methods:

2. Inthewindow, select File> Load RPY Project.

3. Intheresultant dialog box, browse for your Di shwasher project, then click Open. The
root of an expandable Di shwasher treeisdisplayed, with aplussign in front of it.

4. Click the plus sign to expand the Di shwasher project.

At the categories level, expandabl e segments appear for Packages, Object Diagrams,
Sequence Diagrams, and so on.

5. Expand each category to reveal its contents.

Rhapsody 33



Using the Rhapsody API

6. Toexpandindividual elements of acategory, simply select them.

The RPY Explorer example has a browser similar to the Rhapsody browser.
Information for each highlighted model element is displayed on the right-hand side
of the dialog box.

Using the Tools Menu
The Tools menu options enable you to do the following:
+  Get, set, add and remove project properties using property dot notation

(Subj ect . Met adl ass. Property). For more information on project and element
properties, refer to the Properties Reference Manual.

+ Get nested elements recursively for a selected element. For example, if you highlight a
component and select Get Nested Elements Recur sive from the Tools menu, you receive
asmall report on all configurations and filesin the component.

+ Saveareport of an element’s properties and methods to atext file.
+ Report on amodel.
+ View diagrams. You can view a diagram only after storing adiagram asan. enf file.

Storing and Viewing Diagram Files
To store and view diagram files, follow these steps:

1. Highlight anindividual diagram in the tree. The properties and methods for the diagram
are displayed in the right-hand pane.

When you highlight adiagram in the VB browser, VB automatically creates an. enf
file of the diagram in your system’s temporary directory (for example, C: \ TEMP).
VB displays the message “getPicture: see metaFile in your TMP folder” in the right-
hand panel.

2. Tosavethefileto adifferent location (in addition to the one in your temporary directory),
select Tools> Create EM etaFile from the RPDiagram. You are prompted for the name
and location of afile in which to store the diagram.

3. Toview astored diagram file, select Tools > RPDiagram Viewer.

4. Intheresultant dialog box, highlight the appropriate . enf file, then click View Selected
RPDiagrams. The diagram is displayed.
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RPYReporter Example in Visual Basic

Theintent of thislesson isto describe how the examples were prepared so you can create your own
applications.

The RPY Reporter and RPY Explorer examples were created in the Microsoft Visual Basic 6.0 IDE
(Interface Development Environment). Although the intent of thislesson is not to instruct you in
Visual Basic, the features are explained as encountered in order to see how the examples were

prepared. Note that although this tutorial uses Visual Basic version 6.0, version 5.0 isalso
compatible.

Do the following:

1. Start Microsoft Visual Basic 6.0 IDE using the Windows Start menu or from within
Rhapsody by selecting Tools > VBA > Visual Basic Editor.

2. Inthe New Project dialog box, select Sandard EXE and click Open. The Microsoft
Visua Basic design window is displayed with an empty, default project.

3. Select File> Open Project and browse for the RPY Reporter project file,
Proj ect 1. vbp, located in the subdirectory

Sanpl es\ CppSanpl es\ APl \ RPYRepor t er of the Rhapsody installation directory.
Thisis the same directory with the executable RPYRepor t er . exe.

4. Select Proj ect 1. vbp, then click OK to load it.

When the RPY Reporter project is loaded, you should see several open windowsin
the VB IDE. The Project Explorer window has a browser-like appearance with the
window title Project - RPY Reporter, as shown in the following figure.

Froject - RFvYReporter

I

Eg RPYReporter {Project1.vbp)
B- @ Farms

If thiswindow is not displayed, select View > Project Explorer on the VB desktop.

Rhapsody 35



Using the Rhapsody API

5. Inthe Project Explorer, double-click on the form RPY ReportDumpForm. A window

containing this form is displayed, as shown in the following figure.

. RPYReponter - RPYReportDumpForm (Form]) | (O] x|
a [m]

RPY Project Reporter Ij

L]

L}

Thisform is similar to the dialog box in the RPY Report executable.

Another window that should be present on the VB IDE is the Properties window,

shown in the following figure.

Properties - RFvYReportDumpFarm
|RP‘|’RepurtDumpForm Farm ;I
Alphabetic |Categorized
Appearance 1-3D
AukoRedraw False
BackColor [ &HR000000F S
BorderStyle 1 - Fixed Single
(_aption RPY Project Reparker
ClipContrals True
ControlBox False
Dt awiode 13 - Copw Pen o
Dt atSkyle 0 - Salid
Dravtidth 1
Enabled True
FillZalor . BHO00000002:
Fill5Style 1 - Transparent
Font M5 Sans Serif
FontTransparent True
ForeColor B &HE000001 28
HasDiZ True
Height 1830
HelpContextID 0 ;I
{Name)
Returns the name used in code to identify an object.

If thiswindow is not open, select View > Properties Window.
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VB Forms

Forms are the basis for writing programsin Visual Basic. Each form consists of elements such as
buttons, text fields, and pull-downs.

The form and its elements each have propertiesthat are listed in the Properties window. Currently,
the Properties window displays the properties for the entire form. You can show the properties of
each form element by clicking on an individual element, then examining the Properties window.

Placing Elements on Forms
To place elements on aform, follow these steps:

1. Click the appropriate type of form element in the Form toolbox on the | eft.

2. Double-click alocation for the element, or click and drag to establish its outline.

Viewing the Element Properties and Code

Each element has many properties, such as Appear ance, BackCol or, Capt i on, and Label . For
example, if you click the Load Project button, you can see its properties consist of a name
(cnmdLoad), atype (ConmandBut t on), and others such as Capt i on (“Load Project”), which
labelsthe button. Note that the name cndLoad beginswith the three character prefix “cmd” which,
by denotes a command button. Note the different prefixes used for the other elements.

Each form element automatically has code associated with it that reacts to different events on the
element. The most common of these isthe “Click” event. For each element that you can click,
thereis a Visual Basic subprogram that services that click, whose nameis the same asthe
element’s name with the“_Click” suffix.

To view the properties and code associated with an element, follow these steps:

1. Click on each form element and observe the element type and name. These appear in the
pull-down box at the top of the Properties window.

2. Ontheform, double-click the L oad Project button to see the subprogram
cndLoad_d i ck() inthe VB desktop.

A window appears with all of the code for the RPY ReportDumpForm form that has
been scrolled so the start of the cnrdLoad_Cl i ck() subprogramis at the top, as
shown in the following figure.
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™ RPYReporter - RPYR eportDumpForm (Code] |- [O] %]
IcmdLnad =] ICIick =l
Frivate Sub cwdload cClicki) ZI
Call mnuFileLoad Click
End Sub J

Frivate Sub cmdReport Click()
Call mnuToolsReport Click
End 3Sub

Private 3ub Form Loadf)
Set doc = Nothing
End Zub

N 2w

i

Note that the subprogram cndLoad_0C i ck() callsthe subprogram mufFi | eLoad_d i ck() .
You can scroll through the entire contents of this code window to find muFi | eLoad() , or select
it directly using the | eft pull-down at the top of the code window. The muFi | eLoad_d i ck()
calls the subprogram | oadRPYPr oj ect (), with the argument pr oj ect NameText . Text .

The RPY Reporter example was originally built with menu commands instead of button
commands, whichiswhy cndLoad_d i ck() calsmuFi | eLoad_Cl i ck() . Currently, the
menu command elements are invisible and therefore unusable.

To enable them, follow these steps:
1. Select Tools> Menu File Editor.
2. Check the Visible check box for therows &Fi | e, &Tool s, and &Hel p.

3. Uncheck these boxes for now because you do not want to use menus for the application.

Running RPYReporter Step-by-Step

To step through the code of the RPY Reporter example, follow these steps:
1. Pressthe F8 key to begin the RPY Reporter example.

In the RPY ReportDumpForm, the first line of the For m_Load() subprogramis
highlighted. This subprogram loads the form and sets the variable doc to the special
value of Not hi ng.

If you scroll to the very top of the code window, you can see the variable doc
declared as an Obj ect . VB enablesyou to create an object so it can be subsequently
used to refer to an actual object. That object will eventually be the Rhapsody API
Application object, which you will see later. For now, doc is assigned the value of
Not hi ng, which keepsit from referencing anything.
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Note: The keyword Pri vat e isused to indicate that a variable or subprogramis
available only within the modulein which it isdeclared. Therefore, thevariable
doc isrelevant only to this code module, the one accompanying the form
RPY ReportDumpForm.

Press F8 three times until the For m Load() subprogram is ended and the
RPY ReportDumpForm form is displayed.

Click Load Project to continue program execution.

Selecting Load Project callsthelocal subprogram cndLoad_Cl i ck(), whichis
now displayed and highlighted in the code window.

Continue pressing F8 to verify that cndLoad_Cl i ck() callsthe subprogram
muFi | eLoad(), which callsmmuFi | eLoad_d i ck() , which calls the subprogram
| oadRPYPr oj ect () with the argument pr oj ect NanmeText . Text .

Press F8 to proceed to the first line of the subprogram | oadRPYPr oj ect () .

The projectNameText element is the name of the long text box at the top of the
RPY ReportDumpForm form. This element has a property called Text , whichisthe
actual text contents of that text box. The program can designate the contents of the
text property using the expression pr oj ect NanmeText . Text . Thus, if you typed
the project name in the projectNameText field, the subprogram

| oadRPYPr oj ect () would now haveit asan argument. Asitis, itsvalueis
currently an empty, or blank, string.

Note: Thefollowing steps assume that you have clicked F8 to move to next section of
code to be described.

TheOn Error GoTo Cancel Handl er | i ne enablesthe Cancel button on the dialog box.
If you click Cancel, execution continues at the code line following the line labeled
Cancel Handl er : , located at the bottom of the| oadRPYPr oj ect () subprogram that
exits the subprogram.

r pyModel Nare isastring variable that will hold the name of the project you are loading.
Itsvalueisinitialized to an empty string.

The next few lines involve properties and an operation of the object RPYMbdel DI g. This
element, a common dialog box, does not appear on the form during execution until its
operation ShowOpen is executed.

Thefirst three RPYMbdel Dl g lines change the properties of the dialog for itsinitial
directory, default file search pattern, and the name of the project (which was passed
as an argument). Finally, the ShowQpen operation of the RPYMbdel DI g object is
executed and the Open dialog box is displayed with the appropriate property
changes.

Browse for your Di shwasher project, then click OK.
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The step r pyModel Name = RPYModel D g. Fi | eNane isready for execution. This
step sets the string variable r py Model Nane to the name of the project you selected
in the Open dialog box.

10. PressF8.

In the following line, the variable r pyMbdel Nare is checked to seeif it isempty. If
s0, thel 0adRPYPr oj ect subprogram exits. Otherwise, it loadsthewai t For m
object, followed by the execution of thewai t For mobject’s Show operation

(wai t For m show), which displaysthewai t For mform to tell the user the project is
loading.

Before continuing program execution, you need to learn more about the Rhapsody API.
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The Rhapsody API: A Closer Look

The Rhapsody API isaset of classes consisting of operations and attributes that enable you to
programmatically interact with aRhapsody project (repository) using a programming environment
that supports Microsoft COM (Component Object Model). This allows an application to interface
programs using COM, such as Rhapsody. In thisway, standard interfacesto obtain system services
or provide functionality to other programs can be established.

You can make the Rhapsody API classes available for the RPY Reporter project file
(Pr oj ect 1. vbp) using references, which allow the use of objects from other applications.

To seethelist of referencesin this project, follow these steps:

1. Stop execution of the RPY Reporter application by selecting Run > End inthe VB
integrated development environment (IDE).

2. Select Project > Referencesinthe VB IDE. VB displays the References dialog box, as
shown in the following figure.

References - Project]l_vbp

fvvailable References: Ok

Wisual Basic For Applicakions il Cancel |
Wisual Basic runtime objects and procedures

Wisual Basic objects and procedures
OLE Autamation Browse. ..

v oy

[ acrobat . ﬂ
[] acrobat Diskiller

[ active Setup Contraol Library Priority
[] ActiveMaovie contral bype library

[] AdobePDFMaker ﬂ
[ sFormdut 1.0 Type Library

[ AnalysisSI 1.0 Type Library

[JappTab 1.0 Type Library

[] rktBn:uotIE 1.0 Tvoe Library | _|;|
4 ]

—rhapsody

Location:  1:\Rhapsody40irhapsody, tb
Language:  Standard

Access to the Rhapsody API classes is made possible by referencing the RHAPSQDY. t | b library
file included in the Rhapsody distribution. Without it, the Rhapsody APl is not available. Be sure
to check this part of your project if this becomes questionable. When you create a new project to
access a Rhapsody model, the very first step isto make sure that your project references
RHAPSQDY. t | b.
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The Rhapsody API classes that come from the RHAPSQDY. t | b reference, along with their
operations and attributes, are visible in the VB design area. In Visual Basic, interface classes are
implemented with names that begin with the letter “1.” However, when the interfaces are seen in
the VB IDE, they appear without the “1.” For example, the | RPMbdel El ement class appears as
RPMbdel El enent .

To display the Rhapsody API classes and their methods and properties, follow these steps:
1. Select View > Object Browser. The Object Browser dialog box is displayed, as shownin

the following figure.

[<Ail Libraries> =] ) ] 2]
[ =] #| v

|Classes Members of ‘=globals='

@ [=giohals= i’ % fhs i’
= AlignConstants = addToModel

2 AlignmentConstants. B& App

B AmbientProperties =@ AnpActivate

B App e Application

= ApplicationStartCone =2 arcCheckOot

B AsyncPropery = Ast

B AsyncProperty_vBs v |- AscB =]

=All Libraries=
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2. Select therhapsody library from the pull-down field. VB displays the Rhapsody API

5.

classes, as shown in the following figure.

+si Object Browser

T -] || [

2]

| =] #AlY
|Classes Members of '=globals='
@ {=giohals= j =% gddToModel i’
= COMErrors & Application
Bl RPAction =% groCheckout
Bl RPActor =& Buildro
1 RPApplication =& checkin
B RPArgument =% checkModel
B RPASCIFile =% checkOut
# RPAssociationRole = |- connectToArchive hd
Library rhapsocy

JIRHAPSO~2RHAPSODY

Click on one of the API classes to seeits attributes and operations.

Click on an attribute or operation of the selected API classto view asmall report on it at
the bottom of the display area.

Click the“X” in the upper, right-hand corner to dismiss the dialog box.

Continuing the Step-by-Step Execution of RPYReporter

Now that you have seen how the Rhapsody API is made available to the RPY Reporter project, you
can continue step-by-step execution of the RPY Reporter application to see how it is used.

Continue executing each step of the program, as follows:

1
2.

3.

If you halted execution earlier, press F8 to begin step-by-step execution again.

The next execution step in thel oadRPYPr oj ect subprogram calls the
di sabl eAl | But t ons subprogram, which sets al the enabled properties of all

RPY ReportDumpForm buttons to Fal se, rendering the buttons unusable (grayed-out).
Press F8 to move through the subprogram.

The next step compares Not doc (recall that doc isan object of type Chj ect ) against the
value Not hi ng. Because doc was created a few steps ago and wasiinitialized to

Not hi ng, execution stepsinto the El se part of thel f - Then- El se statement that
followsit.
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10.

11

Because the module-level variable THE_APPLI CATI ON has been set to the string
“rhapsody. Appl i cati on” (scroll to the top of the window to see the declaration) the
line Set doc = Cr eat eObj ect ( THE_APPLI CATI ON) makesdoc areferenceto the
Rhapsody Appl i cat i on object and a stepping stone for upcoming use of the Rhapsody
API.

Note: Rhapsody is started as an application during the execution of the line
Creat eCbj ect ( THE_APPLI CATI ON) .

Because doc isnow areferenceto the Appl i cat i on object, you can use API class
operations and attributes through it. Therefore, the line doc. openPr oj ect

r pyModel Nane actually callsthe openPr oj ect subprogram of the Appl i cati on
object referenced by doc, and opens the project file you selected.

Thenext ling, Set t hePr oj ect =doc. acti veProj ect, callstheact i vePr oj ect
method of the Appl i cat i on object referenced by doc and sets the project you loaded as
the active project in Rhapsody.

Theunl oad wai t For mline unloads wait dialog box.

Thenext line, pr oj ect NaneText . t ext isset to the name and path of the Di shwasher
model (r py file) you selected.

Now that the project isloaded, the program calls Enabl eAl | But t ons to
re-enable al the buttons on the main form. Press F8 to step through each button.

Now that a project has been loaded, the property Enabl ed of the muTool sReport
object is set to Tr ue. The function of this menu item is equivalent to that of the Report
on Project button.

Press F8 to step through the exiting of all subprograms that have been entered as part of
project loading. Theseinclude, in order:

a. | oadRPYProj ect ()
b. mmuFil eLoad_d i ck()
Cc. cmdLoad_dick()

The program now waitsin stasisfor the next event to occur through other button clicks on the RPY
Project Reporter window.
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Code Summary of Loading a Project

The following is a code summary of the project-loading processin VB:

Private doc As Object
Private ProjectName As String
Private theProject As RPModelElement

' Get project name and store as ProjectName

' Open the Rhapsody API Application Object
Set doc = CreateObject (“rhapsody.Application”)
doc.openProject ProjectName

Set theProject = doc.activeProject

Reporting on a Project

Going step-by-step through the entire program sequence for the report procedure in RPY Reporter
is beyond the scope of this guide. However, reporting does require the execution of several
important API operations that are highlighted here.

It is assumed that you are continuing this tutorial uninterrupted from the previous project loading
example. If you have stopped the program, the program has been press F8 to enter the program in
step-by-step mode and repeat al steps from the previous section. Otherwise, continue stepping
through the program, as follows:

1. Inthe RPY ReportDumpForm form, click Report on Project.

2. Thesubprogram cnrdReport _Cl i ck() iscalled, which calls the subprogram
mmuTool sReport _d i ck.

Within the muTool sReport _d i ck subprogram, thewai t For mform isloaded
and displayed, and the buttons of the RPY ReportDumpForm form are disabled.

3. Becausethe report will be written to afile, the function get Def aul t LogFi | eName
generates aname for the file using the project name string r py Model Nane as a base.

4. After the name of the report output fileis generated in the variable | ogFi | eNang, itis
opened by a call to the VB subprogram Open, which opensit for output and assignsit the
reference number of FI LE_NUMBER (set to 1 at the top of the codefile) for future callson
thisfile.

5. Finaly, thesubpr ogr am Report _on_Mbdel iscaled with the argumentst hePr oj ect
and FI LE_NUMBER. The variablet hePr oj ect has been typed to be an API object type
RPModel El enment .

6. IntheReport _on_Mdel subprogram, the calling arguments are passed by value using
the keyword By Val , which makes alocal copy of them.

Note that in the diagram for the Rhapsody API hierarchy (see page 4-41) that all the
remaining classes, except for the Appl i cat i on class, inherit from
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RPModel El ement . By using an object of type RPModel El enent , you can access
objects of subclasses corresponding to hierarchical project elementsin ageneric
fashion. Many of the properties of an RPMbdel El enent have been developed to
make its identification and consequent action possible.

Before proceeding to other stepsin Report _on_Model , note the typing of local
variablescol asRPCol | ecti on, and e asRPMbdel El emrent . AnNRPCol | ecti on
isacollection of RPMbdel El ement objects used for holding and accessing the
result of a“get” that obtains multiple or numerous objects satisfying the
regquirements of the get.

7. After setting the variable th to an empty string, the second line performs the following get:

Set col = aProject.getNestedElementsRecursive ()

ThegetNestedElementsRecursive () method, amember of object class
RPModel El enent s, is called for the current project, aPr oj ect , and returns a
collection of RPMbdel El erent s that is accessed through the variable col . The
method get Nest edEl enent sRecur si ve() retrievesall owned elements of the
calling object and places the resultsin a collection. Because the calling object in this
caseisaproject, get Nest edEl ement sRecur si ve() returnsall packages, classes,
diagrams, and so on that belong to the project.

The remaining code opens the report file and writes a header to it, followed by alargef or loop
over each element incol (f or e i n col ). Within the loop, each element is analyzed for itstype
and is reported accordingly. As previously mentioned, a variety of properties of the element
identify it (the element’snet adl ass (e. met aCl ass)), making this computed action possible.

Code Summary of Reporting a Project
The following is a code summary of the project-reporting processin VB:

Dim col As RPCollection

Dim e As RPModelElement

Private logFileName As String

Private Const FILE NUMBER As Integer = 1

‘Open file logFileName: FILE NUMBER’

‘Set col = theProject.getNestedElementsRecursive ()

' Write header to file=FILE NUMBER

for e In col

' Identify model element e based on e.xxxx properties

‘ Write report of e based on e.xxxx properties

Next
‘Close file=FILE NUMBER
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Starting and Saving Your Own VB IDE Work

If you want to use the API, spend some time studying the RPY Reporter example and the more
complex RPY Explorer example. In conjunction with the examples, you can use the online help,
which contains the methods and properties of each API class along with descriptions of required
arguments.

If you want to use these Rhapsody API examples as a starting point for your own applications, the
following sections describe how to perform some common tasks.

Saving the Examples as New Projects

If you want to create your own applications by modifying one of the supplied examples, a good
starting point isto save the appropriate example as anew project in its own directory. Notethat VB
projects consist of aproject file(. vbp), aform filefor eachform (. f r m, and modulefiles(. bas).
Usethe File > Save As options for projects, forms, and modules, and save to a new directory.

Making Your Own New Projects

You might decide to start from scratch and build your own project. When you open Visual Basic,
VB displays a default new project environment, complete with a blank form. Alternatively, you
can create anew project environment by selecting File > New Project > Sandard EXE inthe VB
IDE.

Once you have started a new project or begun working with an existing one, you can add new
forms or modules to a project by right-clicking on the forms folder in the VB Explorer window,
then select either Add > Form or

Add > Module.

Compiling and Making Your Executables

To create your own applications, you must compile and make your projects into executable files.

In Visual Basic 6.0, compiling is seen as part of making so when you make, you compile.
Compiling appears as a separate step only when you test run your project in the Visual Basic IDE
by selecting Run > Start With Full Compile.

To make your application’s executable, select File > Make [Project].exe.
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The Microsoft Word VB IDE

In addition to the Visual Basic IDE, you can use the Visual Basic editor of Microsoft Word to
create applications that use the Rhapsody API.

Follow these steps:

Start Microsoft Word.

Select File > New to start a new document.

In the New dialog box, select the template labeled Blank Document, then click OK.
Select File > Save As and save the new, blank document asWr d_API . doc.

Start a new Word macro by selecting Tools > Macro > Record New Macro.

o g ~ w Dd P

In the Record Macro dialog box, follow these steps:

a. For the Namefield, type “ CountPackages.”

b. Forthe Sore macroin field, select Wor d_API . doc from the pull-down list.
c. Click the Keyboard icon.

7. Inthe Customize Keyboard dialog box, follow these steps:

a. If itisnot there already, move the cursor to the Press new shortcut key field. While
holding down the Alt key, type the characters “CP’. When finished, you should see
the following entry:

Alt+C,P
b. Inthe Savechangesin field, select Wor d_API . doc.

c. Click Assign and Closg, in that order.

A small dialog box (shown below) appears to stop and pause the recording of the
macro that you are currently recording.

8.  Click the small square to stop recording the macro.

You now have a macro named Count Packages saved in the file Wbor d_API . doc that you can
trigger at any time within this document with the keyboard sequence Alt+C,P. Currently, the macro
has no content.
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Specifying the Macro Content

To alter the content of the Count Packages macro, follow these steps:

1
2.

With the filewor d_API . doc still loaded in Word, select Tools > Macro > Macros.
In the Macros dialog box, follow these steps:

a. IntheMacrosin field, select Wor d_API . doc.

b. Inthelist of available macros, select Count Packages.

c. Click Edit.

The Microsoft Word Visual Basic IDE opens, so you can edit the contents of the
macro Count Packages.

Select Tools > References.

In the Reference - Project dialog box, scroll down until you find the reference r hapsody.

References - Project

[JReqisterTab 1.0 Type Librar
D.

i Priority
[JRunCnce 1.0 Type Library Help
[[]schedules 1.0 Type Library ]+ |

[] schiarid GLE Custom Contral module

[1sDDocsnapin 1.0 Tvpe Library

[ 5dMEDew 1.0 Type Library
HISDNTODtiDns 1.0 Tvoe Library | _ILI
4 »

—thapsody

fvailable References:
[] uinkus WebCenter Engine Contral ;l Cancel |
[] QuinkusTreeckr! 1.0 Type Library

[JowebConnect 1.0 Type Library

[JRAD 98 - Wizard Interfaces Browse... |
[CIRAD Hast ‘Wizard

[ Realdudio Ackivel Control Library + |

Location:  J:\Rhapsody40irhapsody.tb
Language:  Skandard

Mark the rhapsody check box, then click OK. Itslocation isreported in asmall areaat the
bottom of the dialog box, referencing the RHAPSCQDY. t | b file located in the Rhapsody
installation directory.

Insert the following code between the lines Sub Count Packages() and End Sub, but
after the comments that appear identifying the macro, date, and author.
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Make sure the pr oj Namre path is correct for your Rhapsody installation.

' Start Rhapsody

Dim rhapApp As Object
Set rhapApp = CreateObject ("rhapsody.Application")

' Set Project Name String
1

Dim projName As String
projName =
"C:\Rhapsody40\Samples\CppSamples\Radio\Radio.rpy"

1

' Open Project
1

Dim theProject As RPModelElement
rhapApp.openProject projName
Set theProject = rhapApp.activeProject

1

' Get Packages

1

Dim packages As rhapsody.RPCollection
Set packages = theProject.packages
1

' Report Packages to Current Word Doc (ThisDocument)

Dim package As rhapsody.RPPackage
For Each package In packages
ThisDocument .Range.InsertAfter package.name &
vbCrLf
Next

' Close Application When Finished

If Not rhapApp Is Nothing Then rhapApp.Quit
7. Runthe macro by selecting Run > Run Sub/User Form.

If you encounter an error, click Debug on the error dialog window to see the
offending line of code highlighted.

If the macro works, you will see the packages of the Rhapsody project radio
displayed in the document screen of Word. There are three packages:

¢ gui Pkg
¢ hardwar ePkg
¢ radi oPkg

Once you are sure that the macro works, you can execute it in the Word document area by simply
typing the macro key sequence (Alt+C,P).
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Comments on the Code

The following sequence loads the project:

Dim rhapApp As Object

Set rhapApp = CreateObject ("rhapsody.Application")
Dim projName As String

projName = "C:\Rhapsody\some project.rpy"

Dim theProject As RPModelElement
rhapApp.openProject projName

Set theProject = rhapApp.activeProject

An dternative sequenceis as follows:

Dim rhapApp As rhapsody.Application

Set rhapApp = CreateObject ("rhapsody.Application")
Dim projName As String

projName = "C:\Rhapsody\some project.rpy"

Dim theProject As RPProject

rhapApp.openProject projName

Set theProject = rhapApp.activeProject

Note the use of RPCol | ect i on in the following sequence:

Dim packages As rhapsody.RPCollection
Set packages = theProject.packages

Unlike the RPY Reporter example, a*“get” method was not used to obtain the elements (in this
case, packages). You can use this method for obtaining model elements on one level.

Finally, note the following f or loop over the packages:

For Each package In packages

ThisDocument .Range.InsertAfter package.name & vbCrLf

Next

Printing to the Word document is accomplished through the second line of code. The object called
Thi sDocunent isthe highest level object of Word, representing the document itself. You can see
it in the explorer window in the upper, left-hand corner of the VB desktop. Highlight it to examine
some its properties.
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Modifying the Example to Print Classes

Suppose that instead of printing the names of all the classesin the radio model, you want to print
the names of all the classes for a particular package, such asr adi oPkg. To modify the previous
code and save it to another macro, follow these steps:

1
2.

Start a new Word macro by selecting Tools > Macro > Record New Macro.

In the Record Macro dialog box, follow these steps:

a. For the Namefield, type “ CountClassesForPackage.”

b. Forthe Storemacroin field, select Wor d_API . doc from the pull-down list.

c. Click theKeyboard icon.

In the Customize Keyboard dialog box, follow these steps:

a. If itisnot there already, move the cursor to the Press new shortcut key field. While
holding down the Alt key, type the“CC” characters. When finished, you should see
the following entry:

Alt+C,C
b. Inthe Save changesin field, select Wor d_API . doc.

c. Click Assign and Closg, in that order.
A small dialog box appears to stop and pause the recording of the current macro.
Click the small square to stop recording the macro.
With thefilewsr d_API . doc till loaded in Word, select Tools > Macro > Macros.
In the Macros dialog box, follow these steps:
a. IntheMacrosin field, select Wor d_API . doc.
b. Inthelist of available macros, select Count Cl assesFor Package.
c. Click Edit. The focus switchesto the VB editor.

Note the presence of the new, empty Count Cl assesFor Package subprogram. If
you scroll up, you can see the code you created for the Count Packages macro.

Cut and paste the code between the lines Sub Count Packages() and End Sub inthe
Count Packages macro, but after the comments that appear identifying the macro, date,
and author.
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8. Replace this section:

' Report Packages to Current Word Doc (ThisDocument)
1
Dim package As rhapsody.RPPackage
For Each package In packages
ThisDocument .Range.InsertAfter package.name &
vbCrLf
Next

' Close Application When Finished

If Not rhapApp Is Nothing Then rhapApp.Quit

With this:

1
' Report Classes of Package "radioPkg" to Current
' Document
1
Dim package As rhapsody.RPPackage
For Each package In packages
If (package.name = "radioPkg") Then
Dim classes As rhapsody.RPCollection
Dim class As rhapsody.RPClass
Set classes = package.classes
For Each class In classes
ThisDocument .Range.InsertAfter class.name &
vbCrLf
Next
End If
Next

' Close Application When Finished

If Not rhapApp Is Nothing Then rhapApp.Quit

9. Runthe macro by selecting Run > Run Sub/User Form.

* 6 & o o

If you encounter an error, click Debug on the error dialog window to see the
offending line of code highlighted.

If the macro works, you will see the classes of ther adi oPkg package displayed in
the document screen of Word, as follows:

Frequency
| Di spl ay
| Tuner
Radi o
Waveband
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Rhapsody API Interfaces

This section contains reference information describing the classes and methods that comprise the
abstract factory interface. For ease of use, the interfaces are presented in aphabetical order.

Note

Only the public and protected methods are documented.

The reference material for each of the Rhapsody API interfacesis shown in VB-compliant form
(except for the interface class names). This means the following:

*

Each COM interface has attributes and methods. In Visual Basic, the attributes are
identified as properties.

The actual identity of the interface classes used in the Rhapsody API varies with the
language platform of the client application attempting to interface with the Rhapsody
repository. In COM, al interface names start with “1”, such as| RPModel El enent .
Visua C++ connects directly with the COM tables, which are C++ (or C++-related), and
seesthe“l”. However, Visual Basic (VB) triesto be user-friendly by avoiding the use of
the“1” so, for example, the | RPModel El ement interfaceis RPMbdel El enent in VB. If
you open the object browser in the Microsoft Visual Basic IDE, you can see which classes
are there and what they are called. Nevertheless, in the reference material, interface
objects are identified with the “IRP” prefix and not the “RP” prefix seenin VB.

Void returns are not shown as voi d—they are simply not shown.

Pointers are not displayed. In C++, interfaces and collections of interfaces are handled
with pointers. VB has no pointers.

Each method has an implied argument: an instance of its interface referred to as “this.”
Thus, the reference on amethod of | RPCl ass will refer to something done to “this
Cl ass.”

String returns and arguments are shown as St r i ng. For C++, thistype isBSTR.

Thereis only one collection object type: | RPCol | ect i on. In the reference material,
however, collectionsare displayed as“xxxxs” wherexxxx refersto the object type of the
collection and the “s” indicatesit is a collection.
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Access to VB Properties

The COM API interface consists of data and methods. In Visual Basic, the datais identified as
properties. These properties are implemented with invisible operations that enable some properties
to be read/write (RW). In other words, the property can be used to set a value in a Rhapsody 6.1
model or retrieve it. Thus, if Aisaread/write property, you can set the model value it points to
through an " A=.." statement or retrieveit through a" .. =A" statement.

Note

Not all properties are implemented with write ability. These are identified as read-only
(RO).

APl Conventions

The Rhapsody Repository API isaset of COM interfaces specified in terms of COM properties
and methods, using COM types. The API listings have two syntaxes to describe the various
attributes and methods provided by each interface:

+ The VB syntax that follows indicates that the function takes a string argument for the
property key and then returns a string:

getProperty (propertyKey As String) As String
The C/C++ prototype for the same function is:

HRESULT getProperty (String propertyKey,
String*** retval) ;

+ All interfaces are prefixed with “IRP” (“1” for interface, “RP” for Rhapsody 6.1). For
example, the interface for a package is| RPPackage.

+ Cdlsreturning multiple objects return the equivalent of a VBA “collection.” To enhance
readability, this guide treats collections as “typed,” for example, “ Collection of

| RPA asses.” However, inthe API, al collections are implemented as “ Collection of
| RPMbdel El enent s.”

¢+ Enumerated types are treated as strings. For example, the get Vi si bi | i t y method of an
attribute returns the string “Public,” “Protected,” or “Private.”
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The Rhapsody API interfaces are as follows:

*

IRPAction Interface

IRPActor Interface

IRPANnnotation Interface

IRPApplication Interface

IRPArgument Interface

IRPASCIIFile Interface

IRPAssociationClass Interface

IRPAssociationRole Interface

IRPAttribute Interface

IRPBlock Interface

IRPClass Interface

IRPClassifier Interface

IRPClassifierRole Interface

IRPCollaboration Interface

IRPCollaborationDiagram Interface

IRPCollection Interface

IRPComment Interface

IRPComponent Interface

IRPComponentDiagram Interface

IRPComponentinstance Interface

IRPConfiguration Interface

IRPConnector Interface

IRPConstraint Interface

IRPControlledFile

IRPDependency Interface

IRPDeploymentDiagram Interface

IRPDiagram Interface

IRPEnumerationLiteral Interface

IRPEvent Interface
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IRPEventReception Interface

IRPExecutionOccurrence Interface

IRPExternalCodeGenerator Interface

IRPExternalCodeGeneratorlnvoker Interface

IRPFile Interface

IRPFlow Interface

IRPFlowchart Interface

IRPFlowltem Interface

IRPGeneralization Interface

IRPGraphEdge Interface

IRPGraphElement Interface

IRPGraphicalProperty Interface

IRPGraphNode Interface

IRPGuard Interface

IRPHyperLink Interface

IRPImageMap

IRPInstance Interface

IRPInteractionOccurrence Interface

IRPInterfaceltem Interface

IRPLink Interface

IRPMessage Interface

IRPMessagePoint Interface

IRPModelElement Interface

IRPModule Interface

IRPNode Interface

IRPObjectModelDiagram Interface

IRPOperation Interface

IRPPackage Interface

IRPPort Interface

IRPProfile Interface

IRPProject Interface

IRPRelation Interface
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¢ |RPRequirement Interface

¢ |RPSequenceDiagram Interface

¢ |RPState Interface

¢ |RPStatechart Interface

¢ |RPStateVertex Interface

¢ |RPStereotype Interface

¢ |RPStructureDiagram Interface

¢ |RPSwimlane Interface

¢ |RPTag Interface

¢ |RPTemplatelnstantiation Interface

¢ |RPTemplatelnstantiationParameter Interface

¢ |RPTemplateParameter Interface

¢ |RPTransition Interface

¢ |RPTrigger Interface

¢ |RPType Interface

¢ |RPUnit Interface

¢ |RPUseCase Interface

¢ |RPUseCaseDiagram Interface

¢ |RPVariable Interface

IRPAction Interface

VB Properties
Name Type Access Description
body String RW The entered body of this
action

Thel RPAct i on interface represents the action of atransition in a statechart. It inherits from

| RPMbdel El enent .
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IRPActor Interface

Thel RPAct or interface represents Rhapsody actors. It inheritsfrom | RPA assi fi er.

IRPANnnotation Interface

Thel RPAnnot at i on interface represents Rhapsody annotations—notes, comments,
constraints, and requirements. It inherits from | RPMbdel El enent .

VB Properties
Name Type Access Description

anchoredByMe | RPCol | ecti on RO The list of model elements
that are anchored to the
annotation

body Deprecated

body String RW The body text of the
remark

specification String RW The body text for the
annotation

Method Summary

addAnchor

Adds an anchor from the annotation to the
specified model element.
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addAnchor
Read method

Description

The addAnchor method adds an anchor from the annotation to the specified model element.
Visual Basic
Syntax

addAnchor (target As RPModelElement)

Arguments

target

The model element to which to anchor the annotation

C/C++ Prototype

HRESULT addAnchor (IRPModelElement* target)

Return Value

HRESULT (O for success, or asigned integer error code)
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IRPApplication Interface

The application is the top-level object of the Rhapsody object model, which represents the
Rhapsody application shell. It conceptually provides the functionality available through the
Rhapsody menu bars. Initially, the application object exposes the minimal set of functionality
required to open a project.

When you use VB or VC++ to interface to the COM AP, the | RPAppl i cat i on object needs
to be created before any other API interface objects are used. However, if you use the
Rhapsody VBA interface, you are automatically connected to the | RPAppl i cat i on object.
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VB Properties
Name Type Access Description

BuildNo CString RO The current build number

Language String RW The current language
setting

OMROOT String RO The value for OMROOT

SeriaNo CString RO The serial number

Tool Set CString RO The current tool setting
(demo, Designer, and so
on)

Method Summary

activeProject

Returns a pointer to the active (open)
project

addToModel

Adds a Rhapsody unit located in the
specified file to the current model with or
without descendant elements

addToModelByReference

Adds the Rhapsody unit you specify to
your model as a reference.

addToModelFromURL

Adds a Rhapsody unit located at the
specified URL to the current model

arcCheckOut Checks out files from the CM archive into
the model

build Builds the application

checklin Checks in the specified unit within the
model into the CM archive you have
already connected to (using
connect ToAr chi ve)

checkModel Checks the current model

checkOut Refreshes a unit in the model by checking

it out from the CM archive

connectToArchive

Connects the Rhapsody 6.1 project to the
specified CM archive

createNewProject

Creates a new project named
<projectName> in <projectLocation>

enterAnimationCommand

Specifies the command to begin animation

errorMessage

Returns the most recent error message

forceRoundtrip Forces a roundtrip of the code back into
the Rhapsody 6.1 model, and vice versa
generate Generates code for the active

configuration of the active component

getDiagramOfSelectedElement

Retrieves the diagram of the current
element
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getErrorMessaae

Returns the most recent error message

getListOfFactoryProperties

Retrieves the list of properties in the
<l ang>_factory. prp file

getlListOfSelectedElements

Returns the collection of model elements

getListOfSiteProperties

Retrieves the list of properties in the
<l ang>_si te. prpfile

getSelectedElement

Retrieves the current model element

getTheExternalCodeGeneratorinvoker

Retrieves the invoker for the external code
generator

highlightByHandle

Highlights an element, given its handle

highLightElement

Highlights the specified element

importClasses

Imports classes according to the reverse
engineering setting stored in the current
configuration

make

Builds the current component following
the current configuration

openProject

Opens a Rhapsody 6.1 project

openProjectFromURL

Opens the Rhapsody 6.1 product at the
specified URL

openProjectWithlLastSession

Opens the project using the settings from
the previous Rhapsody 6.1 session

openProjectWithoutSubUnits

Opens the Rhapsody 6.1 project without
subunits

quit Closes the active Rhapsody 6.1 project
rebuild Rebuilds the application

refreshAllViews

Refreshes all the views

regenerate

Regenerates the active configuration of
the active component

report Generates a report in ASCII or RTF into
the specified file
roundtrip Roundtrips code changes back into the

open model

setComponent

Sets the current component for the open
project

setConfiguration

Sets the current configuration for the open
project

setLog Creates a log file that records all the
information that is normally displayed in
the Rhapsody 6.1 output window

version Returns the version of Rhapsody 6.1 that

corresponds to the current COM API
version
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activeProject
Read method

Description
The activeProject method returns a pointer to the active (open) project.
Visual Basic
Syntax
activeProject () As RPProject
Return Value
A pointer to the current open project (an RPPr oj ect )
C/C++ Prototype
HRESULT activeProject (IRPProject** pval)

Return Value

HRESULT (O for success, or asigned integer error code)

addToModel
Write method

Description

The addToModel method adds a Rhapsody unit located in the specified file to the current model
with or without descendant elements.

Note: When adding a file with descendants, all the file subunits must be in the unit
directory of the project before you issue the command.

Visual Basic
Syntax

addToModel (filename As String, withDescendant As Long)

Arguments

filename
The full file name of the file that contains the unit to be added
withDescendants

Specifies whether to bring in descendants of the unit to be added to
the model
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C/C++ Prototype

HRESULT addToModel

Return Value

(BSTR filename,

long withDescendant)

HRESULT (O for success, or asigned integer error code)
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addToModelByReference

The method addToMode1ByReference adds the Rhapsody unit you specify to your model as a
reference.

Syntax
addToModelByReference (filename As String)

Arguments

filename

The name of the file that contains the unit to be added. The full path to the file must be
specified.

Return Value
HRESULT (O for success, or asigned integer error code)

Example

Sub addJavadocProfile ()
Dim app As Object
Set app = GetObject(, "Rhapsody.Application")
On Error GoTo aa
app.addToModelByReference ("C:\temp\JavaDocProfile.sbs")
Exit Sub
aa:
MsgBox errorMessage

End Sub
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addToModelFromURL
Write method

Description

The addToModelFromURL method adds a Rhapsody unit located at the specified URL to the
current model. This method is used to support the Webify Toolkit.

Visual Basic
Syntax

addToModelFromURL (url As String)

Arguments

url

The URL that contains the unit to be added
C/C++ Prototype
HRESULT addToModelFromURL (BSTR url)

Return Value

HRESULT (O for success, or asigned integer error code)

arcCheckOut
Write method

Description

The arcCheckOut method checks out files from the configuration management (CM) archive
into the model.

Note: The difference between ar cCheckQut and checkQut isthat ar cCheckQut
refersto filesinthe archive, whereascheckQut refersto unitsinthe model. To
add new units to the model, use ar cCheckCut . The method checkQut is
intended to refresh elements aready existing in the model.

Visual Basic
Syntax

arcCheckOut (filename As String, label As String,
isLocked As Long, isRecursive As Long)

Arguments

filename
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Specifies the name of the file.
label

Specifies the revision or label to be checked out. If this is set to
NULL, the last revision on the main trunk (the default) will be checked
out.

isLocked

Specifies whether the file is locked. The possible values are as
follows:

1--Designates that a writable file be checked out and the archive
locked from other checkouts of the file.

0--The file is checked out as read-only and the archive not locked to
other checkouts.

isRecursive (1 or 0)

If this is set to 1, the file and all the other elements that it
contains are checked out.

C/C++ Prototype

HRESULT arcCheckOut (BSTR filename, BSTR label,
long isLocked, long isRecursive)

Return Value

HRESULT (O for success, or asigned integer error code)
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build

Note
Currently, this method has not been implemented.

Read method
Description

The build method builds the application.

Visual Basic
Syntax

build()

C/C++ Prototype

HRESULT build()

Return Value
HRESULT (O for success, or asigned integer error code)
checkln
Read method
Description

The checkin method checks in the specified unit within the model into the configuration
management (CM) archive you have already connected to (using connect ToAr chi ve).

Visual Basic
Syntax

checkIn (unitName As String, label As String,
isLocked As Long, isRecursive As Long,
description As String)

70 API| Reference Manual



IRPApplication Interface

Arguments

unitName
The name of the unit.
label

The label to apply when you check in the file to the archive. If it is
not needed, set this argument to NULL.

isLocked (1 or 0)

Specifies whether to lock the archive after checkin.

isRecursive

If set to 1, check in the unit and all the elements contained in it.
description

The description to add to the unit when you check it in to the archive.

C/C++ Prototype

HRESULT checkIn (BSTR unitName, BSTR label,
long isLocked, long isRecursive, BSTR description)

Return Value

HRESULT (O for success, or asigned integer error code)
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checkModel
Read method

Description

The checkModel method checks the current model. This is equivalent to the Rhapsody 6.1
command Tools > Check Model for the current configuration.

Visual Basic

Syntax
checkModel ()

C/C++ Prototype

HRESULT checkModel ()

Return Value

HRESULT (O for success, or asigned integer error code)
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checkOut
Write method

Description

The checkOut method refreshes a unit in the model by checking it out from the CM archive.
Visual Basic
Syntax

checkOut (unitName As String, label As String,
isLocked As Long, isRecursive As Long)

Arguments

unitName
The name of the unit.
label

The revision or label to be checked out. If you set this to NULL, the
last revision on the main trunk (the default) will be checked out.

isLocked

Specifies whether to lock the archive after checkout. The possible
values are as follows:

1--Designates that a writable unit is to be checked out and the archive
locked from other checkouts of the unit.

0--The unit is checked out as read-only and the archive not locked to
other checkouts.

isRecursive

If this is set to 1, check out the unit and all the elements contained
in it.

C/C++ Prototype

HRESULT checkOut (BSTR unitName, BSTR label,
long isLocked, long isRecursive)

Return Value

HRESULT (O for success, or asigned integer error code)
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connectToArchive
Read method

Description

The connectToArchive method connects the Rhapsody 6.1 project to the specified CM archive.
This operation is necessary only for the following cases:

+ Thereisno current association in the project.
¢ Theassociation needs to be modified.

Visual Basic

Syntax

connectToArchive (archivePath As String)

Arguments

archivePath

The path to location of archive

C/C++ Prototype

HRESULT connectToArchive (BSTR archivePath)

Return Value

HRESULT (O for success, or asigned integer error code)
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createNewProject
Write method

Description

The createNewProject method creates a new project named <projectName> in

<projectLocation>. You should call this operation before a project has been opened, or after a
project has been saved.

Note that hel per applications might not close the current document. This means that the
createNewProject method should not be used in aVBA macro that you specify as a helper.

Visual Basic
Syntax

createNewProject (projectLocation As String,
projectName As String)

Arguments
projectLocation
The location of the project

projectName

The name of the project

C/C++ Prototype

HRESULT createNewProject (BSTR projectLocation,
BSTR projectName)

Return Value

HRESULT (O for success, or asigned integer error code)
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deferredAddToModel
Write method

Description

The deferredAddToModel method TBS.

Visual Basic
Syntax

deferredAddToModel (filename As String,
withDescendants As Long, orijPrjId As String,
eraseDir As Long)

Arguments

filename
The full name of the file that contains the unit to be added
withDescendants

Specifies whether to bring in descendants of the unit to be added to
the model

orijPrjId
The project ID
eraseDir

Specifies whether to delete the directory after the unit has been added
to the model

C/C++ Prototype

HRESULT deferredAddToModel (BSTR filename,
long withDescendants, BSTR orijPrjId, long eraseDir);

Return Value

HRESULT (O for success, or asigned integer error code)
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enterAnimationCommand
Read method

Description

The enterAnimationCommand method specifies the command to begin animation.

Visual Basic
Syntax

enterAnimationCommand (command As String)

Arguments

command

The animation command

C/C++ Prototype

HRESULT enterAnimationCommand (BSTR command)

Return Value

HRESULT (O for success, or asigned integer error code)
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errorMessage

Read method

Description

The errorMessage method returns the most recent error message.

Visual Basic
Syntax
errorMessage () As String
Return Value
A pointer to the most recent error message (a string)
C/C++ Prototype

HRESULT errorMessage (BSTR* _ MIDL 0016)

Arguments

BSTR*

A pointer to most recent error message

Return Value

HRESULT (O for success, or asigned integer error code)
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forceRoundtrip
Read method

Description

The forceRoundtrip method forces a roundtrip of the code back into the Rhapsody 6.1 model,
and vice versa.

Visual Basic
Syntax

forceRoundtrip ()

C/C++ Prototype

HRESULT forceRoundtrip ()

Return Value
HRESULT (O for success, or asigned integer error code)
generate
Read method
Description
The generate method generates code for the active configuration of the active component.
Visual Basic
Syntax

generate ()

C/C++ Prototype

HRESULT generate ()

Return Value

HRESULT (O for success, or asigned integer error code)
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getDiagramOfSelectedElement
Read method

Description

The getDiagramOfSelectedElement method retrieves the diagram of the current element.
Visual Basic
Syntax

getDiagramOfSelectedElement () As RPDiagram

Return Value
The RPDi agr am
C/C++ Prototype

HRESULT getDiagramOfSelectedElement (IRPDiagram** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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getErrorMessage
Read method

Description

The getErrorMessage method returns the most recent error message.

Visual Basic
Syntax

getErrorMessage (_ MIDL 0014 As String) As String
Return Value

A pointer to the most recent error message (a string)
C/C++ Prototype

HRESULT getErrorMessage (BSTR* MIDL 0014)

Arguments

BSTR*

A pointer to most recent error message

Return Value

HRESULT (O for success, or asigned integer error code)
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getListOfFactoryProperties

Note
Currently, this method has not been implemented.

Read method
Description

The getListOfFactoryProperties method returns the list of propertiesin the
<l ang> factory. prp file.

Visual Basic
Syntax

getListOfFactoryProperties () As RPCollection

Return Value
Thelist of properties defined in the <l ang>_f act ory. prp file
C/C++ Prototype

HRESULT getListOfFactoryProperties (IRPCollection** pvVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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getListOfSelectedElements
Read method

Description

The getListOfSelectedElements method returns a collection of model e ements.

In Version 4.1, this method was modified as follows:

* |f theinstanceis selected in the context of an OM D, the method returns an
| RPI nst ance instead of | RPCl ass or | RPAct or . See “IRPInstance I nterface”
for more information on this interface.

* |f alink is selected in the context of an OMD, the method returns an | RPLi nk
instead of | RPRel at i on. See“IRPLink Interface” for more information on this
interface.

+ If aninstanceis selected in the context of a sequence diagram, the method returns
an | RPA assi fi er Rol e instead of | RPA ass. See“|RPClassifierRole
Interface’ for more information on this interface.

Visual Basic
Syntax

getListOfSelectedElements () As RPCollection

Return Value
The collection of e ements
C/C++ Prototype

HRESULT getListOfSelectedElements (IRPCollection** pvVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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getListOfSiteProperties

Note
Currently, this method has not been implemented.

Read method
Description

The getListOfSiteProperties method returns the list of propertiesinthe<l ang>_site. prp
file.

Visual Basic
Syntax

getListOfSiteProperties () As RPCollection

Return Value
Thelist of properties defined in the <l ang>_si t e. pr p file
C/C++ Prototype

HRESULT getListOfSiteProperties (IRPCollection** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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getSelectedElement
Read method

Description

The getSelectedElement method retrieves the current model element.

In Version 4.1, this method was modified as follows:

* |f theinstanceis selected in the context of an OM D, the method returns an
| RPI nst ance instead of | RPCl ass or | RPAct or . See “IRPInstance I nterface”
for more information on this interface.

* |f alink is selected in the context of an OMD, the method returns an | RPLi nk
instead of | RPRel at i on. See“IRPLink Interface” for more information on this
interface.

+ If aninstanceis selected in the context of a sequence diagram, the method returns
an | RPA assi fi er Rol e instead of | RPA ass. See“|RPClassifierRole
Interface’ for more information on this interface.

Visual Basic
Syntax

getSelectedElement () As RPModelElement

Return Value
The current model element
C/C++ Prototype

HRESULT getSelectedElement (IRPModelElement** pvVal)

Return Value
HRESULT (O for success, or asigned integer error code)
VBA Example

The following example assumes that alink is selected.

Dim m As RPModelElement
Dim link as RPLink

Dim fromCls as RPClass
Dim toCls as RPClass
Dim from as RPInstance
Dim to as RPInstance
Dim rel as RPRelation

Set m = getSelectedElement
If m.metaClass = "Link" then
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link = m

from = link.from

to = link.to

fromCls = from.otherClass
toCls = to.otherClass

rel = link.instantiates

'Variable content:

'link points to the selected link.

'from points to the "source" instance.

'to points to the "target" instance.

'fromCls points to the class of the "source" instance.
'toCls points to the class of the "target" instance.
'rel points to the relation instantiated by the link.

MsgBox m.name & " is a link from instance " &
from.name &" of class " + clsFrom.name & " to
instance " & to.name & " of class " + toCls.name
& " which instantiates the " & rel.name

& " relation."
End If
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getTheExternalCodeGeneratorinvoker
Read method

Description

The getTheExternalCodeGeneratorlnvoker method returns the invoker for the external code
generator.

Visual Basic
Syntax

getTheExternalCodeGeneratorInvoker () As
RPExternalCodeGeneratorInvoker

Return Value

The RPExt er nal CodeGener at or | nvoker singleton. The external code generator queries
the application for this interface.

C/C++ Prototype

HRESULT getTheExternalCodeGeneratorInvoker (
IRPExternalCodeGeneratorInvoker** pvVal)

Return Value

HRESULT (O for success, or asigned integer error code)
highlightByHandle

Read method

Description
The highlightByHandle method highlights the specified model element, given its handle.
The rules for developing the handle for each element type are as follows:
1. Themetaclassin the beginning is the value of the metaClass property.
2. The GUID at the end of the nameis the value of the GUID property.

3. The structure of the name is as follows:

<Package name>::<Class name>.<Element name>

In this syntax:
+ <Package name> isthe full path of the package of the element (for example,
P1:: P2).
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— <Classfull name> isthe full path of the class of the element (for example,
ClL:: C2).

— <Element name> isthe name of the element.
See the section “Example’ for a code exampl e that uses this method.

Visual Basic
Syntax

highlightByHandle (strHandle As String)

Arguments

strHandle

The handle to the element to highlight. Call the method with this
argument using the following string:

" (<metaclass>) <FullPathName> (<GUID>) "

C/C++ Prototype

HRESULT highlightByHandle (BSTR strHandle)

Return Value

HRESULT (O for success, or asigned integer error code)
Example

Dim proj As RPProject
Dim m As RPModelElement
Dim str As String

Dim app As Object
set app = GetObject(, "Rhapsody.Application")

On Error GoTo aa

Set proj = getProject

Set m = proj.findNestedElementRecursive ("state 0", "State")

str = "(" & m.metaClass & ")" & m.getFullPathName & " (" & m.GUID & ")"
app.highlightByHandle (str)

Exit Sub

aa:

MsgBox errorMessage
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highLightElement
Read method

Description

Highlights the specified element.
Visual Basic
Syntax

highLightElement (val As RPModelElement)

Arguments

val

The element to highlight

C/C++ Prototype

HRESULT highLightElement (IRPModelElement* wval)

Return Value

HRESULT (O for success, or asigned integer error code)
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importClasses
Write method

Description

The importClasses method imports classes according to the reverse engineering setting stored
in the current configuration. Thisis equivalent to selecting the Rhapsody 6.1 command Tools
> Rever se Engineering.

Visual Basic
Syntax

importClasses ()

C/C++ Prototype

HRESULT importClasses ()

Return Value
HRESULT (O for success, or asigned integer error code)
make
Read method
Description
The make method builds the current component following the current configuration.
Visual Basic
Syntax

make ()

C/C++ Prototype

HRESULT make ()

Return Value

HRESULT (O for success, or asigned integer error code)
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openProject
Read method

Description
The gpenProject method opens a Rhapsody 6.1 project.

Note that helper applications might not close the current document. This means that you
should not use the openPr oj ect method in aVBA macro that you specify as a helper:

Visual Basic
Syntax

openProject (filename As String) As RPProject

Arguments

filename

The name of the file that contains the project

Return Value
A pointer to the opened project (an RPPr oj ect )
C/C++ Prototype

HRESULT openProject (BSTR filename, IRPProject** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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openProjectFromURL
Write method

Description

The gpenProjectFromURL method opens the Rhapsody 6.1 product at the specified URL. This
method is used to support the Webify Toolkit.

Visual Basic
Syntax

openProjectFromURL (url As String)

Arguments

url

The URL of the project to open

C/C++ Prototype

HRESULT openProjectFromURL (BSTR url)

Return Value

HRESULT (O for success, or asigned integer error code)
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openProjectWithLastSession
Write method

Description

The gpenProjectWithLastSession method opens the project using the settings from the
previous Rhapsody 6.1 session.

Visual Basic
Syntax

openProjectWithLastSession (filename As String)
As RPProject

Arguments

filename

The name of the project to open
Return Value
The RPProj ect that was opened

C/C++ Prototype

HRESULT openProjectWithlLastSession (BSTR filename,
IRPProject** pvVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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openProjectWithoutSubUnits

Write method

Description

The gpenProjectWithoutSubUnits method opens the Rhapsody 6.1 project without subunits.

Visual Basic
Syntax

openProjectWithoutSubUnits (filename As String)
As RPProject

Arguments

filename

The name of the project to open

C/C++ Prototype

HRESULT openProjectWithoutSubUnits (BSTR filename,
IRPProject** pvVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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quit
Read method
Description

The guit method closes the active Rhapsody 6.1 project.

Note that helper applications might not close the current document. This means that you
should not use the qui t method in a VBA macro that you specify as a helper:

Visual Basic
Syntax
quit ()
C/C++ Prototype
HRESULT quit ()

Return Value

HRESULT (O for success, or asigned integer error code)
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rebuild

Note
Currently, this method has not been implemented.

Read method
Description

Therebuild method rebuilds the application.

Visual Basic
Syntax

rebuild()

C/C++ Prototype

HRESULT rebuild()

Return Value

HRESULT (O for success, or asigned integer error code)
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refreshAllViews
Read method

Description

TherefreshAllviews method refreshes the views.
Visual Basic
Syntax

refreshAllViews ()

C/C++ Prototype
HRESULT refreshAllViews ()

Return Value
HRESULT (O for success, or asigned integer error code)
regenerate
Read method
Description
Theregenerate method regenerates the active configuration of the active component.
Visual Basic
Syntax
regenerate ()
C/C++ Prototype

HRESULT regenerate ()

Return Value

HRESULT (O for success, or asigned integer error code)
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report
Read method

Description

The report method generates areport in ASCII or RTF into the specified file. The report is
generated for the elements found in the scope of the current component.

Visual Basic
Syntax

report (format As String, outputFileName As String)
Arguments

format

The file format. The possible values are as follows:
ASCIT

RTF

outputFileName

The name of the output file, including the path.
C/C++ Prototype
HRESULT report (BSTR format, BSTR outputFileName)

Return Value

HRESULT (O for success, or asigned integer error code)
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roundtrip
Write method

Description
The roundtrip method roundtrips code changes back into the open model.
Visual Basic
Syntax
roundtrip ()
C/C++ Prototype

HRESULT roundtrip ()

Return Value

HRESULT (O for success, or asigned integer error code)
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setComponent

Write method

Description

The setComponent method sets the current component for the open project.

Visual Basic
Syntax
setComponent (component As String)
Arguments
component

The name of component in the project

C/C++ Prototype

HRESULT setComponent (BSTR component)

Return Value

HRESULT (O for success, or asigned integer error code)
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setConfiguration
Write method

Description

The setConfiguration method sets the current configuration for the open project.

Note: Thismethod failsif the configuration is not found within the current component.
Therefore, you should call set Conponent beforeset Confi gur ati on.

Visual Basic
Syntax

setConfiguration (configuration As String)
Arguments

configuration

The name of the configuration in the project. This refers to the simple name of the
configuration, not the full name, i.e., not packageA ::componentB::configC.

C/C++ Prototype

HRESULT setConfiguration (BSTR configuration)

Return Value

HRESULT (O for success, or asigned integer error code)
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setLog
Write method

Description

The setLog method creates alog file that records al the information that is normally displayed
in the Rhapsody 6.1 output window.

Visual Basic
Syntax

setLog (logFile As String)
Arguments

LogFile

The name of the log file, including the path

C/C++ Prototype

HRESULT setLog (BSTR logFile)

Return Value

HRESULT (O for success, or asigned integer error code)
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version
Read method

Description

The version method returns the version of Rhapsody 6.1 that corresponds to the current COM
API version.

Visual Basic
Syntax

version() As String

Return Value
The version of Rhapsody that corresponds to the COM API version
C/C++ Prototype

HRESULT version (BSTR* _ MIDL_0015)

Return Value

HRESULT (O for success, or asigned integer error code)
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IRPArgument Interface

The | RPAr gunent interface represents an argument of an operation or an event. It inherits

from | RPVari abl e.

VB Properties

Name Type Access Description

argumentDirection String RW The direction of the
argument (In, Out, or
InOut)

declaration String RW A string that represents an
inline declaration of this
argument

defaultValue String RW The default value of this
argument

typeOf RPType RW The type of this argument

Method Summary

setTypeDeclaration

Sets the C++ type declaration for this argument

104

API| Reference Manual



IRPArgument Interface

setTypeDeclaration
Write method

Description

The setTypeDeclaration method sets the C++ type declaration for this argument.

Visual Basic
Syntax

set TypeDecl arati on (newal As String)
Arguments

NewVal

The C++ type declaration for this argument

C/C++ Prototype

HRESULT setTypeDeclaration (BSTR newVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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IRPASCIIFile Interface

Thel RPASCI | Fi | e interface represents a disk file that you can open, close, and writeto. Itis
atop-level interface in the Rhapsody 6.1 object model.

Method Summary

close Closes a file
open Opens a file
write Writes to the specified file
close
Write method
Description

The close method closes the file.
Visual Basic

Syntax

close ()
C/C++ Prototype
HRESULT close

Return Value

HRESULT (O for success, or asigned integer error code)
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open
Write method

Description

The open method opens afile.
Visual Basic
Syntax

open (filename As String)

Arguments

filename

The name of file to open

C/C++ Prototype

HRESULT open (BSTR filename)

Return Value

HRESULT (O for success, or asigned integer error code)
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write
Write method

Description

Thewr i t e method writesto the specified file.
Visual Basic
Syntax

write (data As String)

Arguments

Data

The ASCII string data to write to the disk file

C/C++ Prototype

HRESULT write (BSTR data)

Return Value
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HRESULT (O for success, or asigned integer error code)

IRPAssociationClass Interface

Thel RPAssoci ati ond ass interface represents a Rhapsody 6.1 association (bi-directional,
directed, composition, or aggregation). | RPAssoci at i onC ass inherits from the
| RPCl ass.

See the User Guide for detailed information about associations.

VB Properties
Name Type Access Description
endl RPRel ati on | RO The first end of the
association line
end2 RPRel ati on | RO The second end of the
association line

IRPAssociationRole Interface

Thel RPAssoci at i onRol e interface represents a channel or relation through which objects
in acollaboration communicate. This object is meaningful only for collaborations displayed in
collaboration diagrams. | RPAssoci at i onRol e inheritsfrom the | RPMbdel El enent .

VB Properties
Name Type Access Description
roleType String RO The role type (specified or
unspecified)
Method Summary
getClassifierRoles Returns a collection of | RPCl assi fi er Rol es

linked by the current association role

getFormalRelations Returns a collection of | RPRel at i ons for the
current association role

Rhapsody 109



Rhapsody API Interfaces

getClassifierRoles
Read method

Description

The getClassifierRoles method returns a collection of | RPC assi f i er Rol es linked by the
current association role.

Note that an association role in a collaboration diagram is always bidirectional.
Visual Basic
Syntax

getClassifierRoles () As RPCollection

Return Value
A collection of classifier roles
C/C++ Prototype

HRESULT getClassifierRoles (
IRPCollection** classifierRoles)

Return Value

HRESULT (O for success, or asigned integer error code)
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IRPAssociationRole Interface

getFormalRelations
Read method

Description

The getFormalRelations method returns a collection of | RPRel at i ons for the current
association role. Pass one of the following values to the method:

¢ 0—Get the unspecified relations.
¢ 1—Get thedirectional relations.
¢ 2—Get the bidirectional relations.

Visual Basic
Syntax

getFormalRelations () As RPCollection

Return Value
A collection of RPRel at i ons
C/C++ Prototype

HRESULT getFormalRelations (
IRPCollection** classifierRoles)

Return Value

HRESULT (O for success, or asigned integer error code)
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IRPAttribute Interface

Thel RPAt t ri but e interface represents a class attribute. It Inheritsfrom | RPVar i abl e.

VB Properties

Name

Type

Access

Description

declaration

String

RW

The declaration of this
attribute. For an inline
declaration, this is an
uninterpreted string.

defaultValue

String

RW

The default value of this
attribute, if one has been
defined.

isConstant

Long

RW

A flag that indicates
whether the attribute is
read-only or modifiable.

isOrdered

Long

RW

A flag that specifies
whether the order of the
reference type items is
significant.

isReference

Long

RW

A flag that specifies
whether the attribute is
referenced as a reference
(such as a pointer (*) or an
address (&) in C++).

isStatic

Long

RW

A flag that indicates
whether this attribute is a
static class attribute. Static
status implies that the
attribute belongs to the
class as a whole rather
than to an individual
instance.

multiplicity

String

RW

The multiplicity of the
attribute. If this is greater
than 1, use the

i sOr der ed property to
specify whether the order
of the reference type items
is significant.

typeOf

RPType

RW

The type of this attribute.
For Rhapsody predefined
types, this is a reference to
that type.

visibility

String

RW

The visibility of this
attribute (public, protected,
or private).
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Method Summary

‘ setTypeDeclaration Updates the type declaration for the current attribute

setTypeDeclaration
Write method

Description

The setTypeDeclaration method updates the type declaration for the current attribute.

Visual Basic
Syntax

setTypeDeclaration (newVal As String)

Arguments

newVal

The type declaration for this attribute

C/C++ Prototype

HRESULT setTypeDeclaration (BSTR newVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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IRPBlock Interface

The | RPBI ock interface represents a block in Rhapsody 6.1. It inheritsfrom | RPI nst ance.

Method Summary

‘ addBlock Adds a block to the current package

addBlock
Write method

Description

The addBlock method adds a block to the current package.
Visual Basic
Syntax

addBlock (name As String) As RPBlock

Arguments

name

The name of the new block

Return Value
The new block

C/C++ Prototype

HRESULT addBlock (BSTR name, IRPBlock** pVal)

Return Value
HRESULT (O for success, or asigned integer error code)

Method Summary

setTypeDeclaration Updates the type declaration for the current attribute
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setTypeDeclaration
Write method

Description

The setTypeDeclaration method updates the type declaration for the current attribute.
Visual Basic
Syntax

setTypeDeclaration (newVal As String)

Arguments

newVal

The type declaration for this attribute

C/C++ Prototype

HRESULT setTypeDeclaration (BSTR newVal)

Return Value

HRESULT (O for success, or asigned integer error code)

Rhapsody 115



Rhapsody API Interfaces

IRPClass Interface

Thel RPCl ass interface represents Rhapsody 6.1 classes. It inheritsfrom | RPCl assi fi er.

VB Properties

Name

Type

Access

Description

isActive

Long

RW

Indicates whether this class is
an active class.

isBehaviorOverridden

Long

RW

Indicates whether the
statechart of the subclass
overrides the statechart of this
class.

A statechart is not inherited.

isComposite

Long

RO

Indicates whether this class is
a composite class.

isReactive

Long

RO

Indicates whether this class
has a statechart that is, it's a
reactive class).

Method Summary

addClass Adds a class to the current class
addConstructor Adds a constructor to the current class
addDestructor Adds a destructor to the current class

addEventReception

Adds an event reception to the current class

addLink

Adds a link between two objects to the current class

addReception

Adds a reception to the current class

addSuperclass

Adds a superclass to the current class

addTriggeredOperation

Adds a triggered operation to the current class

addType Adds a type to the current class
deleteClass Deletes a class from the current class

deleteConstructor

Deletes a constructor from the current class

deleteDestructor

Deletes a destructor from the current class

deleteEventReception

Deletes the specified event reception from the

current class

deleteReception

Deletes the specified reception from the current

class

deleteSuperclass

Deletes a superclass from the current class

deleteType

Deletes a type from the current class

116

API| Reference Manual




IRPClass Interface

addClass
Write method

Description

The addClass method adds a class to the current class.
Visual Basic
Syntax

addClass (name As String) As RPClass

Arguments

name

The name of the new class

Return Value
The new class
C/C++ Prototype

HRESULT addClass (BSTR name, IRPClass** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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addConstructor

Write method

Description

The addConstructor method adds a constructor to the current class.
Visual Basic
Syntax

addConstructor (argumentsData As String) As RPOperation

Arguments

argumentsData

The arguments for the constructor

Return Value

The new constructor for this class

C/C++ Prototype

HRESULT addConstructor (BSTR argumentsData,
IRPOperation** pval)

Return Value
HRESULT (O for success, or asigned integer error code)
Example

Sub addNetwork (c As RPClass)

Dim o As RPOperation

c.addOperation ("serialize")
c.addOperation ("unserialize")
c.addConstructor ("")

On Error Resume Next

c.addDestructor ("")

X = c.addStereotype ("G3Network", "Class")
End Sub
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addDestructor
Write method

Description

The addDestructor method adds a destructor to the current class.
Visual Basic
Syntax

addDestructor () As RPOperation
Return Value

The new destructor for this class
C/C++ Prototype

HRESULT addDestructor (IRPOperation** pval)
Return Value

HRESULT (O for success, or asigned integer error code)
Example

Sub addNetwork (¢ As RPClass)

Dim o As RPOperation

c.addOperation ("serialize")
c.addOperation ("unserialize")
c.addConstructor ("")

On Error Resume Next

c.addDbestructor ("")

X = c.addStereotype ("G3Network", "Class")
End Sub
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addEventReception
Write method

Description

The addEventReception method adds an event reception to the current class.

Visual Basic
Syntax

addEventReception (name As String) As RPEventReception

Arguments

name

The name of the new event reception for this class

Return Value
The new event reception
C/C++ Prototype

HRESULT addEventReception (BSTR name,
IRPEventReception** pval)

Return Value

HRESULT (O for success, or asigned integer error code)
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addLink
The adarink method adds a link between two objects to the current class.

Syntax

addLink (fromPart As RPInstance, toPart As RPInstance, assoc As RPRelation,
fromPort As RPPort, toPort As RPPort) As RPLink

Arguments

fromPart, toPart

The objects that are being linked.

assocC

Association that is being instantiated (optional).

fromPort, toPort

Ports that are being linked (optional).
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addReception

Write method

Description

The addReception method adds a reception to the current class.

Visual Basic
Syntax

addReception (name As String) As RPEventReception

Arguments

name

The name of the new reception for this class

Return Value
The new reception
C/C++ Prototype

HRESULT addReception (BSTR name,
IRPEventReception** pval)

Return Value

HRESULT (O for success, or asigned integer error code)
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addSuperclass
Write method

Description

The addSuperclass method inherits this class from anew superclass.

Visual Basic
Syntax
addSuperclass (superClass As RPClass)
Arguments
superClass

Specifies the RPCl ass from which this class will inherit

C/C++ Prototype

HRESULT addSuperclass (IRPClass* superClass)

Return Value

HRESULT (O for success, or asigned integer error code)
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addTriggeredOperation
Write method

Description

The addTriggeredOperation method adds a new triggered operation to the current class.

Visual Basic
Syntax

addTriggeredOperation (name As String) As RPOperation

Arguments

name

A string that specifies the name of the new trigger

Return Value
The new trigger for this class
C/C++ Prototype

HRESULT addTriggeredOperation (BSTR name,
IRPOperation** pval)

Return Value

HRESULT (O for success, or asigned integer error code)
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addType
Write method

Description

The addType method adds a type to the current class.
Visual Basic
Syntax

addType (name As String) As RPType

Arguments

name

The name of the new type

Return Value
The new type for this class
C/C++ Prototype

HRESULT addType (BSTR name, IRPType** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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deleteClass

Write method

Description

The deleteClass method deletes a class from the current class.

Visual Basic
Syntax

deleteClass (name As String)
Arguments

name

The name of the class to delete

C/C++ Prototype

HRESULT deleteClass (BSTR name)

Return Value

HRESULT (O for success, or asigned integer error code)
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deleteConstructor
Write method

Description

The deleteConstructor method deletes a constructor from the current class.

Visual Basic
Syntax

deleteConstructor (constructor As RPOperation)
Arguments

constructor

The constructor to delete

C/C++ Prototype

HRESULT deleteConstructor (IRPOperation* constructor)

Return Value

HRESULT (O for success, or asigned integer error code)
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deleteDestructor
Write method

Description
The deleteDestructor method deletes a destructor from the current class.
Visual Basic
Syntax
deleteDestructor ()
C/C++ Prototype

HRESULT deleteDestructor ()

Return Value

HRESULT (O for success, or asigned integer error code)
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deleteEventReception
Write method

Description

The deleteEventReception method del etes the specified event reception.

Visual Basic
Syntax

deleteEventReception (pVal As RPEventReception)
Arguments

pVal

The event reception to delete

C/C++ Prototype

HRESULT deleteEventReception (IRPEventReception* pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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deleteReception
Write method

Description

The deleteReception method del etes the specified reception.
Visual Basic
Syntax

deleteReception (pVal As RPEventReception)
Arguments

pVal

The event reception to delete
C/C++ Prototype
HRESULT deleteReception (IRPEventReception* pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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deleteSuperclass
Write method

Description

The deleteSuperclass method deletes the superclass for the current class.
Visual Basic
Syntax

deleteSuperclass (superClass As RPClass)

Arguments

superClass

The superclass (base class) to delete

C/C++ Prototype

HRESULT deleteSuperclass (IRPClass* superClass)

Return Value

HRESULT (O for success, or asigned integer error code)
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deleteType
Write method

Description
The deleteType method del etes a type from the current class.
Visual Basic
Syntax
deleteType (name As String)
Arguments

name

The type to delete

C/C++ Prototype

HRESULT deleteType (BSTR name)

Return Value

HRESULT (O for success, or asigned integer error code)
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IRPClassifier Interface

Thel RPC assi fi er interface is an abstract interface consisting of al the shared features of
classes, actors, use cases, and (data) types. It inherits from | RPUni t .

VB Properties
Name Type Access Description
activityDiagram RPFI owchar t RO The activity diagram
attributes Collection of RO A collection of attributes
RPAttri but es belonging to this classifier
baseClassifiers Collection of RO A collection of classifiers
RPCl assifiers from which this classifier is
derived (inherits)
derivedClassifiers Collection of RO A collection of classifiers
RPC assifiers that derive (inherit) from
this classifier
flows Collection of RO A collection of flows
RPI nf or mat i onFl ows belonging to this classifier
flowltems Collection of A collection of flowltems
RPI nformationltens belonging to this classifier
generdizations Collection of RO A collection of
RPCGeneral i zati ons generalizations that
generalize this classifier
(for which this classifier is
a specialization)
interfaceltems Collection of RO A collection of operations,
RPI nterfacel t ens events, and event
receptions belonging to
this classifier
nestedClassifiers Collection of RO A collection of classifiers
RPC assifiers defined in this classifier
operations Collection of RO A collection of operations
RPQper at i ons belonging to this classifier
ports RPCol | ecti on RO A collection of ports
belonging to this classifier
relations Collection of RO A collection of all relations
RPRel ati ons belonging to this classifier
statechart RPSt at echart * RO The handle to the

statechart of this class, if it
has one
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Method Summary

addActivityDiagram

Adds an activity diagram to the current class

addAttribute

Adds an attribute to the current class

addFlowltems

Adds the specified flowltem to the collection
of flowltems

addFlows

Adds the specified flow to the collection of
flows

addGeneralization

Adds a generalization to the current class

addOperation

Adds an operation to the current class

addRelation Adds a symmetric relation between the
current class and another one
addStatechart Adds a statechart to the current class

addUnidirectionalRelation

Adds a directional relation from the current
class to another class

deleteActivityDiagram

Deletes the specified activity diagram from
the current class

deleteAttribute

Deletes the specified attribute from the
current class

deleteFlowltems

Deletes the specified flowltem from the
collection of flowltems

deleteFlows

Deletes the specified flow from the
collection of flows

deleteGeneralization

Deletes the specified generalization from
the current class

deleteQperation

Deletes the specified operation from the
current class

deleteRelation

Deletes the specified relation from the
current class

deleteStatechart

Deletes the specified statechart from the
current class

findAttribute

Retrieves the specified attribute of the
classifier

findBaseClassifier

Retrieves a base (parent) classifier of a
classifier

findDerivedClassifier

Retrieves the specified derived classifier of
a classifier

findGeneralization

Retrieves the specified generalization of a
classifier

findInterfaceltem

Retrieves an operation or event reception of
the given signature that belongs to a
classifier

134

API| Reference Manual




IRPClassifier Interface

findNestedClassifier

Retrieves the specified classifier defined
within this object

findNestedClassifierRecursive

Retrieves the specified classifier defined in
this object and in objects defined within this
object

findRelation Retrieves the specified relation that belongs
to the current classifier
findTrigger Retrieves the specified trigger in the

statechart of the current class

getAttributesincludingBases

Retrieves the attributes defined for this
class and the ones inherited from its
superclasses

getinterfaceltemsincludingBases

Retrieves the operations and event
receptions defined for this class and the
ones it inherited from its superclasses

getRelationsincludingBases

Retrieves the relations defined for this class
and the ones it inherited from its
superclasses

Note

Some of the properties and methods are meaningful only for some of the derived interfaces.
When meaningless, the call will return nothing (NULL) or an empty collection.
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addActivityDiagram
Write method

Description

The addActivityDiagram method adds an activity diagram to the current class.

Visual Basic
Syntax

addActivityDiagram () As RPFlowchart

Return Value
The new activity diagram
C/C++ Prototype

HRESULT addActivityDiagram (IRPFlowchart** pvVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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addAttribute
Write method

Description

The addAttribute method adds an attribute to the current class.
Visual Basic
Syntax

addAttribute (name As String) As RPAttribute

Arguments

name

The name of the new attribute

C/C++ Prototype

HRESULT addAttribute (BSTR name, IRPAttribute** pval)

Return Value

HRESULT (O for success, or asigned integer error code)
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addFlowltems
Write method

Description

The addFlowltems method adds the specified flowltem to the collection of flowltems.
Visual Basic
Syntax

addFlowItems (name As String) As RPFlowItem

Arguments

name

The name of the new flowItem

C/C++ Prototype

HRESULT addFlowItems (BSTR name, IRPFlowItem** ppItem)

Return Value

HRESULT (O for success, or asigned integer error code)
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addFlows
Write method

Description

The addFlows method adds the specified flow to the collection of flows.
Visual Basic
Syntax

addFlows (name As String) As RPFlow

Arguments

name

The name of the new flow

C/C++ Prototype

HRESULT addFlows (BSTR name, IRPFlow** ppFlow)

Return Value

HRESULT (O for success, or asigned integer error code)
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addGeneralization
Write method

Description

The addGeneralization method adds a generalization to the current class.

Visual Basic
Syntax

addGeneralization (pVal As RPClassifier)
Arguments

pVal

The generalization to add to this class

C/C++ Prototype

HRESULT addGeneralization (IRPClassifier *pVval)

Return Value

HRESULT (O for success, or asigned integer error code)
Example

Sub addUi (c As RPClass)

Dim x As Object

Dim p As RPPackage

Dim theClass As RPClass

'all gui objects are derived from GUI.UIBase

c.Description = "gui class"

On Error Resume Next

Set p = pr.findNestedElement ("GUI", "Package")

Set theClass = p.findNestedElement ("UIBase", "Class")

c.addGeneralization theClass

If Not Err.Number = 0 Then
MsgBox (errorMessage)
End If

c.addStereotype "G3UI", "Class"
End Sub
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addOperation
Write method
Description
The addOperation method adds an operation to the current class.
Visual Basic
Syntax
addOperation (name As String) As RPOperation
Arguments

name

The name of the new operation

Return Value
The operation added to this class
C/C++ Prototype

HRESULT addOperation (BSTR name, IRPOperation** pVal)

Return Value
HRESULT (O for success, or asigned integer error code)
Example

Sub addNetwork (c As RPClass)

Dim o As RPOperation

c.addOperation ("serialize")
c.addOperation ("unserialize")
c.addConstructor ("")

On Error Resume Next

c.addDestructor ("")

X = c.addStereotype ("G3Network", "Class")
End Sub
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addRelation
Write method

Description

The addRelation method adds a symmetric relation between the current class and another one.
Visual Basic
Syntax

addRelation (otherClassName As String,
otherClassPackageName As String,
roleNamel As String, 1linkTypel As String,
multiplicityl As String, roleName2 As String,
linkType2 As String, multiplicity2 As String,
linkName As String) As RPRelation

Arguments

OtherClassName

The name of the other class involved in the new relation with the
current class.

OtherClassPackageName
The name of the package containing the other class.
roleNamel

The role name of the other class, from the point of view of the current
class.

roleName2

The role name of the current class, from the point of view of the other
class.

linkTypel

The relation type. The possible values are as follows:
Aggregation

Association

Composition

linkType2

The second relation type. The possible values are as follows:
Aggregation

Association

Composition

multiplicityl

The multiplicity of instances for the other class.

multiplicity2
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The multiplicity of instances for the current class.
linkName

The name of the link. This is a descriptive and explanatory field that
plays no part in code generation.

Notes
The valid combinations of linkTypel and linkType2 are as follows:
Association/Association--I know you; you know me.
Aggregation/Association--I belong to you; you know me.
Composition/Association--I strongly belong to you; you know me.
Association/Aggregation--I know you; you belong to me.
Associlation/Composition--I know you; you strongly belong me.

Return Value

The new relation
C/C++ Prototype

HRESULT addRelation (BSTR otherClassName,
BSTR otherClassPackageName, BSTR roleNamel,
BSTR linkTypel, BSTR multiplicityl, BSTR roleName2,
BSTR linkType2, BSTR multiplicity2, BSTR linkName,
IRPRelation** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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addStatechart

Write method

Description

The addStatechart method adds a statechart to the current class.

Visual Basic
Syntax

addStatechart () As RPStatechart

Return Value
The new statechart
C/C++ Prototype

HRESULT addStatechart (IRPStatechart** pval)

Return Value

HRESULT (O for success, or asigned integer error code)
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addUnidirectionalRelation

Write method

Description

The addUnidirectionalRelation method adds a directional relation from the current class to

another class.

Visual Basic

Syntax

addUnidirectionalRelation (otherClassName As String,
otherClassPackageName As String,
roleName As String, linkType As String,
multiplicity As String,
linkName As String) As RPRelation

Arguments

OtherClassName

The name of the other class involved in the new relation with the
current class.

OtherClassPackageName
The name of the package containing the other class.
roleName

The role name of the other class, from the point of view of the current
class.

linkType

The relation type. The possible values are as follows:
Aggregation

Association

Composition

multiplicity

The multiplicity of instances for the other class.
linkName

The name of the link. This is a descriptive and explanatory field that
plays no part in code generation.

Return Value

The new relation
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C/C++ Prototype

HRESULT addUnidirectionalRelation (BSTR otherClassName,
BSTR otherClassPackageName, BSTR roleName,
BSTR 1linkType, BSTR multiplicity, BSTR linkName,
IRPRelation** pVal)

Return Value
HRESULT (O for success, or asigned integer error code)
deleteActivityDiagram
Write method
Description

The deleteActivityDiagram method deletes the specified activity diagram from the current
class.

Visual Basic
Syntax

deleteActivityDiagram ()

C/C++ Prototype
HRESULT deleteActivityDiagram()

Return Value

HRESULT (O for success, or asigned integer error code)
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deleteAttribute
Write method

Description

The deleteAttribute method deletes the specified attribute from the current class.
Visual Basic
Syntax

deleteAttribute (attribute As RPAttribute)

Arguments

attribute

The attribute to delete

C/C++ Prototype

HRESULT deleteAttribute (IRPAttribute* attribute)

Return Value

HRESULT (O for success, or asigned integer error code)
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deleteFlowltems

Write method

Description

The deleteFlowltems method deletes the specified flowltem from the collection of flowltems.

Visual Basic
Syntax

deleteFlowItems (pItem As RPFlowItem)
Arguments

pFlowItem

The flowItem to delete

C/C++ Prototype

HRESULT deleteFlowItems (IRPFlowItem* pItem)

Return Value

HRESULT (O for success, or asigned integer error code)
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deleteFlows
Write method

Description

The deleteFlows method deletes the specified flow from the collection of flows.
Visual Basic
Syntax

deleteFlows (pFlow As RPFlow)

Arguments

pFlow

The flow to delete

C/C++ Prototype

HRESULT deleteFlows (IRPFlow* pFlow)

Return Value

HRESULT (O for success, or asigned integer error code)
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deleteGeneralization
Write method

Description

The deleteGeneralization method deletes the specified generalization from the current class.
Visual Basic
Syntax

deleteGeneralization (superClass As RPClassifier)

Arguments

superClass

The superclass of the current class to be deleted

C/C++ Prototype

HRESULT deleteGeneralization (IRPClassifier* superClass)

Return Value

HRESULT (O for success, or asigned integer error code)

150 API| Reference Manual



IRPClassifier Interface

deleteOperation
Write method

Description

The deleteOperation method del etes the specified operation from the current class.
Visual Basic
Syntax

deleteOperation (operation As RPOperation)

Arguments

operation

The operation to delete

C/C++ Prototype

HRESULT deleteOperation (IRPOperation* operation)

Return Value

HRESULT (O for success, or asigned integer error code)
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deleteRelation

Write method

Description

The deleteRelation method del etes the specified relation from the current class.

Visual Basic
Syntax

deleteRelation (relation As RPRelation)
Arguments

relation

The relation to delete

C/C++ Prototype

HRESULT deleteRelation (IRPRelation* relation)

Return Value

HRESULT (O for success, or asigned integer error code)
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deleteStatechart
Write method

Description
The deleteStatechart method deletes the specified statechart from this class.
Visual Basic
Syntax
deleteStatechart ()
C/C++ Prototype

HRESULT deleteStatechart ()

Return Value

HRESULT (O for success, or asigned integer error code)
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findAttribute
Read method

Description

ThefindAttribute method retrieves the specified attribute of the classifier.
Visual Basic
Syntax

findAttribute (name As String) As RPAttribute

Arguments

name

The name of the attribute to find

Return Value
The named attribute of the classifier
C/C++ Prototype

HRESULT findAttribute (BSTR newVal, IRPAttribute** pVval)

Return Value

HRESULT (O for success, or asigned integer error code)
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findBaseClassifier
Read method

Description

ThefindBaseClassifier method retrieves a base (parent) classifier of aclassifier.

Visual Basic
Syntax

findBaseClassifier (newVal As String) As RPClassifier

Arguments

newVal

The name of the base classifier

Return Value
The base classifier of this classifier
C/C++ Prototype

HRESULT findBaseClassifier (BSTR newVal,
IRPClassifier** pval)

Return Value

HRESULT (O for success, or asigned integer error code)
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findDerivedClassifier
Read method

Description

ThefindDerivedClassifier method retrieves the specified derived classifier of aclassifier.

Visual Basic
Syntax

findDerivedClassifier (newVal As String) As RPClassifier

Arguments

newVal

The name of the derived classifier of this classifier

Return Value
The derived classifier of this classifier
C/C++ Prototype

HRESULT findDerivedClassifier (BSTR newVal,
IRPClassifier** pval)

Return Value

HRESULT (O for success, or asigned integer error code)
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findGeneralization
Read method

Description

The findGeneralization method retrieves the specified generalization that belongs to this
classifier.

Visual Basic

Syntax

findGeneralization (newVal As String) As RPGeneralization

Arguments

newVal

The name of the generalization

Return Value
The RPGener al i zat i on
C/C++ Prototype

HRESULT findGeneralization (BSTR newVal,
IRPGeneralization** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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findInterfaceltem
Read method

Description

The findinterfaceltem method retrieves an operation or event reception of the given signature
that belongs to a classifier.

Visual Basic
Syntax

findInterfaceItem (signature As String)
As RPInterfaceltem

Arguments

signature

The signature of the operation or event reception of this classifier

Return Value
The operation or event reception
C/C++ Prototype

HRESULT findInterfaceItem (BSTR signature,
IRPInterfacelItem** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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findNestedClassifier
Read method

Description

The findNestedClassifier method retrieves the specified classifier defined within this object.

Visual Basic
Syntax

findNestedClassifier (newVal As String) As RPClassifier

Arguments

newVal

The name of the nested classifier

Return Value
The nested classifier within this classifier
C/C++ Prototype

HRESULT findNestedClassifier (BSTR newVal,
IRPClassifier** pval)

Return Value

HRESULT (O for success, or asigned integer error code)
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findNestedClassifierRecursive

Read method
Description

ThefindNestedClassifierRecursive method recursively retrieves the specified classifier defined
in this object and in objects defined within this object.

Visual Basic
Syntax

findNestedClassifierRecursive (newVal As String)
As RPModelElement

Arguments

newVal

The name of the nested classifier (at any level of ownership)

Return Value
The nested classifier
C/C++ Prototype

HRESULT findNestedClassifierRecursive (BSTR newVal,
IRPModelElement** pvVal)

Return Value

HRESULT (O for success, or asigned integer error code)

160

API| Reference Manual



IRPClassifier Interface

findNestedGeneralization
Read method

Description

The findNestedGeneralization method retrieves the specified generalization relation.

Visual Basic
Syntax

findGeneralization (name As String) As IRPGeneralization

Arguments

name

A string that specifies the name of the generalization to find

Return Value
The generalization for this classifier (an | RPGener al i zat i on)
C/C++ Prototype

HRESULT findGeneralization (BSTR newVal,
IRPGeneralization** pvVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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findRelation
Read method

Description

ThefindRelation method retrieves the specified relation that belongs to the current classifier.
Visual Basic
Syntax

findRelation (newVal As String) As RPRelation

Arguments

newVal

The name of the relation to find

Return Value
The classifier'srelation
C/C++ Prototype

HRESULT findRelation (BSTR newVal, IRPRelation** pval)

Return Value

HRESULT (O for success, or asigned integer error code)
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findTrigger
Read method

Description

ThefindTrigger method retrieves the specified trigger in the statechart of the current class.
Visual Basic
Syntax

findTrigger (name As String) As RPInterfaceltem

Arguments

name

The name of the trigger to find

Return Value
The trigger
C/C++ Prototype

HRESULT findTrigger (BSTR name, IRPInterfaceltem** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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getAttributesincludingBases

Read method

Description

The getAttributesincludingBases method retrieves the attributes defined for this class and the

ones inherited from its superclasses.
Visual Basic
Syntax

getAttributesIncludingBases () As RPCollection

Return Value
A collection of class attributes (RPAt t ri but es)
C/C++ Prototype

HRESULT getAttributesIncludingBases (
IRPCollection** pval)

Return Value

HRESULT (O for success, or asigned integer error code)
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getinterfaceltemsincludingBases
Read method

Description

The getinterfaceltemsincludingBases method retrieves the operations and event receptions
defined for this class and the ones it inherited from its superclasses.

Visual Basic
Syntax

getInterfaceIltemsIncludingBases () As RPCollection

Return Value
A collection of interface items
C/C++ Prototype

HRESULT getInterfaceItemsIncludingBases (
IRPCollection** pval)

Return Value

HRESULT (O for success, or asigned integer error code)
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getRelationsincludingBases
Read method

Description

The getRelationsIncludingBases method retrieves the relations defined for this class and the
onesit inherited from its superclasses.

Visual Basic
Syntax

getRelationsIncludingBases () As RPRelations

Return Value
A collection of relations
C/C++ Prototype

HRESULT getRelationsIncludingBases (IRPCollection** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)

166 API| Reference Manual



IRPClassifierRole Interface

IRPClassifierRole Interface

Thel RPCl assi fi er Rol e interface represents an object participating in the collaboration. It
usually corresponds to some object of a given class or actor. It inherits from

| RPMbdel El enent .

VB Properties
Name Type Access Description

formal Classifier RPCl assi fi er RO The classifier (NULL
(unspecified),
systemBorder, or
multipleObjects)

referencedSequenceDiagram | RPSequence RW The referenced sequence

Di agram diagram
roleType String RO The role type (unspecified,

systemBorder, class,
actor, or multipleObjects)
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IRPCollaboration Interface

Thel RPCol | abor at i on interface represents the logical collaboration, devoid of any

sequence diagram or collaboration diagram graphics. Note that the two diagrams give rise to

similar but dlightly different | RPCol | abor at i on objects. This classinherits from
| RPModel El enment .

VB Properties

Name

Type

Access

Description

activationCondition

CString

RO

The activation condition. This
can be empty.

activationMode

CString

RO

The activation mode (initial,
invariant, or unspecified).

associations

RPAssoci ati onRol es

RO

A collection of

RPAssoci ati onRol esin
the collaboration diagram.
This applies only to
collaboration diagram-based
| RPCol | abor ati ons.

classifier

RPCl assi fi er Rol es

RO

A collection of
RPCl assi fi erRol esin
the collaboration diagram.

messagePoints

RPMessagePoi nt s

RO

A collection of
RPMessagePoi nt s. For
sequences, this is the way of
obtaining full information
about the order of messages
in the sequence diagram. For
collaborations, each send
messagepoint is immediately
followed by a receive
messagepoint on the same
message.

messages

RPMessages

RO

A collection of
RPMessages. For
collaborations, this list
contains all information
regarding the order of
elements in the model. For
sequences, some information
is lost and the message list is
ordered by the send time (as
opposed to the receive time).

mode

Cstring

RO

The mode (existential,
universal, or unspecified).
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Method Summary

addCancelledTimeout

Adds a cancelled timeout to the diagram

addClassifierRole

Adds a classifier role

addClassifierRoleByName

Adds a classifier role, given its name

addCtor

Adds a constructor

addDtor

Adds a destructor

addInteractionOccurrence

Adds an interaction occurrence (reference
diagram) to the diagram

addMessage

Adds a message

addSystemBorder

Adds a system border

addTimelnterval

Adds a time interval to the diagram

addTimeout Adds a timeout the diagram
generateSequence Generates the specified sequence diagram
getConcurrentGroup Retrieves the activation messages
getConcurrentGroup Retrieves all the messages concurrent with

the input message, including the input
message itself

getMessagePoints

Returns an ordered collection of all
messagepoints occurring on this classifier

getPredecessor Retrieves the message that precedes the
specified message
getSuccessor Retrieves the message that follows the

specified message
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addCancelledTimeout
Write method

Description

The addCancelledTimeout method adds a cancelled timeout to a collaboration diagram.

Visual Basic
Syntax

addCancelledTimeout (receiver As RPClassifierRole)
As RPMessage

Arguments

receiver

The receiver object for the timeout

Return Value
The new cancelled timeout
C/C++ Prototype

HRESULT addCancelledTimeout (IRPClassifierRole *receiver,
IRPMessage **pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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addClassifierRole
Write method

Description

The addClassifierRole method adds a classifier role.

Visual Basic
Syntax

addClassifierRole (newVal As String, cls As RPClass)
As RPClassifierRole

Arguments

newVal
The name of the new classifier role
cls

The name of the class

Return Value
The new RPCl assi fi er Rol e
C/C++ Prototype

HRESULT addClassifierRole (BSTR newVal, IRPClass *cls,
IRPClassifierRole** pval)

Return Value

HRESULT (O for success, or asigned integer error code)
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addClassifierRoleByName

Write method

Description

The addClassifierRoleByName method adds the specified classifier role.

Visual Basic
Syntax

addClassifierRoleByName (newVal As String,
classFullPath As String) As RPClassifierRole

Arguments

newVal
The name of the classifier role to add
classFullPath

The full path to the class

Return Value
The new RPCl assi fi er Rol e
C/C++ Prototype

HRESULT addClassifierRoleByName (BSTR newVal,
BSTR classFullPath, IRPClassifierRole** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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addCtor
Write method

Description

The addCtor method adds a constructor.
Visual Basic
Syntax

addCtor (interItem As RPInterfaceltem,
actualParamlList As String, sender As RPClassifierRole,
receiver As RPClassifierRole) As RPMessage

Arguments

interItem

The interface item

actualParamList

The list of parameters for the constructor
sender

The RPCl assifierRol e that acts as the sender
receiver

The RPCl assifierRol e that acts as the receiver
Return Value

an RPMessage
C/C++ Prototype

HRESULT addCtor (IRPInterfacelItem *interItem,
BSTR actualParamList, IRPClassifierRole *sgender,
IRPClassifierRole *receiver, IRPMessage** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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addDtor
Write method

Description

The addDtor method adds a destructor.
Visual Basic
Syntax

addDtor (interItem As RPInterfaceltem,
actualParamlList As String, sender As RPClassifierRole,
receiver As RPClassifierRole) As RPMessage

Arguments

interItem

The interface item

actualParamList

The list of parameters for the constructor
sender

The RPCl assifierRol e that acts as the sender
receiver

The RPCl assifierRol e that acts as the receiver
Return Value

an RPMessage
C/C++ Prototype

HRESULT addDtor (IRPInterfacelItem *interItem,
BSTR actualParamList, IRPClassifierRole *sgender,
IRPClassifierRole *receiver, IRPMessage** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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addInteractionOccurrence
Write method

Description

The addinteractionOccurrence method adds a new interaction occurrence (reference diagram)
to the collaboration diagram.

Visual Basic
Syntax

addInteractionOccurrence () As RPInteractionOccurrence

Return Value
The new interaction occurrence
C/C++ Prototype

HRESULT addInteractionOccurrence (
IRPInteractionOccurrence** pval)

Return Value

HRESULT (O for success, or asigned integer error code)
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addMessage
Write method

Description

The addMessage method adds a message.
Visual Basic
Syntax

addMessage (interItem As RPInterfaceltem,
actualParamlList As String, sender As RPClassifierRole,
receiver As RPClassifierRole) As RPMessage

Arguments

interItem

The interface item

actualParamList

The list of parameters for the constructor
sender

The RPCl assifierRol e that acts as the sender
receiver

The RPCl assifierRol e that acts as the receiver
Return Value

The new message

C/C++ Prototype

HRESULT addMessage (IRPInterfaceltem *interItem,
BSTR actualParamList, IRPClassifierRole *sgender,
IRPClassifierRole *receiver, IRPMessage** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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addSystemBorder
Write method

Description

The addSystemBorder method adds a system border to the collaboration diagram.
Visual Basic
Syntax

addSystemBorder () As RPClassifierRole

Return Value
The new system border
C/C++ Prototype

HRESULT addSystemBorder (IRPClassifierRole** pvVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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addTimelnterval

Write method
Description

The addTimelnterval method adds atime interval to the diagram.
Visual Basic
Syntax

addTimeInterval (receiver As RPClassifierRole)
As RPMessage

Arguments

interItem

The interface item

Return Value

The new time interval

C/C++ Prototype

HRESULT addTimeInterval (IRPClassifierRole *receiver,
IRPMessage** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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addTimeout
Write method

Description

The addTimeout method adds a timeout.
Visual Basic
Syntax

addTimeout (interItem As RPInterfaceltem,
actualParamlList As String, sender As RPClassifierRole,
receiver As RPClassifierRole) As RPMessage

Arguments

interItem

The interface item

actualParamList

The list of parameters for the constructor
sender

The RPCl assifierRol e that acts as the sender
receiver

The RPCl assifierRol e that acts as the receiver
Return Value

The new timeout
C/C++ Prototype

HRESULT addTimeout (IRPInterfacelItem *interItem,
BSTR actualParamList, IRPClassifierRole *sgender,
IRPClassifierRole *receiver, IRPMessage** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)

Rhapsody

179



Rhapsody API Interfaces

generateSequence
Write method

Description

The generateSequence method generates the specified sequence diagram.

Visual Basic
Syntax

generateSequence (newVal As String, owner As RPPackage)
As RPSequenceDiagram

Arguments

newVal
The name of the sequence diagram to generate
owner

The owner package
Return Value

The new RPSequenceDi agram
C/C++ Prototype

HRESULT generateSequence (BSTR newVal, IRPPackage* owner,
IRPSequenceDiagram** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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getActivator
Read method

Description

The getActivator method retrieves the activation messages.

Visual Basic
Syntax

getActivator (msg As RPMessage) As RPMessage

Arguments

msg

The message to retrieve

Return Value
A collection of RPMessages
C/C++ Prototype

HRESULT getActivator (IRPMessage* msg,
IRPMessage** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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getConcurrentGroup
Read method

Description

The getConcurrentGroup method retrieves all the messages concurrent with the input message,
including the input message itself. If the message does not have any concurrent messages
because it is sequential, the method returns only the message itself.

Visual Basic
Syntax

getConcurrentGroup (message As RPMessage) As RPMessages

Arguments

message

The group of messages to retrieve

Return Value
A collection of RPMessages
C/C++ Prototype

HRESULT getConcurrentGroup (IRPMessage* message,
IRPCollection** pval)

Return Value

HRESULT (O for success, or asigned integer error code)
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getMessagePoints
Read method

Description

The getMessagePoints method returns an ordered collection of all messagepoints occurring on
this classifier.

Visual Basic
Syntax

getMessagePoints (classifier As RPClassifierRole)
As RPCollection

Arguments

classifier

The RPCl assifier whose messagepoints you want to retrieve

Return Value
A collection of RPMessagePoi nt s
C/C++ Prototype

HRESULT getMessagePoints (IRPClassifier* classifier,
IRPCollection** pval)

Return Value

HRESULT (O for success, or asigned integer error code)
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getPredecessor
Read method

Description

The getPredecessor method retrieves the message that precedes the specified message.
Visual Basic
Syntax

getPredecessor (message As RPMessage) As RPMessage

Arguments

message

The message whose predecessor you want

Return Value
The message that precedes the specified message
C/C++ Prototype

HRESULT getPredecessor (IRPMessage *message,
IRPMessage** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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getSuccessor
Read method

Description

The getSuccessor method retrieves the message that follows the specified message.
Visual Basic
Syntax

getSuccessor (message As RPMessage) As RPMessage

Arguments

message

The message whose successor you want

Return Value
The message that follows the specified message
C/C++ Prototype

HRESULT getSuccessor (IRPMessage *message,
IRPMessage** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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IRPCollaborationDiagram Interface

Thel RPCol | abor at i onDi agr aminterface represents a collaboration diagram. It inherits
from | RPDi agr am

Method Summary

getLogicalCollaboration Retrieves the logic behind the collaboration
diagram

getLogicalCollaboration
Read method

Description

The getLoagicalCollaboration method retrieves the logic behind the collaboration diagram.

Visual Basic
Syntax

getLogicalCollaboration() As RPCollaboration

Return Value
The collaboration diagram
C/C++ Prototype

HRESULT getLogicalCollaboration (IRPCollaboration** pval)

Return Value

HRESULT (O for success, or asigned integer error code)
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IRPCollection Interface

Thel RPCol | ect i on interfaceis a utility class used to return collections of

| RPMvbdel El enent s. Methods and attributes that need to return more than one element
always return a pointer to an | RPCol | ecti on.

| RPCol | ect i on also supports VB iteration viathe following construct:

For Each obj in col

VB Properties
Name Type Access Description
Count Long RO The number of elements
currently in the collection
Item(long i) RPModel El enent * RO The ith element in the
collection

Method Summary

addltem Adds an item to the collection
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addltem
Write method

Description

The additem method adds an item to the collection.

Visual Basic
Syntax

addItem (newVal As RPModelElement)

Arguments

newVal

The new item to add

C/C++ Prototype

HRESULT addItem (IRPModelElement* newVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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IRPComment Interface

The | RPConment interface represents Rhapsody comments. It inherits from
| RPAnnot at i on.

IRPComponent Interface

Thel RPConponent interface represents a code generation component. It inherits from
| RPUNi t .

VB Properties

Name Type Access Description

additional Sources String RW The additional source files
to be compiled with the
component.

buildType String RW The build type (library or
executable).

configurations Collection of RW The configurations of this
RPConfi gurati on component.

files Collection of RPFi | es RO The files of this
component.

includePath String RW The path to standard
headers to be linked with
the component.

libraries String RW The libraries to be linked
with the component (for
example, "X. | i b,
y.lib, z.lib").

nestedComponents Collection of RO The components nested in
RPConmponent this component.

path(full Path) String(path) RO The string containing the
path to the component.If

ful | Pat his True, the
Bool ean(ful | Pat h) full path is returned:

<drive>:\

<model dir>\
<conponent dir>\
<config dir>)

If fullPath is Fal se, the
path relative to the project
is returned:

<conponent dir>\
<config dir>
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Name

Type Access

Description

Collection of RO

scopeElements

RPMbdel El enent

The logical elements
allocated to this
component.

standardHeaders

String

to be linked with the
component.

Method Summary

addConfiguration

Adds a configuration to this component

addFile

Adds an empty file to the current component

addFolder

Adds an empty folder to the current component

addNestedComponent

Adds a component to the current component

addScopeElement

Places a model element within the scope of the
current component

addToScope

Places the specified file, classes, and packages
within the scope of the current component

allElementsinScope

Places all model elements within the scope of
the current component

deleteConfiguration

Deletes the specified configuration from the
current component

deleteFile

Deletes the specified file from the current
component

findConfiguration

Retrieves the specified configuration in the
current component

getConfigByDependency

Retrieves the appropriate configuration to use
in the component on which the current
component depends

getFile Returns the file in which the specified classifier
will be generated
getFileName Retrieves the name of the file to which the

specified classifier will be generated in this
component

getModelElementFileName

Gets the file name of the specified model
element

getPackaqgeFile

Returns the package file

removeScopeElement

Deletes a scope element

setPath

Sets the path of the application built for this
component
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addConfiguration
Write method

Description

The addConfiguration method adds a configuration to the current component.

Visual Basic
Syntax

addConfiguration (name As String) As RPConfiguration

Arguments

name

The name of the new configuration

Return Value
The new configuration
C/C++ Prototype

HRESULT addConfiguration (BSTR name,
IRPConfiguration** configuration)

Return Value

HRESULT (O for success, or asigned integer error code)
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addFile

Write method

Description

The addFile method adds an empty file to the current component.

Visual Basic
Syntax

addFile (name As String) As RPFile

Arguments

name

The name of the new file

Return Value
The file added to the component
C/C++ Prototype

HRESULT addFile (BSTR name, IRPFile** file)

Return Value

HRESULT (O for success, or asigned integer error code)
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addFolder
Write method

Description

The addFolder method adds an empty folder to the current component.
Visual Basic
Syntax

addFolder (name As String) As RPFile

Arguments

name

The name of the new folder

Return Value
The folder added to the component
C/C++ Prototype

HRESULT addFolder (BSTR name, IRPFile** file)

Return Value

HRESULT (O for success, or asigned integer error code)
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addNestedComponent
Write method

Description

The addNestedComponent method adds a component to the current component.

Visual Basic
Syntax

addNestedComponent (name As String) As RPComponent

Arguments

name

The name of the component to add

Return Value
The component added to the current component
C/C++ Prototype

HRESULT addNestedComponent (BSTR name,
IRPComponent** pval)

Return Value

HRESULT (O for success, or asigned integer error code)
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addScopeElement
Write method

Description

The addScopeElement method places a model element within the scope of the current
component.

Visual Basic
Syntax

addScopeElement (pVal As RPModelElement)

Arguments

pval

The RPMbdel El enent to place in the scope of the current component

C/C++ Prototype

HRESULT addScopeElement (IRPModelElement* pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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addToScope
Write method

Description

The addToScope method places the specified file, classes, and packages within the scope of
the current component.

Visual Basic
Syntax

addToScope (file As RPFile,
classes As RPCollection, packages As RPCollection)

Arguments

file

The file to place in scope of the current component
classes

The classes to place in scope of the current component
packages

The packages to place in scope of the current component
C/C++ Prototype

HRESULT addToScope (IRPFilex* file,
IRPCollection* classes, IRPCollection* packages)

Return Value

HRESULT (O for success, or asigned integer error code)
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allElementsinScope
Write method

Description

The allElementsinScope method places al model elements within the scope of the current
component.

Visual Basic
Syntax

allElementsInScope ()

C/C++ Prototype

HRESULT allElementsInScope ()

Return Value

HRESULT (O for success, or asigned integer error code)
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deleteConfiguration
Write method

Description

The deleteConfiguration method del etes the specified configuration from the current
component.

Visual Basic
Syntax

deleteConfiguration (configuration As RPConfiguration)

Arguments

configuration

The configuration to delete

C/C++ Prototype

HRESULT deleteConfiguration (
IRPConfiguration* configuration)

Return Value

HRESULT (O for success, or asigned integer error code)
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deleteFile
Write method

Description

The deleteFile method deletes the specified file from the current component.
Visual Basic
Syntax

deleteFile (file As RPFile)
Arguments
file
The file to delete
C/C++ Prototype
HRESULT deleteFile (IRPFilex file)

Return Value

HRESULT (O for success, or asigned integer error code)
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findConfiguration
Read method

Description

ThefindConfiguration method retrieves the specified configuration in the current component.

Visual Basic
Syntax

findConfiguration (name As String) As RPConfiguration

Arguments

name

The name of the configuration to retrieve

Return Value
The Rhapsody configuration
C/C++ Prototype

HRESULT findConfiguration (BSTR name,
IRPConfiguration** pval)

Return Value

HRESULT (O for success, or asigned integer error code)
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getConfigByDependency

Used in cases where there are dependencies between components, this method retrieves the
appropriate configuration to use in the component on which the current component depends. The
argument required is the name of the dependency between the components.

getFile
Read method

Description
The getFile method returns the file in which the specified classifier will be generated.
Visual Basic
Syntax
getFile (c As RPClassifier, spec As Long) As RPFile
Arguments

c
The classifier.
spec (1 or 0)

If this is set to 1, the file is a specification file.

Return Value
Thefilein which the specified classifier is generated
C/C++ Prototype

HRESULT getFile (IRPClassifier* c, long spec,
IRPFile** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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getFileName
Read method

Description

The getFileName method retrieves the name of the file to which the specified classifier will be
generated in this component.

Visual Basic
Syntax

getFileName (c As RPClassifier, spec As Long,
withExt As Long) As String

Arguments

c

The classifier.

spec (1 or 0)

If this is set to 1, the file is a specification file.
withExt (1 or 0)

If this is set to 1, the file extension is included in the retrieval.

Return Value
The name of the file that contains the generated classifier
C/C++ Prototype

HRESULT getFileName (IRPClassifier* ¢, long spec,
long withExt, BSTR* pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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getModelElementFileName
Read method

Description

The getModelElementFileName method gets the file name of the specified model element.

Visual Basic
Syntax

getModelElementFileName (c As RPModelElement,
long spec As Long, withExt As Long) As String

Arguments
c
The model element.
spec (1 or 0)
If this is set to 1, this is a specification file.

withExt (1 or 0)

If this is set to 1, the extension is included in the returned file
name.

Return Value
Thefile name

C/C++ Prototype

HRESULT getModelElementFileName (IRPModelElement *c,
long spec, long withExt, BSTR *pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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getPackageFile
Read method

Description

The getPackageFile method returns the package file.
Visual Basic
Syntax

getPackageFile (c as RPPackage, spec As Long spec)
As RPFile

Arguments

c
The model element.
spec (1 or 0)

If this is set to 1, this is a specification file.

Return Value
Thefile name
C/C++ Prototype

HRESULT getPackageFile (IRPPackage* c, long spec,
IRPFile** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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removeScopeElement
Write method

Description

The removeScopeElement method del etes the scope element.

Visual Basic
Syntax

removeScopeElement (pVal As RPModelElement)
Arguments

pVal

The element to delete

C/C++ Prototype

HRESULT removeScopeElement (IRPModelElement* pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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setPath
Write method

Description

The setPath method sets the path of the application built for this component.

Visual Basic
Syntax

setPath (path As String)

Arguments

path
The path to which this component is built

C/C++ Prototype

HRESULT setPath (BSTR path)

Return Value

HRESULT (O for success, or asigned integer error code)
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IRPComponentDiagram Interface

The | RPConponent Di agr aminterface represents a component diagram. It inherits from the

| RPDi agr am

Currently, | RPConponent Di agr amdoes not expose additional functionality to the diagram.

IRPComponentinstance Interface

Thel RPConponent | nst ance interface represents a component instance. It inherits from the

| RPConponent .
VB Properties
Name Type Access Description
componentType RPConponent RW The component type
node RPNode RO The node

Rhapsody
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IRPConfiguration Interface

Thel RPConf i gur at i on interface represents a code generation configuration within agiven

| RPConponent . It inherits from | RPMbdel El enent .

VB Properties

Name

Type

Access

Description

additional Sources

String

RW

The additional source files to
be compiled with this
configuration.

alElementsin
I nstrumentationScope

Long

RW

A Boolean value that reflects
the All Elementsand

Selected Elementsoptions
of the instrumentation scope.

The property defines the
following accessor and
mutator:

propget, HRESULT

al | El enent sl n-

I nstrument at i on- Scope
([out, retval] BOOL
*pval);

propput, HRESULT

al | El enent sl n-

I nstrument at i on- Scope
([in] BOOL newval);

buildSet

String

RW

The build set of this
configuration (debug or
release).

compilerSwitches

String

RW

The compiler switches to be
applied to this configuration
in addition to those already
specified in property

<l ang>_CG : <env>::
CPPConpi | eSwi t ches.

generateCodeForActors

Bool ean

RW

If this is TRUE, code is
generated for actors when
this configuration is
generated.

includePath

String

RW

The path to standard headers
to be linked with the
configuration.

initiall nstances

RPCol | ecti on

RO

The initial instances.
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Name

Type

Access

Description

initializationCode

String

RW

The string containing the
initialization code to be added
to the main program after any
initialization done by
Rhapsody and before the
main program loop.

instrumentationScope

RPCol | ecti on

RW

A container of elements in the
selected instrumentation
scope, if the All Elements
option is selected.

The property defines the
following accessor:

propget, HRESULT

i nstrunment ati onScope(
[out], retval]

| RPCol | ecti on**
pval);

instrumentationType

String

RW

The type of instrumentation in
this configuration (None,
Trace, or Animate).

libraries

String

RW

The libraries to be linked with
the component (for example,
"x.lib, y.lib,

z. lib").

linkSwitches

String

RW

The link switches to be
applied to the configuration in
addition to those already
specified in the property

<l ang>_CG : <env>::

Li nkSwi t ches.

path(full Path)

String(path)

Bool ean(f ul | Pat h)

RO

The string containing the path
to the component.If

ful | Pat h is true, the full
path is returned:

<drive>:\

<nmodel dir>\
<conponent dir>\
<config dir>)

Iff ul | Pat h is false, the
path relative to the project is
returned:

<conponent dir>\
<config dir>

scopeType

String

RW

The scope type of the
configuration (explicit or
derived).

Rhapsody
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Name Type

Access Description

standardHeaders

String

RW The standard header files to
be linked with the
configuration.

statechartlmplementation

String

RW The statechart
implementation of the
configuration (flat or
reusable).

timeM odel

String

RW The time model of the
configuration (real or
simulated).

Method Summary

addlInitiallnstance

Adds an instance to the list of initial instances
for the current configuration

addPackageTolnstrumentationScope

Adds a classifier to the instrumentation scope

addTolnstrumentationScope

Adds explicit initial instances to the
instrumentation scope

deletelnitiallnstance

Deletes an instance from the list of build
instances for the current configuration

getDirectory

Retrieves the build directory specified for the
current configuration

getltsComponent

Retrieves the component to which the current
configuration belongs

getMainName

Retrieves the name of the file where the
mai n() routine for the current configuration
resides

getMakefileName

Retrieves the name of the makefile generated
for the current configuration

getTargetName

Retrieves the build name of the file to be
generated for the current configuration

removeFromlinstrumentationScope

Removes the classifier from the
instrumentation scope

removePackageFromInstrumentationScope

Removes the specified package from the
instrumentation scope. including all its
aggregated classes, actors, and nested
packages

setDirectory

Sets the directory for the current configuration

setltsComponent

Sets the owning component for the current
configuration
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addInitialinstance
Write method

Description

The addInitiallnstance method adds an instance to the list of initial instances for the current
configuration.

Visual Basic
Syntax

addInitialInstance (newVal As RPModelElement)
Arguments

newVal

The new instance to add to list of initial instances for this
configuration

C/C++ Prototype

HRESULT addInitialInstance (IRPModelElement* newVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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addPackageTolnstrumentationScope
Write method

Description

The addPackageTolnstrumentationScope method adds the specified package to the
instrumentation scope, including all its aggregated classes, actors, and nested packages.

Visual Basic
Syntax

addPackageToInstrumentationScope (pVal As RPPackage)

Arguments

pval

The package to add to the instrumentation scope

C/C++ Prototype

HRESULT addPackageToInstrumentationScope (
IRPPackage* pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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addTolnstrumentationScope
Write method

Description

The addTolnstrumentationScope method adds explicit initial instances to the instrumentation
scope.

Beginning with Version 5.0, Rhapsody 6.1 does not include explicit initial instances as part of
the scope. In other words, in explicit mode, code is not generated for a class just becauseitis
inthelist of initia instances for the configuration.

For existing models, Rhapsody 6.1 setsthe
CG : Configuration:: AddExplicitlnitiallnstancesToScope property to Tr ue at
the project level to maintain the old behavior.

This change enables you to use the list of initial instances to create instances that their classes
defined in related components (libraries).

Visual Basic
Syntax

addToInstrumentationScope (pVal As RPClassifier)
Arguments

pval

The initial instance to add to the instrumentation scope

C/C++ Prototype

HRESULT addToInstrumentationScope (
IRPClassifier* pval)

Return Value

HRESULT (O for success, or asigned integer error code)
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deletelnitiallnstance

Write method
Description

The deletelnitialinstance method deletes an instance from the list of build instances for the
current configuration.

Visual Basic
Syntax

deleteInitialInstance (newVal As RPModelElement)
Arguments

NewVal

The initial instance to delete from list of initial instances for this
configuration

C/C++ Prototype

HRESULT deleteInitialInstance (IRPModelElement* newVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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getDirectory
Read method

Description

The getDirectory method retrieves the build directory specified for the current configuration.
Visual Basic
Syntax

getDirectory (fullPath As Long, newName As String)
As String

Arguments

fullPath
If this is 1, the returned directory contains the full path.
newName

Reserved for future use.

Return Value
The build directory for the current configuration
C/C++ Prototype

HRESULT getDirectory (long fullPath, BSTR newName,
BSTR* retVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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getitsComponent

Read method

Description

The getltsComponent method retrieves the component to which the current configuration

belongs.
Visual Basic
Syntax

getItsComponent () As RPComponent

Return Value
The component to which this configuration belongs
C/C++ Prototype

HRESULT getItsComponent (IRPComponent** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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getMainName
Read method

Description

The getMainName method retrieves the name of the file where the mai n() routine for the
current configuration resides.

Visual Basic
Syntax

getMainName () As String

Return Value
The location of the file that contains the mai n()
C/C++ Prototype

HRESULT getMainName (BSTR* pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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getMakefileName
Read method

Description

The getMakefileName method retrieves the name of the makefile generated for the current
configuration.

Visual Basic
Syntax

getMakefileName (fullPath As Long) As String
Arguments

fullPath
Set this to one of the following values:

1--Return the full path.
0--Return the path relative to the project directory.

Return Value
The name of the makefile

C/C++ Prototype

HRESULT getMakefileName (long fullPath, BSTR* pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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getTargetName
Read method

Description

The getTargetName method retrieves the build name of the file to be generated for the current
configuration.

Visual Basic
Syntax

getTargetName (fullPath As Long) As String

Arguments

fullPath
Set this to one of the following values:
1--Return the full path.

0--Return the path relative to the project directory.

Return Value
The name of the build file (for example, Bui | dNane. exe or Bui | dNane. | i b)
C/C++ Prototype

HRESULT getTargetName (long fullPath, BSTR* pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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removeFrominstrumentationScope
Write method

Description

TheremoveFromInstrumentationScope method removes the classifier from theinstrumentation
scope.

Visual Basic
Syntax

removeFromInstrumentationScope (pVal As RPClassifier)

Arguments

pval

The classifier to remove from the instrumentation scope

C/C++ Prototype

HRESULT removeFromInstrumentationScope (
IRPClassifier *pval)

Return Value

HRESULT (O for success, or asigned integer error code)
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removePackageFromIinstrumentationScope
Write method

Description

The removePackageFromInstrumentationScope method removes the specified package from
the instrumentation scope. including all its aggregated classes, actors, and nested packages.

Visual Basic
Syntax

removePackageFromInstrumentationScope (pVal As RPPackage)

Arguments

pval

The package to remove from the instrumentation scope

C/C++ Prototype

HRESULT removePackageFromInstrumentationScope (
IRPPackage* pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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setDirectory

Note
Currently, this method has not been implemented.

Write method
Description

The setDirectory method sets the directory for the current configuration.
Visual Basic
Syntax

setDirectory (fullpath As Long, newName As String)
Arguments

fullpath (1 or 0)
Set this to 1 to include the full directory path.
newName

The new name for the directory.
C/C++ Prototype
HRESULT setDirectory (long fullpath, BSTR newName)

Return Value

HRESULT (O for success, or asigned integer error code)
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setltsComponent
Write method

Description

The setitsComponent method sets the owning component for the current configuration.
Visual Basic
Syntax

setItsComponent (newVal As RPComponent)

Arguments

newVal

The new owner component for this configuration

C/C++ Prototype

HRESULT setItsComponent (IRPComponent* newVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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IRPConnector Interface

Thel RPConnect or interface represents a connector in a statechart diagram. It inherits from
| RPSt at eVert ex.

VB Properties
Name Type Access Description
connectorType String RW The connector type

(Termination, History,
Condition, Fork, Join, or

Unknown)
Method Summary

getDerivedIinEdges Retrieves the incoming transitions for the connector

getDerivedOutEdge Retrieves the outgoing transition for the connector

getOfState Returns the state connected to the current
connector if it is a history connector

isConditionConnector Determines whether the current connector is a
condition connector

isDiagramConnector Determines whether the current connector is a
diagram connector

isForkConnector Determines whether the current connector is a fork
synch bar connector

isHistoryConnector Determines whether the current connector is a
history connector

isJoinConnector Determines whether the current connector is a join
synch bar connector

isJunctionConnector Determines whether the current connector is a
junction connector

isStubConnector Determines whether the current connector is a stub
connector

isTerminationConnector Determines whether the current connector is a

termination connector

setOfState Updates the source state of the current connector
with a new state
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getDerivedInEdges
Read method

Description

The getDerivedinEdges method retrieves the incoming transitions for the connector.
Visual Basic
Syntax

getDerivedInEdges () As RPCollection

Return Value
The incoming transitions
C/C++ Prototype

HRESULT getDerivedInEdges (IRPCollection** pvVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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getDerivedOutEdge
Read method

Description

The getDerivedOutEdge method retrieves the outgoing transition for the connector.
Visual Basic
Syntax

getDerivedOutEdge () As Transition

Return Value
The outgoing transition
C/C++ Prototype

HRESULT getDerivedOutEdge (IRPTransition** pvVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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getOfState
Read method

Description

The getOfstate method returns the state connected to the current connector if it is a history
connector. Thisis the state for which the history connector maintains historical state
information.

Visual Basic
Syntax

getOfState () As RPState

Return Value
The state for which the history connector maintains state information
C/C++ Prototype

HRESULT getOfState (IRPState** pvVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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isConditionConnector

Read method

Description

TheisConditionConnector method determines whether the current connector is a condition

connector.
Visual Basic
Syntax

isConditionConnector () As Long

Return Value
1if the connector is a condition connector; O otherwise
C/C++ Prototype

HRESULT isConditionConnector (long* pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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isDiagramConnector
Read method

Description

The jsDiagramConnector method determines whether the current connector is a diagram
connector.

Visual Basic
Syntax

isDiagramConnector () As Long

Return Value
1if the connector is a diagram connector; O otherwise
C/C++ Prototype

HRESULT isDiagramConnector (long* pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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isForkConnector
Read method

Description

TheisForkConnector method determines whether the current connector is afork synch bar
connector.

Visual Basic
Syntax

isForkConnector () As Long

Return Value
1if the connector is afork synch bar connector; 0 otherwise
C/C++ Prototype

HRESULT isForkConnector (long* pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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isHistoryConnector
Read method

Description

TheisHistoryConnector method determines whether the current connector is a history
connector.

Visual Basic
Syntax

isHistoryConnector () As Long

Return Value
1if the connector is a history connector; 0 otherwise
C/C++ Prototype

HRESULT isHistoryConnector (long* pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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isJoinConnector
Read method

Description

TheisJoinConnector method determines whether the current connector is ajoin synch bar
connector.

Visual Basic
Syntax

isJoinConnector () As Long

Return Value
1if the connector is ajoin synch bar connector; 0 otherwise
C/C++ Prototype

HRESULT isJoinConnector (long* pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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isJunctionConnector
Read method

Description

TheisJunctionConnector method determines whether the current connector is ajunction
connector.

Visual Basic
Syntax

isJunctionConnector () As Long

Return Value
1if the connector is ajunction connector; 0 otherwise
C/C++ Prototype

HRESULT isJunctionConnector (long* pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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isStubConnector
Read method

Description

TheisStubConnector method determines whether the current connector is a stub connector.

Visual Basic
Syntax

isStubConnector () As Long

Return Value
1if the connector is a stub connector; O otherwise
C/C++ Prototype

HRESULT isStubConnector (long* pVal)

Return Value

HRESULT (O for success, or asigned integer error code)

isTerminationConnector
Read method

Description

TheisTerminationConnector method determines whether the current connector isatermination
connector.

Visual Basic
Syntax

isTerminationConnector () As Long

Return Value
1if the connector is a termination connector; O otherwise
C/C++ Prototype

HRESULT isTerminationConnector (long* pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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setOfState
Write method

Description

The setOfstate method updates the source state of the current connector with a new state.
Visual Basic
Syntax

setOfState (OfState As RPState)

Arguments

OfState

The new source state for the connector

C/C++ Prototype

HRESULT setOfState (IRPState* OfState)

Return Value

HRESULT (O for success, or asigned integer error code)
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IRPConstraint Interface

Thel RPConst r ai nt interface represents a constraint in a Rhapsody model. It inherits from
| RPAnnot at i on.

VB Properties

Name Type Access Description
body String RW The body of the constraint.
constraintsByMe Collection of RO The model elements

RPMbdel El enent s affected by this constraint.

For example, if a
constraint says that each
Airplane must have at
least two Pilots, this
collection will contain both
the Airplane and Pilot
classes.

IRPControlledFile

Represents controlled files.

fullPathFileName
Property that represents the full path of the file.

open
Method that can be used to open the controlled file.
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IRPDependency Interface

The | RPDependency interface represents the dependencies between model elements, for
example, in terms of either an include or afriend relationship between classes. It inherits from
| RPMbdel El enent .

VB Properties
Name Type Access Description
dependent RPNModel El errent RW The source element in the
dependency relation
dependsOn RPModel El enent RW The target element in the
dependency relation

IRPDeploymentDiagram Interface

The | RPDepl oynent Di agr aminterface represents deployment diagrams. It inherits from
| RPDi agr am

IRPDiagram Interface

Thel RPDi agr aminterface is an abstract interface that provides the common functionality of
Rhapsody diagrams. Currently, the functionality provided by | RPDi agr am(in addition to

| RPMbdel El enent ) isto render the view as ametafile. This class inherits from | RPUni t
because diagrams are a so units.

Method Summary

getElementsinDiagram Returns a collection of all the model
elements in the current diagram

getPicture Renders this diagram into the specified
extended metafile

getPictureAs Saves a Rhapsody diagram in a specific
graphic format.

getPictureAsDividedMetafiles Enables you to split a large diagram into
several metafiles when you export it
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getElementsinDiagram
Read method

Description

The getElementsinDiagram method returns a collection of all the model e ementsin the current
diagram.

Visual Basic
Syntax

getElementsInDiagram() As RPCollection

Return Value
A collection of all the model elementsin the diagram
C/C++ Prototype

HRESULT getElementsInDiagram (IRPCollection** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)

getPicture
Read method

Description
The getPicture method renders this diagram into the specified extended metafile.
Note: If the file cannot be written, this method flags the error.
Visual Basic
Syntax

getPicture (filename As String)

Arguments

filename

The name of the metafile that will contain the current diagram.The format of the created metafile
is. enf. The created metafile is used later by the VB function L oadPicture, which createsa VB
function object that can be used for placing pictures in documents.
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C/C++ Prototype
HRESULT getPicture (BSTR filename)

Return Value

HRESULT (O for success, or asigned integer error code)

getPictureAs

This method can be used to save a Rhapsody diagram in aspecific graphic format. The method can
also be used to retrieve diagram element information that can be used to create an HTML image

map.
The method returns alist of the graphic files created.

getPictureAs (firstFileName As String, imageFormat As String, getImageMaps As
Long, diagrammap As RPCollection, fileNames As RPCollection) As RPCollection

firstFileName

The naming convention to use for the files that will be created. For a detailed explanation, see
getPictureAsDividedMetafiles.

imageFormat

The graphic format in which the diagram should be saved. This can be one of the following: EMF,
BMP, JPEG, JPG, TIFF.

getlmageMaps

Use this argument to indicate whether the function should also return a collection of objects that
can be used to construct an HTML image map for the diagram. (Use 1 if you want this
information, else use 0.)

diagrammap

The collection to use when returning objects containing the required information for constructing
an HTML image map.

fileNames

The collection to use for the names of the graphic files created.
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getPictureAsDividedMetafiles
Read method

Description

The getPictureAsDividedMetafiles method enables you to split alarge diagram into several
metafiles when you export it.

This method is influenced by the property

General : : G aphi cs: : Export edDi agr antcal e. See the definition provided for the
property on the applicable Properties tab of the Features dialog box. Refer also to the
Properties Reference Manual.

Note: If the file cannot be written, this method flags the error.
Visual Basic
Syntax

getPictureAsDividedMetafiles (firstFileName As String)
As RPCollection

Arguments

firstFileName

The naming convention for the created files. For example, if you passed
the value “Foo” as the firstFileNane:

If the diagram can be drawn on one page, the name of the metafile is
Foo.

If the diagram is split into multiple pages, the first file will be
named FOOZ_X Y. The variables used in the name are as follows:

¢ Z—Thenumber of the created file
¢ X—The number of the page along the X vector
¢ Y—The number of the page along the Y vector

¢ For example, thefile Foo2_1_ 2 meansthat thisisthe second metafile created and
it contains one page, which is the second page aong the Y vector (the X vector is

1).
All the file names will be inserted in the sent strings list
(fil eNanes) .

Return Value

A collection that contains the names of the files that were created
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C/C++ Prototype

HRESULT getPictureAsDividedMetafiles (
[in] BSTR firstFileName,
[out, retval] IRPCollection** fileNames)

Return Value
HRESULT (O for success, or asigned integer error code)

VBA Sample

Private Sub CommandButtonl Click()

Dim proj As RPProject

Dim d As RPDiagram

Dim col As RPCollection

On Error GoTo aa

Set proj = getProject

Set d = proj.findNestedElementRecursive (
"Dishwasher Cycle", "SequenceDiagram")

Set col = d.getPictureAsDividedMetafiles (
"D:\Temp\Diagram.emf")

Exit Sub

aa:

MsgBox errorMessage

End Sub
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IRPEnumerationLiteral Interface

Thel RPEnuner at i onLi t er al interface supports the language-independent types

introduced in Rhapsody 5.0. It inheritsfrom | RPMbdel El enent .

See the Rhapsody User Guide for detailed information about language-independent types.

VB Properties

Name

Type

Access

Description

vaue

RPEvent

RW

An optional value for the

literal
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IRPEvent Interface

The| RPEvent interface represents an event. It derivesfrom | RPI nt er f acel t em

VB Properties
Name Type Access Description
baseEvent RPEvent RW The pointer to the base
event (if this event is
inherited from it).
superEvent RPEvent RW The pointer to the super

event (if this event is
inherited from it)

As a read method,

super Event ()
provides the base event
that an event was derived
from. Thus, if event B is
inherited from event A,

B. super Event ()
returns a pointer to A.As a
write method,

super Event () inherits
or reinherits an event from
a new base (super) event.
Thus, if you want event B
to be inherited from A, set
B. super Event () = A
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IRPEventReception Interface

The| RPEvent Recept i on interface represents a relationship between a class and an event
that is part of itsinterface. It derivesfrom | RPI nt er f acel t em

Method Summary

getEvent Returns the event for the current event reception that
serves as part of the interface for a class

getEvent
Read method

Description

The getEvent method returns the event for the current event reception that serves as part of the
interface for a class.

Visual Basic
Syntax

getEvent () As RPEvent

Return Value
The RPEvent related to a class through the event reception interface
C/C++ Prototype

HRESULT getEvent (IRPEvent** pvVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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IRPExecutionOccurrence Interface

Thel RPExecut i onCccur r ence interface represents an execution occurrence in a sequence
diagram. It derives from | RPMbdel El enent .

VB Properties
Name Type Access Description
message RPMessage RO The start message for the
execution occurrence

IRPExternalCodeGenerator Interface

The | RPExt er nal CodeGener at or interface isadispatch interface that defines events that
must be handled by the external code generator.

Theinterface inheritsfrom | Di spat ch.

Using an External Code Generator

Beginning with Version 4.1, you can integrate an externa code generator with Rhapsody 6.1.
The code generator application is loaded when Rhapsody 6.1 is loaded. This code generator
should be afull-featured code generator that can generate al the model code. When you
specify an external code generator, Rhapsody 6.1 does not generate any code. Rhapsody 6.1 in
Adauses an external code generator.

You can set the environment variable Ext er nal Gener at or inthe[ codegen] section of the
r hapsody. i ni filetothe path of the external code generator executable. This executable will
be loaded when Rhapsody 6.1 isloaded and terminates when Rhapsody 6.1 exits. If you do not
set this environment variable, you must manually load your code generator after Rhapsody 6.1
isloaded. Note the following:

¢ Thisvariable setting applies only to full-featured external code generators.

+ If you do not load your external code generator, it cannot display messagesin the
Rhapsody 6.1 output window.

In addition, you can integrate makefiles generated by a makefile generator other than the
Rhapsody 6.1 generator; all other code generation is done by Rhapsody 6.1.
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Restrictions

Note the following restrictions:

*

Because the active code view uses the annotations generated by Rhapsody 6.1 to find the
location of amodel element in asourcefile, searching afile generated by an external code
generator (unannotated) might not be accurate. There are other annotation issues
concerning roundtrip and error highlighting. Therefore, the external code generator must
generate annotations to make all of these features work properly.

If you specify an external code generator, you cannot use the CG In Browser feature to
generate code.

You can integrate a single external code generator with one instance of a Rhapsody 6.1
application, running on the same machine.

You can integrate an external code generator with Rhapsody 6.1 on a Solaris platform only
if the client supports the COM framework.

This functionality is supported only by Rhapsody 6.1 Developer Edition as a separate,
add-on feature.

Event Handling

When you trigger code generator operations, Rhapsody 6.1 fires events that are handled by the
registered, external code generator. The following table lists the different events and when
they arefired.

Event When Fired

generate When you invoke any kind of generation command (forced or

incremental), for selected classifiers, files, or for the entire
configuration. The invocation can be explicit or by DMCA.

When called, the external code generator generates the elements
according to the settings for the active configuration.

This method is called with all model elements that need to be
generated.

Abort Is invoked when the user selects the Abort option during code

generation. When the external code generator receives this event, it
stops the code generation process and notifies Rhapsody 6.1 that it is
done.

getFileName Is invoked when Rhapsody 6.1 needs the file name and path of a

model element.

If the event is not handled, Rhapsody 6.1 displays an error message
stating that it could not get the file name from the external code
generator.

Note that if the external code generator uses the same file mapping
scheme as Rhapsody 6.1, you do not need to implement this event.
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Event When Fired

GetMainFileName Is invoked when Rhapsody 6.1 needs the main file name and path for
a configuration.

If the event is not handled, Rhapsody 6.1 displays an error message
stating that it could not get the file name from the external code
generator.

GetTargetfileName Is invoked when Rhapsody 6.1 needs the target name and path for a
configuration.

If the event is not handled, Rhapsody 6.1 displays an error message
stating that it could not get the makefile name from the external code
generator.

Note that if the external code generator uses the same file mapping
scheme as Rhapsody 6.1, you do not need to implement this event.

WhoAml Is invoked to identify the external code generator.

Exit Is invoked before Rhapsody 6.1 exits. When the external code
generator receives this event, it performs the necessary cleanup and
terminates its process.

Implementing the External Code Generator
To implement an external code generator, follow these steps:

1. Implement the event handlersfor the | RPExt er nal CodeGener at or events:

¢ Invoke the code generation process on another thread to return from the call to
generate as So0n as possible.

¢ Notify thel RPExt er nal CodeGener at or | nvoker when the generation session
has ended.

2. Instantiate your event handler class when the external code generator is loaded.
3. Getthel RPAppl i cati on object.

4. Getthel RPExt er nal CodeGener at or | nvoker singleton from the | RPAppl i cat i on
interface. See the method getTheExternalCodeGeneratorinvoker for more information.

5. Register theimplemented | RPExt er nal CodeGener at or asthe external code generator
on the | RPExt er nal CodeGener at or | nvoker interface.

6. Print code generation messages using standard output. For example:

cout<<"Generating"<<class name<<endl;

7. Terminate the externa code generator process when Exit is called.
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Rhapsody Settings

You must set the following environment variables and properties:
¢ SettheExt er nal Gener at or environment variableinther hapsody. i ni fileto

the path to the implemented code generator executable. See “Using an External
Code Generator”for more information.

Set the<l ang>_CG : <Envi r onnent >: : CodeGener at or Tool property for
the configuration that should be generated with the external code generator.

Set the <l ang>_CG : Confi gur ati on: : Ext er nal Gener ati onTi meout
property with areasonable time for an average class generation session.

See the definition provided for the property on the applicable Properties tab of the Features
dialog box. Refer also to the Properties Reference Manual.

*
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Sample

1117777177
// MyCodeG
// class.

1171111777

class CMyC
public
IDispEvent

[17170777777777777777777777777777777777777777

enerator.h: interface for the CMyCodeGenerator

LI71770077777777777777777777777777777777777777

odeGenerator:

Impl<l,CMyCodeGenerator,

&DIID_ IRPExternalCodeGenerator, &LIBID rhapsody,1,0>

public:

CMyCodeGenerator () ;
virtual ~CMyCodeGenerator() ;
void Register() ;

//event handlers

HRESULT _ stdcall Generate(
IDispatch* configuration,
IDispatch* classifiers,IDispatch* files,
BOOL genMain,BOOL genMake) ;

BSTR _ stdcall WhoAmI () ;

BSTR _ stdcall GetFileName (IDispatch* modelElement,
IDispatch* configuration, int pathType,
BOOL withExt) ;

BSTR _ stdcall GetTargetfileName (IDispatch*
configuration, int pathType,BOOL withExt) ;

BSTR _ stdcall GetMainFileName (
IDispatch* configuration, int pathType,
BOOL withExt) ;
BSTR _ stdcall GetMakefileName (
IDispatch* configuration, int pathType,
BOOL withExt) ;
VOID _ stdcall OnExit () ;
VOID _ stdcall Abort();
BEGIN_SINK MAP (CMyCodeGenerator)
SINK ENTRY_EX(/*nID =*/ 1,
DIID_ IRPExternalCodeGenerator,
/*dispid =*/ 0x1, Generate)
SINK ENTRY EX(/*nID =%/ 1,
DIID IRPExternalCodeGenerator,
/*dispid =*/ 0x2, OnExit)
SINK ENTRY_EX(/*nID =*/ 1,
DIID_ IRPExternalCodeGenerator,
/*dispid =*/ 0x3, GetFileName)
SINK ENTRY EX(/*nID =%/ 1,
DIID IRPExternalCodeGenerator,
/*dispid =*/ 0x4, GetTargetfileName)
SINK ENTRY_EX(/*nID =*/ 1,
DIID_ IRPExternalCodeGenerator,
/*dispid =*/ 0x5, GetMainFileName)
SINK ENTRY EX(/*nID =%/ 1,
DIID IRPExternalCodeGenerator,
/*dispid =*/ 0x6, GetMakefileName)
SINK ENTRY EX(/*nID =%*/ 1,
DIID IRPExternalCodeGenerator,
/*dispid =*/ 0x7, WhoAmI)
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SINK_ ENTRY EX (/*nID =%/ 1,
DIID IRPExternalCodeGenerator,
/*dispid =*/ 0x8, Abort)
END_ SINK MAP ()

Method Summary

Abort Is invoked when the user selects the Abort option
during code generation

Exit Is invoked before Rhapsody 6.1 exits

generate Is invoked whenever a generation command of any
kind is invoked

getFileName Is invoked when Rhapsody 6.1 needs the file name

and path of a model element

GetMainFileName

Is invoked when Rhapsody 6.1 needs the main file
name and path for a configuration

getMakefileName

Is invoked when Rhapsody 6.1 needs the makefile
name and path for a configuration

GetTargetfileName

Is invoked when Rhapsody 6.1 needs the target name
and path for a configuration

WhoAml

Is invoked to identify the external code generator
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Abort
Description

The Abort event is invoked when the user selects the Abort option during code generation.
When the external code generator receives this event, it stops the code generation process and
notifies Rhapsody 6.1 that it is done.

Visual Basic
Syntax

Event Abort ()

C/C++ Prototype
void Abort ()
Exit
Description

The Exit event isinvoked before Rhapsody 6.1 exits. When the external code generator
receivesthis event, it performs the necessary cleanup and terminates its process.

Visual Basic
Syntax

Event Exit ()

C/C++ Prototype

void Exit ()

Rhapsody 251



Rhapsody API Interfaces

generate

Description

The generate event is invoked whenever a generation command of any kind isinvoked
(including forced or incremental generation for selected classifiers; or files for the entire
configuration either explicitly by the user or by DMCA).

When called, the external code generator generates the elements according to the settings for
the active configuration.

Visual Basic

Syntax

Event generate (activeConfiguration As Object,
classifiersCollection As Object,
filesCollection As Object, generateMainFile As Long,
generateMakefile As Long)

Arguments

activeConfiguration

A pointer to the active configuration for this generation session. If
this value is not NULL, configuration files (main and make) are
generated.

The external code generator queries the activeConfiguration for its
RPConfi guration interface.

classifiersCollection

The container of classes and package interfaces to be generated. The
container can be NULL if no classifiers need to be generated. Packages
in this container are generated without their aggregates (the
package’s classes) .

The external code generator queries the cl assifiersCollection for
its RPCol | ection interface.

filesCollection

The container of file and folder interfaces (RPFileS) to be generated.
The container can be NULL if no files need to be generated.

Model elements that are mapped to a file or folder in the
filesCollection container will be added to the
classifiersCollection. Therefore, the external generator does not
query the file for its mapped classifiers. However, the code generator
does check the files for text elements.

The external code generator queries the filesColl ection for its
RPCol | ecti on interface.

generateMainFile (1 or 0)
Set this to 1 to generate the main configuration files.

generateMakefile (1 or 0)
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Set this to 1 to generate the makefile for the configuration.

C/C++ Prototype

HRESULT generate (IDispatch* activeConfiguration,
IDispatch* classifiersCollection,
IDispatch* filesCollection, long generateMainFile,
long generateMakefile)

Return Value

S_OK for success, or an error code. If an error occurs, code generation is aborted.
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getFileName

Description

The getFileName method is invoked when Rhapsody 6.1 needs the file name and path of a
model element.

If the event is not handled, Rhapsody 6.1 displays an error message stating that it could not get
the file name from the external code generator.

Note: If the external code generator uses the same file mapping scheme as Rhapsody
6.1, you do not need to implement this event.

Visual Basic
Syntax

Event getFileName (modelElement As Object,
configuration As Object, pathType As Long,
withExtensions As Long)

Arguments

modelElement

The model element whose name you want to retrieve. The model element can be a
class, actor, package, event, or file.

The external code generator queriesthe nodel El enent for its RPMbdel El enent
interface.

configuration

The configuration for which the file name is requested.

The external code generator queriesthe configuration for itSrRPConfiguration
interface.

pathType
The requested path format. The possible values are as follows:

1. Include the full path. For example: c:\Project\Component\Config\Classl.h
2. Include only the name of thefile. For example: classi.h

3. Include the path relative from the project directory. For example:
Component\Config\Classl.h

4. Include the path relative from the active configuration to the requested file.
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For example, if thefileislocated under
C:\Project\Component\Subfolder\Classl.h, the externa code generator
includes the following path: subfolder\classi.h.

withExtensions
Specifies whether to include the extension in the returned file name. For example,
Classl.hinstead of classi.
Return Value

The file names of the model elements, separated by commas. If there is more than one filein
thelist, Rhapsody 6.1 assumes that the first file is the specification file and the others are
implementation files.

C/C++ Prototype

BSTR getFileName (IDispatch* modelElement,
IDispatch* configuration, int pathType,
long withExtensions)

Rhapsody 255



Rhapsody API Interfaces

GetMainFileName

Description

The GetMainFileName method is invoked when Rhapsody 6.1 needs the main file name and
path for a configuration.

If the event is not handled, Rhapsody 6.1 displays an error message stating that it could not get
the file name from the external code generator.

Visual Basic
Syntax

Event GetMainFileName (configuration As Object,
pathType As Long, withExtensions As Long)

Arguments

configuration

The configuration for which the main file name is requested.

The external code generator queriesthe configuration foOr itSRPConfiguration
interface.

pathType
The requested path format. The possible values are as follows:

1—Include the full path. For example: ¢:\pProject\Component\Config\Classl.h
2—Include only the name of thefile. For example: classi.h

3—Include the path relative from the project directory. For example:
Component\Config\Classl.h

4—Include the path relative from the active configuration to the requested file.

For example, if thefile islocated under
C:\Project\Component\Subfolder\Classl.h, the external code generator will
include the following path: subfolder\classi.h.

withExtensions

Specifies whether to include the extension in the returned file name. For example,
mainfile.cpp instead of mainfile.
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Return Value

The main file names of the model elements, separated by commas. If there is more than one
fileinthelist, Rhapsody 6.1 assumesthat thefirst file isthe specification file and the second is
the implementation file.

C/C++ Prototype

BSTR GetMainFileName (IDispatch* configuration,
int pathType, long withExtensions)
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getMakefileName

Description

The getMakefileName method isinvoked when Rhapsody 6.1 needs the makefile name and
path for a configuration.

If the event is not handled, Rhapsody 6.1 displays an error message stating that it could not get
the makefile name from the external code generator.

Visual Basic
Syntax

Event getMakefileName (configuration As Object,
pathType As Long, withExtensions As Long)

Arguments

configuration

The configuration for which the file name is requested.

The external code generator queriesthe configuration foOr itSRPConfiguration
interface.

pathType
The requested path format. The possible values are as follows:

1—Include the full path. For example: ¢:\pProject\Component\Config\Classl.h
2—Include only the name of thefile. For example: classi.h

3—Include the path relative from the project directory. For example:
Component\Config\Classl.h

4—Include the path relative from the active configuration to the requested file.

For example, if thefile islocated under
C:\Project\Component\Subfolder\Classl.h, the external code generator will
include the following path: subfolder\classi.n.

withExtensions

Specifies whether to include the extension in the returned file name. For example,
makefile.mak instead of makefile.

Return Value

The name of the makefile
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C/C++ Prototype

BSTR getMakefileName (IDispatch* configuration,
int pathType, long withExtensions)

GetTargetfileName

Description

The GetTargetfileName method is invoked when Rhapsody 6.1 needs the target name and path
for a configuration.

If the event is not handled, Rhapsody 6.1 displays an error message stating that it could not get
the makefile name from the external code generator.

Note: If the external code generator uses the same file mapping scheme as Rhapsody
6.1, you do not need to implement this event.

Visual Basic
Syntax

Event GetTargetfileName (configuration As Object,
pathType As Long, withExtensions As Long)

Arguments

configuration

The configuration for which the file name is requested.

The externa code generator queriesthe conf i gur at i on for its
RPConf i gur ati on interface.

pathType
The requested path format. The possible values are as follows:

1—Include the full path. For example: ¢:\pProject\Component\Config\Classl.h
2—Include only the name of the file. For example: c1ass1.n

3—Include the path relative from the project directory. For example:
Component\Config\Classl.h

4—Include the path rel ative from the active configuration to the requested file.

For example, if the fileislocated under
C:\Project\Component\Subfolder\Classl.h, the external code generator will
include the following path: subfolder\classi.h.
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withExtensions

Specifies whether to include the extension in the returned file name. For example,
target .exe instead of target.

Return Value
The name of the target file
C/C++ Prototype

BSTR GetTargetfileName (IDispatch* configuration,
int pathType, long withExtensions)

WhoAmlI
Description
The whoAmI event isinvoked to identify the external code generator.
Visual Basic
Syntax

Event WhoAmI ()
C/C++ Prototype
BSTR WhoAmI ()

Return Value

A string that identifies the name and version number of the external code generator. It is
printed to the output window before the generate event is invoked.
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IRPExternalCodeGeneratorinvoker Interface

The | RPExt er nal CodeGener at or | nvoker istheinterface that invokes the external code

generator. The invoker isthe object that fires all the events defined by the

| RPExt er nal CodeGener at or interface. The external code generator registers the invoker

instance to get events, and notifiesthe | RPExt er nal CodeGener at or | nvoker when acode
generation session is over.

Thisinterface inherits from | Di spat ch.

Method Summary

notifyGenerationDone Is called by the external code generator after a
generation session invoked by the generate event is
done
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notifyGenerationDone

Description

The notifyGenerationDone method is called by the external code generator after a generation
session invoked by the generate event is done. You cannot invoke a new code generation
session or make any changes to the model between the call to the generate and
notifyGenerationDone events. However, you can set the timeout period using the property

<l ang>_CG : Confi gur ati on: : Ext er nal Gener at i onTi meout . See the definition
provided for the property on the applicable Properties tab of the Features dialog box. Refer
also to the Properties Reference Manual.

Note: The external code generator must call this method after a code generation
session (invoked by the generate event) was done or aborted (by the Abort
event).

Visual Basic

Syntax
notifyGenerationDone ()

C/C++ Prototype

HRESULT notifyGenerationDone ()

Return Value

HRESULT (O for success, or asigned integer error code)
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IRPFile Interface

The | RPFi | e interface represents afile or folder to be generated during code generation. It
inheritsfrom | RPMbdel El enment .

VB Properties
Name Type Access Description
elements Collection of RO The elements to be
RPCl assifiers mapped to the file or
folder.
files Collection of RPFi | es RO Iffil eType is “folder,”
fil es is the collection of
all files contained in that
folder.
fileType String RW The file type (“folder,”
“implementation,”
“specification,” “logical,” or
“other”).
path(full Path) String(path) RO The string containing the

path to the component.If
f ul | Pat his true, the full
path is returned:

<drive>:\

<nmodel dir>\
<conponent dir>\
<config dir>)

Iff ul | Pat h is false, the
path relative to the project
is returned:

<conponent dir >\
<config dir>

Bool ean(
ful | Pat h)
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Method Summary

addElement Adds an element to the current file

addPackageToScope Adds the specified package to the scope of the file or
folder

addTextElement Adds text to the file

addToScope Places an element within the scope of the current file or
folder

getimpName Retrieves the name of the current file’'s implementation
file, including its extension and, if specified, its relative
path

getSpecName Retrieves the name of the current file’s specification
file, including its extension and, if specified, its relative
path

isEmpty Determines whether the current file is empty

setPath Sets the path to the specified file
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addElement
Write method

Description

The addElement method adds an element to the current file or folder.
Visual Basic
Syntax

addElement (element As RPClassifier,
fileFragmentType As String)

Arguments

element

An RPCl assifier that specifies the new element to be mapped to the
current file. The possible values are as follows:

Actors

Classes

Data

Use cases

fileFragmentType

One of the following strings:

undef Fr agment —The element is not defined.

t ext Fragment —The element is text.

i mpl Fragnment —The implementation of the element is added to the file.
specFragnment —The specification of the element is added to the file.

nodul eFr agnent —Both implementation and specification of the element
are added to the file.

C/C++ Prototype

HRESULT addElement (IRPClassifier *element,
BSTR fileFragmentType)

Return Value

HRESULT (O for success, or asigned integer error code)
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addPackageToScope

Write method

Description

The addPackageToScope method adds the specified package to the scope of the file or folder.

Visual Basic
Syntax
addPackageToScope (p As RPPackage)

Arguments

p
The package to add

C/C++ Prototype

HRESULT addPackageToScope (IRPPackage *p)

Return Value

HRESULT (O for success, or asigned integer error code)
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addTextElement
Write method

Description

The addTextElement method adds text to the file.
Visual Basic
Syntax

addTextElement (text As String)

Arguments

text

The text to add to the file

C/C++ Prototype

HRESULT addTextElement (BSTR text)

Return Value

HRESULT (O for success, or asigned integer error code)
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addToScope

Write method
Description

The addToScope method places an element within the scope of the current file or folder. If the
file represents afile, both the implementation and specification of the element are added to the
file. If the file represents a folder, the element is added to the folder scope.

Visual Basic
Syntax

addToScope (element As RPClassifier)

Arguments

element

The element to place in the scope of the file

C/C++ Prototype

HRESULT addToScope (IRPClassifier *element)

Return Value

HRESULT (O for success, or asigned integer error code)

268

API| Reference Manual



IRPFile Interface

getimpName
Read method

Description

The getimpName method retrieves the name of the current file’'simplementation file, including
its extension and, if specified, its relative path.

Visual Basic
Syntax

GetImpName (includingPath As Long) As String

Arguments

includingPath (1 or 0)

Set this to 1 to include the relative path in the implementation file
name.

Return Value
The name of the implementation file
C/C++ Prototype

HRESULT getImpName (long includingPath, BSTR* pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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getSpecName

Read method
Description

The getSpecName method retrieves the name of the current file's specification file, including
its extension and, if specified, its relative path.

Visual Basic
Syntax

getSpecName (includingPath As Long) As String

Arguments

includingPath (1 or 0)

Set this to 1 to include the relative path in the specification file
name.

Return Value
The name of the specification file
C/C++ Prototype

HRESULT getSpecName (long includingPath, BSTR* pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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iISEmpty
Read method

Description

The isEmpty method determines whether the current fileis empty.
Visual Basic
Syntax

IsEmpty () As Long

Return Value
1if thefileis empty; otherwise O
C/C++ Prototype

HRESULT isEmpty (long* pval)

Return Value

HRESULT (O for success, or asigned integer error code)
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setPath
Write method

Description

The setPath method sets the path to the specified file.

Visual Basic
Syntax

setPath (path As String)

Arguments

path
The file path

C/C++ Prototype

HRESULT setPath (BSTR path)

Return Value

HRESULT (O for success, or asigned integer error code)
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IRPFlow Interface

The | RPFI ow interface represents aflow. It inherits from | RPMbdel El enent .

VB Properties

Name

Type Access Description

conveyed

RPCol | ecti on RO A read-only collection of
information elements
conveyed by the flow.

direction

String RW A string specifying the
direction of the flow. The
possible values are:

e toEndl
* toEnd2
« bidirectional

endl

RPMbdel El enent RW An association to a model
object that is one of the
ends of the flow.

end1Port

RPPor t RO Valid when end1 is an
RPI nst ance thatis
connected via a port
defined by the class of the
instance.

end2

RPModel El enent RW An association to a model
object that is one of the
ends of the flow.

end2Port

RPPor t RO Valid when end2 is an
RPI nst ance that is
connected via a port
defined by the class of the
instance.

Method Summary

addConveyed

Adds an information element to the conveyed
collection

removeConveyed

Removes an information element to the
conveyed collection

setEndiViaPort

Connects end1 of the flow to the specified
instance via the given port (defined by the instance
class)

setEnd2ViaPort

Connects end2 of the flow to the specified
instance via the given port (defined by the instance
class)
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addConveyed

Write method

Description

The addConveyed method adds an information element to the conveyed collection.

Visual Basic
Syntax

addConveyed (pElement As RPModelElement)
Arguments

pElement

The information element to add

C/C++ Prototype

HRESULT addConveyed (IRPModelElement* pElement)

Return Value

HRESULT (O for success, or asigned integer error code)
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removeConveyed
Write method

Description

TheremoveConveyed method removes an information element from the conveyed collection.
Visual Basic
Syntax

removeConveyed (pElement As RPModelElement)

Arguments

pElement

The information element to remove

C/C++ Prototype

HRESULT removeConveyed (IRPModelElement* pElement)

Return Value

HRESULT (O for success, or asigned integer error code)
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setEnd1ViaPort
Write method

Description

The setEnd1viaPort method connects end1 of the flow to the specified instance viathe given
port (defined by the instance class).

Visual Basic
Syntax

setEndlViaPort (pInstance As RPInstance, pPort As RPPort)
Arguments

pInstance
The instance to which to connect endl of the flow
pPort

The port used to connect endl of the flow to plnstance

C/C++ Prototype

HRESULT setEndlViaPort (IRPInstance* pInstance,
IRPModelElement* pPort)

Return Value

HRESULT (O for success, or asigned integer error code)
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setEnd2ViaPort
Write method

Description

The setEnd2ViaPort method connects end2 of the flow to the specified instance via the given
port (defined by the instance class).

Visual Basic
Syntax

setEnd2ViaPort (pInstance As RPInstance, pPort As RPPort)
Arguments

pInstance
The instance to which to connect end2 of the flow
pPort

The port used to connect end2 of the flow to plnstance

C/C++ Prototype

HRESULT setEnd2ViaPort (IRPInstance* pInstance,
IRPModelElement* pPort)

Return Value

HRESULT (O for success, or asigned integer error code)
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IRPFlowchart Interface

Thel RPFI owchar t interface represents an activity diagram (formerly referred to asa
flowchart). It inheritsfrom | RPSt at echart .

VB Properties
Name Type Access Description

isAnalysisOnly Long RW If this is set to 1 (as
opposed to 0), this
| RPFI owchart is for
analysis only.

itsOwner RPOper at i on RW The operation that owns
this activity diagram

swimlanes RPCol | ecti on RO The collection of
swimlanes in the activity
diagram

Method Summary

addReferenceActivity

Adds a reference activity to the activity diagram

addSwimlane

Adds a swimlane to the activity diagram
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addReferenceActivity

Note
Currently, this method has not been implemented.

Write method
Description

The addReferenceActivity method adds the specified reference activity to the activity diagram.

Visual Basic

Syntax

addReferenceActivity (referenced As RPModelElement)
As RPState

Arguments

referenced

The referenced activity or activity chart

Return Value
The new reference activity
C/C++ Prototype

HRESULT addReferenceActivity (
IRPModelElement* referenced, IRPState** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)

Rhapsody 279



Rhapsody API Interfaces

addSwimlane

Note
Currently, this method has not been implemented.

Write method
Description

The addSwimlane method adds the specified swimlane to the activity diagram.
Visual Basic
Syntax

addSwimlane (name As String) As RPSwimlane

Arguments

name

The name for the new swimlane

Return Value
The new RPSwi nl ane

C/C++ Prototype
HRESULT addSwimlane (BSTR name, IRPSwimlane** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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IRPFlowltem Interface

The | RPFI owl t eminterface represents aflowltem. It inheritsfrom | RPCl assi fi er.

| RPFI owl t emisalimited classifier (it cannot own attributes, operations, types, and so on),
but the interface does support generalization.

See the User Guide for detailed information about flows and flowltems.

VB Properties
Name Type Access Description
represented Collection of RO A read-only collection of
RPFl ow t ens flow items represented by
the flowltem

Method Summary

addRepresented

Adds a flowltem to the r epr esent ed collection

removeRepresented

Removes a flowltem from the r epr esent ed
collection
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addRepresented
Write method

Description

The addRepresented method adds aflowltem to ther epr esent ed collection.
Visual Basic
Syntax

addRepresented (pElement As RPModelElement)

Arguments

pElement

The flow item to add

C/C++ Prototype

HRESULT addRepresented (IRPModelElement* pElement)

Return Value

HRESULT (O for success, or asigned integer error code)
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removeRepresented
Write method

Description

TheremoveRepresented method removes a flowltem from ther epr esent ed collection.
Visual Basic
Syntax

removeRepresented (pElement As RPModelElement)

Arguments

pElement

The flow item to remove

C/C++ Prototype

HRESULT removeRepresented (IRPModelElement* pElement)

Return Value

HRESULT (O for success, or asigned integer error code)
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IRPGeneralization Interface

Thel RPGener al i zat i on interface represents an inheritance relation between two
classifiers (class/use case/actor). It inherits from | RPMbdel El enent .

VB Properties
Name Type Access Description

baseClass RPCl assi fi er RW The base class of the
generalization

derivedClass RPCl assi fi er RW The derived class of
the generalization

extensi onPoint String RW The extension point

isVirtual Long RO A flag that indicates
whether the
generalization is
virtual

visibility String RO The visibility of the
generalization (public,
protected, or private)

Thebased ass and deri vedd ass properties allow write access to update the
generdization. For example, if class Cisderived from class A and you want to deriveit from
class B instead, follow these steps:

C.get General i zation.baseC ass = B

Here, get Gener al i zat i on is used as pseudo-operation shorthand for the procedure
involved in actually obtaining a Gener al i zat i on object from aclass.

Similarly, if class Cis derived from A and you want to derive it from B instead, follow these
steps:

B. get General i zati on. derivedCl ass = C

284 API| Reference Manual



IRPGraphEdge Interface

IRPGraphEdge Interface

Thel RPGr aphEdge interface represents alinear element of a diagram, such asatransition. It
represents the UML Gr aphEdge class. | RPGr aphEdge inherits from | RPGr aphEl enent .

VB Properties
Name Type Access Description

source RPG aphNode RO The point at which the
edge is connected to the
source

target RPGr aphNode RO The point at which the
edge is connected to the
target

IRPGraphElement Interface

Thel RPGr aphEl enent interface isthe base for al graphical elements on adiagram. It
represents the UML | nt er change Gr aphEl enent class. | RPG aphEl enent inheritsfrom

| RPDi spat ch.
VB Properties
Name Type Access Description
graphical Parent RPG aphEl enent RO The owning object
model Object RPModel El enent RO The graphical object

Method Summary

getAllGraphicalProperties Returns the list of graphical properties for a
diagram element

getGraphicalProperty Returns the specified graphical property for a
diagram element

setGraphicalProperty Allows the setting of graphical properties for a
diagram element
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getAllGraphicalProperties
Read method

Description

The getAllGraphicalProperties method returns the list of graphical properties for adiagram
element.

Visual Basic
Syntax

getAllGraphicalProperties () As RPCollection

Return Value
AnRPCol | ecti on that contains the read-only list of graphical properties
C/C++ Prototype

HRESULT getAllGraphicalProperties (IRPCollection** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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getGraphicalProperty
Read method

Description

The getGraphicalProperty method returns the value of the specified graphical property for a
diagram element.

Visual Basic
Syntax

getGraphicalProperty (name As String)
As RPGraphicalProperty

Arguments

name

The name of the property whose value you want to retrieve (note that
only the actual property name is required here, there is no need to
specify the hierarchy, as is the case with getPropertyValue)

Return Value
The value of the specified property, or nul | if the specified key is unsupported or invalid
C/C++ Prototype

HRESULT getGraphicalProperty (BSTR name,
IRPGraphicalProperty **pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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setGraphicalProperty
Write method

Description

Theset Gr aphi cal Property method allows the setting of graphical propertiesfor a
diagram element.

Visual Basic

Syntax

setGraphicalProperty (name As String,

Arguments

name

value As String)

The name of the graphical property whose value you want to set (note
that only the actual property name is required here; there is no need
to specify the hierarchy, as is the case with setPropertyValue)

value

The value of the specified graphical property

C/C++ Prototype

HRESULT setGraphicalProperty([in] BSTR name,

Return Value

HRESULT (O for success, or asigned integer error code)

VBA Sample

Dim
Set
Dim
Dim
Dim
Dim
Dim
Dim
Dim

proj As RPProject

d = proj.addNewAggr (“*ObjectModelDiagram”,
m As RPModelElement

nl As RPGraphNode

n2 As RPGraphNode

e As RPGraphEdge

cl As RPClass

c2 As RPClass

gp As RPGraphicalProperty

On Error GoTo aa

Set
Set
Set
Set

proj = getProject

d = proj.addNewAggr (“*ObjectModelDiagram”,
m = proj.findNestedElementRecursive ("C",
cl =m

' Add node for existing element

[in] BSTR value)

“MyDiagram”)

“MyDiagram”)
"Class")
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Set nl = d.AddNewNodeForElement (m, 10, 20, 50, 50)
Call nl.setGraphicalProperty("LineColor", "155.230.100")

' Add node with new element

Set n2 = d.AddNewNodeByType ("Class", 110, 120, 50, 50)
Set ¢2 = n2.modelObject

c2.name = "D"

' Add edge for new dependency

Set e = d.AddNewEdgeByType ("Dependency", nl, 60, 60, n2, 130, 140)
Set gp = e.getGraphicalProperty("LineStyle")
MsgBox gp.value

Exit Sub

aa:
MsgBox errorMessage
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IRPGraphicalProperty Interface

Thel RPG aphi cal Property interface represents a graphical elements on adiagram. It
inherits from | RPDi spat ch.

VB Properties
Name Type Access Description
key String RO The name of the property
value String RO The property value

IRPGraphNode Interface
The | RPG aphNode interface represents either a boxed element (for example, a class box) or

apoint element (for example, a connector) in adiagram. It represents the UML G- aphNode
class. | RPG aphNode inherits from | RPGr aphEl enent .

IRPGuard Interface

Thel RPQuar d interface represents the guard of atransition in a statechart diagram. It inherits
from | RPModel El enent .

VB Properties
Name Type Access Description
body String RW The body of the guard
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IRPHyperLink Interface

Note: You cannot create or modify hyperlinks using the COM API.

VB Properties
Name Type Access Description
target RPModel El ement RW The target for the hyperlink
URL String RW The URL for the hyperlink

Method Summary

getDisplayOption

Returns the display option (free text,
target name, target label, or tag value)
for the hyperlink

setDisplayOption

Sets the display option (free text, target
name, target label, or tag value) for the

hyperlink

The | RPHyper Li nk interface enables you to read the attributes of hyperlink objects. See the
User Guide for detailed information about hyperlinks.
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getDisplayOption
Read method

Description

The getDisplayOption method returns the display option (free text, target name, target label, or
tag value) for the hyperlink.

See the User Guide for detailed information on hyperlinks.
Visual Basic
Syntax

getDisplayOption (pVal As HYPNameType, [pDisplayName As String])

Arguments

pVal
The hyperlink

Return Value

A string that represents the display option for the hyperlink

C/C++ Prototype

HRESULT getDisplayOption (HYPNameType* pVal, BSTR *pDisplayName)

Return Value

HRESULT (O for success, or asigned integer error code)
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setDisplayOption
Write method

Description

The setDisplayOption method sets the display option (free text, target name, target label, or tag
value) for the hyperlink.

See the User Guide for detailed information on hyperlinks.
Visual Basic
Syntax

setDisplayOption (pVal As HYPNameType, [pDisplayName AsString])
Arguments
pVal
The hyperlink
pDisplayName
The display type (free text, target name, target label, or tag value)

C/C++ Prototype

HRESULT setDisplayOption (HYPNameType* pVal, BSTR *pDisplayName)

Return Value

HRESULT (O for success, or asigned integer error code)

Rhapsody 293



Rhapsody API Interfaces

IRPImageMap

Represents diagram element information that can be used to build an HTML image map for the
diagram. IRPDiagram's get Pictureas method returns a collection of objects of this type.

interfaceName
This property is for future use.

isGUID
Indicates whether the target property isthe GUID of the element.

name
Name of the element.

pictureFileName
Name of theimagefile.

points

String that represents the bounding rectangle for the element in the Rhapsody diagram (for
example, "10,10,206,10,206,151,10,151").

shape
This property isfor future use.

target
Target for the image map entry.
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IRPInstance Interface

Thel RPI nst ance interface represents an instance. It is derived from | RPRel at i on,
because the instance is a rel ation between an owner and some class.

VB Properties
Name Type Access Description
instantiatedBy RPOper ati on | RW The constructor used to

create the instance, as
defined by the user within
the instance features

dialog box
Method Summary
getinLinks Retrieves the list of incoming links
getListOfInitializerArguments Retrieves the list of initializer arguments
getOutLinks Retrieves the list of outgoing links
setlnitializerArgumentValue Sets the value of the initializer argument
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getinLinks
Read method

Description

The getinLinks method returnsthe list of links for which the instance is the target instance
(identified by the “to” property of the link).

Visual Basic
Syntax

getInLinks () As RPCollection

Return Value
AnRPCol | ecti on that contains the read-only list of incoming links
C/C++ Prototype

HRESULT getInLinks (IRPCollection** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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getListOfInitializerArguments
Read method

Description

The getListOfInitializerArguments method returns the list of arguments for the initializer, as
defined by the user in the instance features dialog box.

Visual Basic
Syntax

getListOfInitializerArguments () As RPCollection

Return Value

AnRPCol | ect i on that contains the values of the arguments passed to theinitializer. Thislist
isaread-only list of strings.

C/C++ Prototype

HRESULT getListOfInitializerArguments (
IRPCollection** pval)

Return Value

HRESULT (O for success, or asigned integer error code)
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getOutLinks
Read method

Description

The getOutLinks method returns the list of links for which the instance is the source instance
(identified by the “from” property of the link).

Visual Basic
Syntax

getOutLinks () As RPCollection

Return Value
AnRPCol | ecti on that contains the read-only list of outgoing links
C/C++ Prototype

HRESULT getOutLinks (IRPCollection** pvVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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setInitializerArgumentValue
Write method

Description

The setinitializerArgumentValue method sets the value of the initializer argument.

Visual Basic
Syntax

setInitializerArgumentValue (argName As String,
argValue as String)

Arguments
argName
The name of the initializer argument

argValue

The initial value of the initializer argument

C/C++ Prototype

HRESULT setInitializerArgumentValue (BSTR argName,
BSTR argValue)

Return Value

HRESULT (O for success, or asigned integer error code)
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IRPInteractionOccurrence Interface

Thel RPI nt er act i onQccur r ence interface represents an interaction occurrence (reference
sequence diagram). It derives from | RPMbdel El enent .

See the User Guide for detailed information about interaction occurrences.

VB Properties
Name Type Access Description

messagePoints RPCol | ecti on RO The message points
of the referenced
sequence diagram

referenceSequenceDiagram RPSequenceDbi agram | RW The sequence
diagram being
referenced
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IRPInterfaceltem Interface

Thel RPI nt er f acel t eminterface represents the commonality of class interface elements. It
derivesfrom | RPMbdel El enent .

VB Properties
Name Type Access Description
arguments Collection of RO The arguments of this
RPAr gunment s operation or event
signature String RO The signature of this
operation. For example:
"f(int x,
char *y)"
Method Summary
addArgument Adds an argument for the operation to the end

of its argument list

addArgumentBeforePosition Adds an argument for the operation at the
specified position in its argument list

getSignatureNoArgNames Retrieves the signature of the current class
interface element without argument names

getSignatureNoArgTypes Retrieves the signature of the current class
interface element without argument types

matchOnSignature Determines whether the signature of the
current class interface element matches that
of another | RPI nt er f acel t em
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addArgument
Write method

Description

The addArgument method adds an argument for the operation to the end of its argument list.
Visual Basic
Syntax

addArgument (newVal As String) As RPArgument

Arguments

NewVal

The new argument to append to the argument list

Return Value
The new argument added to the argument list
C/C++ Prototype

HRESULT addArgument (BSTR newVal, IRPArgument** argument)

Return Value

HRESULT (O for success, or asigned integer error code)
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addArgumentBeforePosition
Write method

Description

The addArgumentBeforePosition method adds an argument for the operation at the specified
position in its argument list.

Visual Basic
Syntax

addArgumentBeforePosition (newVal As String, pos As Long)
As RPArgument

Arguments

newVal
The new argument to add to the argument list
pos

A |l ong that represents the position of the argument in argument list
(1,2,3,..n; left to right)

Return Value
The new argument added to the argument list
C/C++ Prototype

HRESULT addArgumentBeforePosition (BSTR newVal, long pos,
IRPArgument** argument)

Return Value

HRESULT (O for success, or asigned integer error code)
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getSignatureNoArgNames
Read method

Description

The getSignatureNoArgNames method retrieves the signature of the current class interface
element without argument names.

Visual Basic
Syntax

getSignatureNoArgNames () As String

Return Value

The signature of the element without argument names. For example:
f (string, int)
C/C++ Prototype

HRESULT getSignatureNoArgNames (BSTR *pVal)

Return Value

HRESULT (O for success, or asigned integer error code)

304 API| Reference Manual



IRPInterfaceltem Interface

getSignatureNoArgTypes
Read method

Description

The getSignatureNoArgTypes method retrieves the signature of the current class interface
element without argument types.

Visual Basic
Syntax

getSignatureNoArgTypes () As String

Return Value
The signature of the element without argument types. For example:

f(x,y)
C/C++ Prototype
HRESULT getSignatureNoArgTypes (BSTR *pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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matchOnSignature

Read method
Description

The matchOnSignature method determines whether the signature of the current class interface
element matches that of another | RPI nt er f acel t em

Visual Basic
Syntax
matchOnSignature (item As RPInterfaceItem) As Long
Arguments
item

A pointer to the RPInterfaceltemwhose signature is being compared to
that of the current interface item

Return Value
1if the two signatures match; otherwise 0
C/C++ Prototype

HRESULT matchOnSignature (IRPInterfaceltem* item,
long *pval)

Return Value

HRESULT (O for success, or asigned integer error code)
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IRPLink Interface

The | RPLi nk interface represents a link-end that instantiates arelation. 1t inherits from
| RPModel El enment .

VB Properties
Name Type Access Description

end1Multiplicity String RW The multiplicity of the first
end of the link

end1lName String RW The name of the first end
of the link

end2Multiplicity String RW The multiplicity of the
second end of the link

end2Name String RW The name of the second
end of the link

from RPI nst ance RO The source instance of the
link.

instantiates RPRel ati on RO The association the link
instantiates.

other RPLi nk RO The pair link. In most
cases, this property is
redundant.

to RPI nst ance RO The target instance of the

link.
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IRPMessage Interface

The | RPMessage interface represents a message sent between two classifier rolesin a

collaboration. It inherits from | RPMbdel El enent .

VB Properties

Name

Type

Access

Description

actual ParameterList

String

RO

A collection of strings that
contain parameters.

communication
Connection

RPAssocat i onRol e

RO

The communication
connection. This is always
NULL for sequence
diagrams.

condition

Cstring

RO

This is meaningful only if
the message is of type
“condition”.

formal Interfaceltem

RPI nterfaceltem

RO

This can be NULL for
timeouts or “default” for
CTOR, DTOR, and non-
specified methods.

messageType

Cstring

RO

The message type
(constructor, destructor,
event, operation,
triggered, timeout,
cancelled timeout,
condition, or unspecified).

returnValue

Cstring

RO

The name of the element
that receives the return
value.

sequenceNumber

Cstring

RO

The number or position in
an ordered list. For
sequence diagrams,
Rhapsody deduces the
number.

source

RPCl assifierRol e

RO

Specifies who sent the
message.

target

RPCl assifierRol e

RO

Specifies who received the
message.

timerValue

String

RO

The timer value

Method Summary

getSignature

Retrieves the prototype of the | RPMessage
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getSignature
Read method

Description

The getSignature method retrieves the prototype of the | RPMessage.
Visual Basic
Syntax

getSignature () As String

Return Value
The signature
C/C++ Prototype

HRESULT getSignature (BSTR* pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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IRPMessagePoint Interface

Thel RPMessagePoi nt interface represents an event in a sequence diagram. It inherits from
| RPModel El enment .

Note that in a collaboration diagram, all events are send/receive pairs with nothing in between

them.
VB Properties
Name Type Access Description
message RPMessage RO The message that the
current event refers to
type String RO “Send' or “receive”

Method Summary

getClassifierRole Retrieves the classifier role for this message point
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getClassifierRole
Read method

Description

The getClassifierRole method retrieves the classifier role for this message point. Thisisthe
classifier role (object) that received this event and sent back a return message.

Visual Basic
Syntax

getClassifierRole() As RPClassifierRole

Return Value
The RPCl assi f i er Rol e on which the message occurred
C/C++ Prototype

HRESULT getClassifierRole (
IRPClassifierRole** classifierRole)

Return Value

HRESULT (O for success, or asigned integer error code)
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IRPModelElement Interface

Thel RPMbdel El enent interface isthe base abstract interface for all Rhapsody 6.1

metamodel elements. It consists of all the common functionality shared by al the elementsin

the model (except for the Appl i cat i on class). It acts as an abstract interface.

VB Properties
Name Type Access Description
annotations Collection of RO The annotations that
RPAnnot ati ons belong to this model
element.
congtraints Collection of RO The constraints that
RPConstraints belong to this model
element.
constraintsByHim Collection of RO The constraints that
| RPConstraints affect this model
element.
dependencies Collection of RO The model elements on
Rpmpendency which this model
element depends.
description String RW The description of this
model element.
descriptionHTML String RW The description of the
model element in HTML
format.
descriptionRTF String RW The description of the
model element in RTF
format.
displayName String RW The display name.
GUID String RW The GUID value.
hyperLinks Collection of RO The hyperlinks added to
IRPHyperLink-s an element.
isOfMetaclass (metacl ass) Long RO This is equal to 1 (as
opposed to 0) if the
current model element
is a member of this
metaclass. Requires the
string metaclass.
isShowDisplayName Long RW Specifies whether to

show the display name.
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Name

Type

Access

Description

mainDiagram

RPDi agr am

RW

The main diagram of
this element. Currently,
this property is valid
only for classes,
packages, actors, and
use cases.

metaClass

String

RO

The metaclass of this
model element.

name

String

RW

The name of this model
element.

of Template

RPModel El enent

RW

If the model element is
an instantiation, this
method will return the
template used to
instantiate it.

owner

RPModel El enent

RW

The object in which this
model element is
defined.

You can use this
property to establish
ownership. For
example, suppose C is
aclassandpisa
package:

Dimc as RPC ass
Di mp as RPPackage
set ¢ = ...

set p = ...
c.owner = p

This will work for any

two objects where one
can contain the other.

project

RPPr oj ect

RO

The project that owns
this element.

requirementTraceability
Handle

| ong

RW

The handle to this
model element used by
requirement traceability
tools.

stereotype

RPSt er eot ype

RW

The stereotype
attached to this model
element.

templateParameters

Collection of
RPTenpl at e
Par amet er

RO

If this model element is
a template, the method
returns the template’s
parameters.
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Name Type Access Description
ti RPTenpl at e RW If this model element is
Instantiation a template, it

instantiates the
template into a class as
follows:

1. Create aclass c.

2. Create a template
instantiation, t heTi .
3. Connect the new

class with the template
instantiation:

c.ti = theTi

Method Summary

addDependenc

Adds a dependency relationship to
the specified object

addDependencyTo

Creates a new dependency
between two objects

addNewAaqar

Used to add a new model element
to the current element, for example,
adding a class to a package

addProperty

Adds a new property/value pair for
the current element

addStereotype

Adds a stereotype relationship to
the specified object

becomeTemplatelnstantiationOf

Creates a template instantiation of
another template (of another
template class)

clone

Clones the element

deleteDependenc

Deletes a dependency

deleteFromProject

Deletes the current model element
from the project open in Rhapsody
6.1

errorMessage

Returns the most recent error
message

findElementsByFullName

Searches for the specified element

findNestedElement

Retrieves the specified element
nested in a model element

findNestedElementRecursive

Retrieves the specified element
from a given model element at any
level of nesting within that element

getErrorMessage

Returns the most recent error
message
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getFullPathName

Retrieves the full path name of a
model element as a string

getFullPathNameln

Retrieves the full path name of a
model element as a string

getNestedElements

Retrieves the elements defined in
the current object

getNestedElementsRecursive

Recursively retrieves the elements
defined in the model element for the
object and for objects defined in it

getOverriddenProperties

Retrieves the list of properties
whose default values have been
overridden

getPropertyValue

Returns the value associated with
the specified key value

getPropertyValueExplicit

Returns an explicit value if it has
been assigned to the metamodel

getTag

Returns the tag for the specified
model element

HighlLightElement

Highlights the current model
element

openFeaturesDialog

Displays the information for an
element in the Features dialog.
Depending on parameter provided,
opens new dialog or uses an
already-open dialog.

removeProperty

Removes the property from the
model element

removesStereotype

Removes the stereotype

setPropertyValue

Modifies the value of the specified
property

setTagValue

Assigns the specified tag to the
model element

synchronizeTemplatelnstantiation

Is used to synchronize between a
template and a template
instantiation parameter
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addDependency
Write method

Description

The addDependency method adds a dependency relationship to the specified object.
Visual Basic
Syntax

addDependency (dependsOnName As String, dependsOnType
As String) As RPDependency

Arguments

dependsOnName
The name of the object that this element depends on
dependsOnType

The type of object that this element depends on

Return Value
The newly created dependency
C/C++ Prototype

HRESULT addDependency (BSTR dependsOnName,
BSTR dependsOnType, IRPDependency** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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addDependencyTo
Write method

Description

The addDependencyTo method creates a new dependency relationship between two objects.

Visual Basic
Syntax

addDependencyTo (element As RPModelElement)
As RPDependency

Arguments

element

The name of the object that the current object depends on

Return Value
The newly created dependency
C/C++ Prototype

HRESULT addDependencyTo (IRPModelElement* element,
IRPDependency** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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addNewAqggr
Write method

Description

The addNewAggr method is used to add a new model element to the current element, for
example, adding a new class to a package or adding a new diagram to a project.

Visual Basic
Syntax

addNewAggr (metaType As String, name As String)
As RPModelElement

Arguments

metaType

The type of element to add (the string to use is the name of the appropriate metaclass).

Note

Thelist of metaclass names that can be used for this argument can be found in the file
metaclasses.txt in the Doc directory of your Rhapsody installation.

name

The nameto use for the new element
Return Value

The newly created element
C/C++ Prototype

HRESULT addNewAggr (BSTR metaType, BSTR name,
IRPModelElement ** newObject)

Return Value
HRESULT (O for success, or asigned integer error code)
Example

Set proj = getProject
Set d = proj.addNewAggr (“ObjectModelDiagram”, “MyDiagram”)
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addProperty
Write method

Description
The addProperty method adds a new property/value pair for the current element.
This method is capable of flagging an error. For more information, see Error Handling
Visual Basic
Syntax

addProperty (propertyKey As String,
propertyType As String, propertyValue As String)

Arguments

propertyKey

The name of the new property.

propertyType

The property type. The possible values are as follows:
int

string

enum <xXxx>, <yyy>, <ZzZzz>

Boolean

propertyValue

The default value of the new property.

C/C++ Prototype

HRESULT addProperty (BSTR propertyKey, BSTR propertyType,
BSTR propertyValue)

Return Value

HRESULT (O for success, or asigned integer error code)
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addStereotype
Write method

Description

The addstereotype method adds a stereotype relationship to the specified object.
Visual Basic
Syntax

addStereotype (name As String, metaType As String)
As RPStereotype

Arguments

name
The name of the object in the new stereotype relationship
metaType

The type of the object in the new stereotype relationship

Return Value
The newly created stereotype relationship
C/C++ Prototype

HRESULT addStereotype (BSTR name, BSTR metaType,
IRPStereotype** stereotype)

Return Value
HRESULT (O for success, or asigned integer error code)
Example

Sub addNetwork (c As RPClass)

Dim o As RPOperation

c.addOperation ("serialize")
c.addOperation ("unserialize")
c.addConstructor ("")

On Error Resume Next

c.addDestructor ("")

X = c.addStereotype ("G3Network", "Class")
End Sub
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becomeTemplatelnstantiationOf
Write method

Description

The becomeTemplatelnstantiationOf method creates a template instantiation of another
template (of another template class).

Visual Basic
Syntax

becomeTemplateInstantiationOf (newVal As RPModelElement)
Arguments

newVal

The template object that the template is an instantiation of

C/C++ Prototype

HRESULT becomeTemplateInstantiationOf (
IRPModelElement *newVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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clone
Write method

Description

The clone method clones the element, names it, and adds it to the new owner.
Visual Basic
Syntax

clone (name As String, newOwner As RPModelElement)
As RPModelElement

Arguments
name
The name to use for the cloned element

newOwner

The new owner of the cloned element

C/C++ Prototype

HRESULT clone (BSTR string, IRPModelElement *newOwner,
IRPModelElement** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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deleteDependency
Write method

Description

The deleteDependency method del etes a dependency.

Visual Basic
Syntax

deleteDependency (dependency As RPDependency)

Arguments

dependency

The dependency to delete

C/C++ Prototype

HRESULT deleteDependency (IRPDependency* dependency)

Return Value

HRESULT (O for success, or asigned integer error code)
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deleteFromProject
Write method

Description

The deleteFromProject method del etes the current model element from the project open in
Rhapsody 6.1.

Visual Basic
Syntax
deleteFromProject ()
C/C++ Prototype
HRESULT deleteFromProject ()

Return Value

HRESULT (O for success, or asigned integer error code)
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errorMessage
Read method

Description

The errorMessage method returns the most recent error message.
Visual Basic
Syntax

errorMessage () As String

Return Value
The most recent error message (a string)
C/C++ Prototype

HRESULT errorMessage (BSTR* _ MIDL 0020)

Return Value

HRESULT (O for success, or asigned integer error code)
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findElementsByFullName
Read method

Description

ThefindElementsByFullName method searches for the specified element.

Visual Basic
Syntax

findElementsByFullName (name As String,
metaClass As String) As RPModelElement

Arguments
name
The name of the element to look for

metaClass

The element’s metaclass

Return Value
The specified element
C/C++ Prototype

HRESULT findElementsByFullName (BSTR name,
BSTR metaClass, IRPModelElement** pVal)

Return Value
HRESULT (O for success, or asigned integer error code)
Example

Suppose you have aclass A, under package P. The following VBA code will find this class
using thef i ndEl ement sByFul | Nane API call:

Dim proj As RPProject
Dim m As RPModelElement

Set proj = getProject

Set m = proj.findElementsByFullName ("A in P", "Class")
MsgBox m.name

Note

This method requires that you use the “full” notation, e.g., “A in P’. Otherwise, the method
will not return the specified element.
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findNestedElement
Read method

Description

The findNestedElement method retrieves the specified element nested in amodel element.

For example, if xisof typel RPMbdel El enent (or atypeinherited fromit), the following call
returns an attribute of x named A (or null if there is no such element:

x.findNestedElement (‘A’, 'Attribute’)
Visual Basic
Syntax

findNestedElement (name As String, metaClass As String)
As RPModelElement

Arguments
name
The name of the element

metaClass

The name of the metaclass

Return Value
If found, the retrieved RPMbdel El emrent ; otherwise, NULL
C/C++ Prototype

HRESULT findNestedElement (BSTR name, BSTR metaClass,
IRPModelElement** pvVal)

Return Value
HRESULT (O for success, or asigned integer error code)
Example

Sub addUi (c As RPClass)

Dim x As Object

Dim p As RPPackage

Dim theClass As RPClass

'all gui objects are derived from GUI.UIBase

c.Description = "gui class"

On Error Resume Next

Set p = pr.findNestedElement ("GUI", "Package")

Set theClass = p.findNestedElement ("UIBase", "Class")

c.addGeneralization theClass

If Not Err.Number = 0 Then
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MsgBox (errorMessage)
End If

c.addStereotype "G3UI", "Class"

End Sub

findNestedElementRecursive
Read method

Description

The findNestedElementRecursive method retrieves the specified element from a given model
element at any level of nesting within that element.

For example, if xisof typel RPMbdel El enent (or atypeinherited fromit), the following call
returns an attribute named A (or null if there is no such element) of x, or of any element nested
within x at any level of ownership:

x.findNestedElementRecursive (‘A’, 'Attribute’)
Visual Basic
Syntax

IRPModelElement findNestedElementRecursive (
name As String, metaClass As String) As RPModelElement

Arguments

name
The name of the element
metaClass

The name of the metaclass

Return Value
If found, the retrieved RPMbdel El emrent ; otherwise, NULL
C/C++ Prototype

HRESULT findNestedElementRecursive (BSTR name,
BSTR metaClass, IRPModelElement** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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getErrorMessage
Read method

Description

The getErrorMessage method returns the most recent error message.
Visual Basic
Syntax

String getErrorMessage (__ MIDL 0019 As String)

Return Value
The most recent error message
C/C++ Prototype

HRESULT getErrorMessage (BSTR* _ MIDL 0019)

Return Value

HRESULT (O for success, or asigned integer error code)
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getFullPathName
Read method

Description

The getFullPathName method retrieves the full path name of amodel element as a string with
the following format:

<package>::<class>
Visual Basic
Syntax

getFullPathName () As String

Return Value
Thefull path of the model element
C/C++ Prototype

HRESULT getFullPathName (BSTR* name)

Return Value
HRESULT (O for success, or asigned integer error code)
Example

The following macro checks each transition to seeiif it has atrigger.

Sub checkNullTransitions ()
Dim elem As RPModelElement
For Each elem In getProject.getNestedElementsRecursive

If elem.metaClass = "Transition" Then
Dim trans As RPTransition
Set trans = elem
If trans.getItsTrigger Is Nothing Then
Debug.Print "The trigger in transition '" +
trans.getFullPathName + "' is null!"
End If

End If

Next elem

End Sub
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getFullPathNameln
Read method

Description

The getFullPathNameln method retrieves the full path name of amodel element asastring in
the following format:

<class> in <package>
Visual Basic
Syntax
getFullPathNameIn () As String

Return Value
Thefull path of the model element
C/C++ Prototype

HRESULT getFullPathNameIn (BSTR* name)

Return Value

HRESULT (O for success, or asigned integer error code)
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getNestedElements
Read method

Description

The getNestedElements method retrieves the elements defined in the current object.
Visual Basic
Syntax

getNestedElements () As RPCollection

Return Value
A collection of model elements defined in the current object
C/C++ Prototype

HRESULT getNestedElements (IRPCollection**  MIDL 0017)

Return Value

HRESULT (O for success, or asigned integer error code)
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getNestedElementsRecursive
Write method

Description

The getNestedElementsRecursive method recursively retrieves the elements defined in the
model element for the object and for objects defined in it.

Visual Basic
Syntax
getNestedElementsRecursive () As RPCollection
Return Value
A collection of model elements defined in the current object and the objects nested within it
C/C++ Prototype

HRESULT getNestedElementsRecursive (
IRPCollection** _ MISL__ 0018)

Return Value
HRESULT (O for success, or asigned integer error code)
Example
The following macro checks each transition to see if it has atrigger.

Sub checkNullTransitions ()
Dim elem As RPModelElement
For Each elem In getProject.getNestedElementsRecursive

If elem.metaClass = "Transition" Then
Dim trans As RPTransition
Set trans = elem
If trans.getItsTrigger Is Nothing Then
Debug.Print "The trigger in transition '" +
trans.getFullPathName + "' is null!"
End If

End If

Next elem

End Sub
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getOverriddenProperties
Read method

Description

The getOverriddenProperties method retrieves the list of properties whose default values have
been overridden.

Visual Basic
Syntax

getOverriddenProperties (recursive As Long)
As RPCollection

Arguments

recursive

Specifies whether to include the properties of ascendants of the unit

C/C++ Prototype

HRESULT getOverriddenProperties (long recursive,
IRPCollection **pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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getPropertyValue
Read method

Description

The getPropertyValue method returns the value associated with the specified key value.
This method is capable of flagging an error.

Visual Basic

Syntax

getPropertyValue (propertyKey As String) As String

Arguments

propertyKey

The name of the property whose value is to be retrieved

Return Value

The value of a property explicitly assigned to this instance or the default value (the value
propagated from the containers of the instance as a default).

Notes
Property-related API calls can cause the following error conditions:

¢ RP_BAD PROPERTY_KEY_ERROR—IIlegal property key syntax (that is, not in a
"<subj ect >. <met acl ass>. <nanme>" format).
¢ RP_M SSI NG_PROPERTY_ERROR—The property requested does not exist.

¢ RP_PROPERTY_EXI STS_ERROR—You are attempting to add a property that
aready exists.

C/C++ Prototype

HRESULT getPropertyValue (BSTR propertyKey,
BSTR* propertyValue)

Return Value

HRESULT (O for success, or asigned integer error code)
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Example

Set elt = getSelectedElement

theFileName = elt.getPropertyValue (
"UserProperties.ExternalFile.FileName")

theFilePath = elt.getPropertyValue (
"UserProperties.ExternalFile.FilePath")

theFileType = elt.getPropertyValue (
"UserProperties.ExternalFile.FileType")

getPropertyValueExplicit
Read method

Description

The getPropertyValueExplicit method is similar to the get Pr oper t yVal ue method, but it
does not return adefault value. Instead, it returns an explicit valueif it has been assigned to the
metamodel.

This method is capable of flagging an error. For more information, see Error Handling
Visual Basic
Syntax

getPropertyValueExplicit (propertyKey As String)
As String

Arguments

propertyKey
The name of the property whose value is to be retrieved

Return Value
The explicit value of the property, if one has been assigned to the metamode! instance
C/C++ Prototype

HRESULT getPropertyValueExplicit (BSTR propertyKey,
BSTR* propertyValue)

Return Value

HRESULT (O for success, or asigned integer error code)
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getTag
Read method

Description

The getTag method returns the tag for the specified model element.
Visual Basic
Syntax

getTag (name As String) As RPTag

Arguments

name

The name of the element whose tag you want to retrieve

Return Value
Thetag
C/C++ Prototype

HRESULT getTag (BSTR name, IRPTag **pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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openFeaturesDialog

Description

The method openFeaturesbialog displaysthe information for an element in the Features
dialog. Depending on the parameter you provide, a new Features dialog will be opened or an
aready-open Features dialog will be used to display the information:

¢ 1-opensanew dialog

¢ 0-displaysinformation in already-open dialog; opens anew dialog isthereis not
aFeatures dialog currently open.

Syntax

openFeaturesDialog(newDialog As Long)

Example

The code below displays the information for class C in anew Features dialog. P isthe name of
the package that contains the class.

Dim proj As RPProject

Dim m As RPModelElement

Set proj = getProject

Set m = proj.findElementsByFullName ("C in P", "Class")

m.openFeaturesDialog (1)
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HighLightElement
Read method

Description

The HighLightElement method highlights the current element.

Visual Basic
Syntax

HighLightElement ()

C/C++ Prototype

HRESULT highLightElement ()

Return Value

HRESULT (O for success, or asigned integer error code)
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removeProperty

Write method

Description

The removeProperty method removes the property from the model el ement.

This method is capable of flagging an error.
Visual Basic
Syntax

removeProperty (propertyKey As String)

Arguments

propertyKey

The name of the property to be removed

C/C++ Prototype

HRESULT removeProperty (BSTR propertyKey)

Return Value

HRESULT (O for success, or asigned integer error code)
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removeStereotype
Write method

Description

The removeStereotype method removes the stereotype from the model element.
Visual Basic
Syntax

removeSterotype (stereotype As RPSterotype)

Arguments

stereotype

The name of the stereotype to be removed

C/C++ Prototype

HRESULT removeStereotype (IRPStereotype* stereotype)

Return Value

HRESULT (O for success, or asigned integer error code)
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setPropertyValue
Write method

Description

The setPropertyValue method modifies the value of the specified property.

This method is capable of flagging an error. For more information, see Error Handling
Visual Basic
Syntax

setPropertyValue (propertyKey As String,
propertyValue As String)

Arguments
propertyKey
The name of the property whose value is to be set

propertyValue

The value to be assigned to the property

C/C++ Prototype

HRESULT setPropertyValue (BSTR propertyKey,
BSTR propertyValue)

Return Value

HRESULT (O for success, or asigned integer error code)
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setTagValue

Write method
Description

The setTagValue method assigns the specified tag to the current model element.
Visual Basic
Syntax

setTagValue (tag As RPTag, val As String) AS RPTag
Arguments

tag

The name of the tag to add to the element

val

The value of the new tag

Return Value
The new tag
C/C++ Prototype

HRESULT setTagValue (IRPTag *tag, BSTR val,
IRPTag **pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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synchronizeTemplatelnstantiation
Write method

Description

The synchronizeTemplatelnstantiation method is used to synchronize between atemplate and a
template instantiation parameter. For example, if you add a parameter to atemplate, this
method updates the template instantiation. It is activated on template instantiation.

Visual Basic
Syntax

synchronizeTemplateInstantiation ()

C/C++ Prototype

HRESULT synchronizeTemplateInstantiation ()

Return Value

HRESULT (O for success, or asigned integer error code)
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IRPModule Interface

The | RPModul e interface represents a Rhapsody module. It inherits from | RPI nst ance.

IRPNode Interface

The | RPNode interface represents anode. It derivesfrom | RPCl assi fi er.

VB Properties
Name Type Access Description
componentlnstances RPCol | ecti on RO The list of component
instances

CPUType String RW The CPU type

Method Summary
addComponentinstance Adds a new component instance
deleteComponentinstance Deletes the specified component instance
findComponentinstance Retrieves the specified component instance

addComponentinstance
Write method

Description

The addComponentinstance method adds a component instance.
Visual Basic
Syntax

addComponentInstance (name As String)
As RPComponentInstance

Arguments

name

The name of the new component instance

Return Value

The new component instance
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C/C++ Prototype

HRESULT addComponentInstance (BSTR name,
IRPComponentInstance** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)

deleteComponentinstance
Write method

Description

The deleteComponentinstance method del etes the specified component instance.

Visual Basic
Syntax

deleteComponentInstance (BSTR name)

Arguments

name

The name of the new component instance

C/C++ Prototype

HRESULT deleteComponentInstance (BSTR name)

Return Value

HRESULT (O for success, or asigned integer error code)

findComponentinstance
Read method

Description

The findComponentinstance method retrieves the specified component instance.

Visual Basic
Syntax

findComponentInstance (name As String)
As RPComponentInstance
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Arguments

name

The name of the component instance to look for

Return Value
The component instance
C/C++ Prototype

HRESULT findComponentInstance (BSTR name,
IRPComponentInstance** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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IRPObjectModelDiagram Interface

The | RPObj ect Model Di agr aminterface represents an object model diagram. It inherits

from | RPDi agr am

Currently, | RPQbj ect Model Di agr am does not expose additional functionality to

| RPDi agr am

IRPOperation Interface

Thel RPOper at i on interface is an abstract class that represents an operation. It derives from

| RPI nterfaceltem

VB Properties

Name

Type

Access

Description

body

String

RW

The body of the operation.

flowchart

RPFI owchart

RW

The activity chart of the
operation.

initializer

String

RW

If this operation is a
constructor, this is a string
containing the constructor
initialization list.

isAbstract

Long

RW

This is equal to 1 (as
opposed to 0) if the
operation is abstract.

isCgDerived

Long

RO

This is equal to 1 (as
opposed to 0) if this
operation is automatically
generated by Rhapsody
6.1.

isConst

Long

RO

This is equal to 1 (as
opposed to 0) if the
operation is a const .

isCtor

Long

RO

This is equal to 1 (as
opposed to 0) if the
operation is a constructor.

isDtor

Long

RO

This is equal to 1 (as
opposed to 0) if the
operation is a destructor.

isFinal

Long

RW

This is equal to 1 (as
opposed to 0) if the
operation is final (Java

only).
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Name

Type

Access

Description

isStatic

Long

RO

This is equal to 1 (as
opposed to 0) if the
operation is a static.

isTrigger

Long

RO

This is equal to 1 (as
opposed to 0) if the
operation is triggered.

isVirtual

Long

RO

This is equal to 1 (as
opposed to 0) if the
operation is virtual.

returns

RPCl assi fier

RW

The return type of this
operation.

In previous versions, this
property was called
“returnType”.

returnType

RPType

RW

The return type of this
operation.

visibility

String

RW

The visibility of this
operation (public,
protected, or private).

Method Summary

deleteArgument

Deletes an argument from the current

operation

deleteFlowchart

Deletes an activity diagram from the current

operation

getimplementationSignature

Returns a string representing the signature of
the operation as it will appear in the generated

code.

setReturnTypeDeclaration

Specifies a new value for the return type

declaration
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deleteArgument

Write method

Description

The deleteArgument method deletes an argument from the current operation.

Visual Basic
Syntax

deleteArgument (argument As RPArgument)
Arguments

argument

The argument to be deleted

C/C++ Prototype

HRESULT deleteArgument (IRPArgument* argument)

Return Value

HRESULT (O for success, or asigned integer error code)
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deleteFlowchart
Write method

Description
The deleteFlowchart method deletes an activity diagram from the current operation.
Visual Basic
Syntax
deleteFlowchart ()
C/C++ Prototype

HRESULT deleteFlowchart ()

Return Value
HRESULT (O for success, or asigned integer error code)

getimplementationSignature

Returns a string representing the signature of the operation as it will appear in the generated
code.
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setReturnTypeDeclaration
Write method

Description

The setReturnTypeDeclaration method specifies a new value for the return type declaration.

Visual Basic
Syntax

setReturnTypeDeclaration (newVal As String)

Arguments

newVal

The new value for the return type declaration

C/C++ Prototype

HRESULT setReturnTypeDeclaration (BSTR newVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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IRPPackage Interface

The | RPPackage interface represents Rhapsody packages, which are essentially definition
spaces for diagrams and other model elements. It inherits from | RPUni t .

VB Properties
Name Type Access Description
actors Collection of RPAct or s RO The collection of actors
defined in this package
classes Collection of RPCl asses RO The collection of classes
defined in this package
collaboration Collection of RO The collection of
Diagrams RPCol | abor ati on collaboration diagrams
Di agr ams defined in this package
componentDiagrams Collection of RO The collection of
RPConponent component diagrams
Di agrans defined in this package
deploymentDiagrams Collection of RO The collection of
RPDepl oynent deployment diagrams
Di agr ans defined in the package
events Collection of RPEvent s RO The collection of events
defined in this package
eventsBaseld Long RO The event base identifier
global Functions Collection of RO The collection of global
RPQper ati ons functions defined in the
package
global Objects Collection of RO The collection of global
RPRel ati ons objects defined in the
package
globaVariables Collection of RO The collection of global
RPAttri but es variables defined in the
package
flowltems Collection of RO The collection of
RPFl ow t ens information items defined
in this package
flows Collection of RPFI ows RO The collection of flows
defined in this package
nestedClassifiers Collection of classifiers RO The collection of
classifiers defined in this
package
nodes RPCol | ecti on RO The list of package nodes
objectModel Diagrams Collection of RO The collection of object

RPObj ect Di agr ans

model diagrams defined in
this package
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Name Type Access Description
packages Collection of RO The collection of packages
RPPackages nested inside this package
SavedInSeperateDirectory Long RW Determines whether each
package is saved in a
separate directory
sequenceDiagrams Collection of RO The collection of sequence
RPSequence diagrams defined in this
Di agr ans package
types Collection of RPType RO The collection of data
types defined in this
package
useCaseDiagrams Collection of RO The collection of use case
RPUseCaseDi agr anms diagrams defined in this
package
useCases Collection of RO The collection of use
RPUseCases cases defined in this
package
userDefinedStereotypes Collection of RO The collection of user-
RPSt er eot ypes defined stereotypes
defined in this package

Method Summary

addActor Adds the specified actor to the current
package
addClass Adds the specified class to the current

package

addCollaborationDiagram

Adds the specified collaboration diagram to
the current package

addComponentDiagram

Adds the specified component diagram to
the current package

addDeploymentDiagram

Adds the specified deployment diagram to
the current package

addEvent

Adds the specified event to the current
package

addFlowltems

Adds the specified flowltem to the
flowltems collection

addFlows

Adds the specified flow to the flows
collection

addGlobalFunction

Adds the specified global function to this
package

addGlobalObject

Adds a global object (instance) to the
current package
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addGlobalVariable

Adds the specified global variable to the
current package

addLink Adds a link between two objects to the
current package

addNestedPackage Adds a nested package to the current
package

addNode Adds the specified node to the current

package

addObjectModelDiagram

Adds the specified OMD to the current
package

addSequenceDiagram

Adds the specified sequence diagram to the
current package

addType Adds the specified type to the current
package
addUseCase Adds the specified use case to the current

package

addUseCaseDiagram

Adds the specified UCD to the current
package

deleteActor

Deletes the specified actor from the current
package

deleteClass

Deletes the specified class from the current
package

deleteCollaborationDiagram

Deletes the specified collaboration diagram
from the current package

deleteComponentDiagram

Deletes the specified component diagram
from the current package

deleteDeploymentDiagram

Deletes the specified deployment diagram
from the current package

deleteEvent

Deletes the specified event from the current
package

deleteFlowltems

Deletes the specified flowltem from the
flowltems collection

deleteFlows

Deletes the specified flow from the flows
collection

deleteGlobalFunction

Deletes the specified global function from
the current package

deleteGlobalObject

Deletes the specified global object from the
current package

deleteGlobalVariable

Deletes the specified global variable from
the current package

deleteNode

Deletes the specified node from the current
package

deleteObjectModelDiagram

Deletes the specified OMD from the current
package

deletePackage

Deletes the current package
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deleteSequenceDiagram

Deletes the specified sequence diagram
from the current package

deleteType

Deletes the specified type from the current
package

deleteUseCase

Deletes the specified use case from the
current package

deleteUseCaseDiagram

Deletes the specified use case diagram
from the current package

findActor

Retrieves the specified actor, if it belongs to
the current package

findAlIByName

Searches all the elements and finds the first
element of the specified name and
metaclass in the current package

findClass Retrieves the specified class, if it belongs to
the current package
findEvent Retrieves the specified event, if it belongs to

the current package

findGlobalFunction

Retrieves the specified global function, if it
belongs to the current package

findGlobalObject

Retrieves the specified global object, if it
belongs to the current package

findGlobalVariable

Retrieves the specified global variable, if it
belongs to the current package

findNode Retrieves the specified node, if it belongs to
the current package

findType Retrieves the specified data type, if it
belongs to the current package

findUsage Retrieves the usage of the specified

element in the current package

findUseCase

Retrieves the specified use case, if it
belongs to the current package

recalculateEventsBaseld

Recalculates the events base ID of the
package
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addActor
Write method

Description

The addActor method adds the specified actor to the current package.

Visual Basic
Syntax

addActor (name As String) As RPActor

Arguments

name

The name of actor to add to this package

Return Value
The new actor added to the package
C/C++ Prototype

HRESULT addActor (BSTR name, IRPActor** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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addClass

Write method

Description

The addcClass method adds the specified class to the current package.

Visual Basic
Syntax

addClass (name As String) As RPClass

Arguments

name

The name of the class to be added

Return Value
The class added to this package
C/C++ Prototype

HRESULT addClass (BSTR name, IRPClass** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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addCollaborationDiagram
Write method

Description

The addCollaborationDiagram method adds the specified collaboration diagram to the current
package.

Visual Basic
Syntax

addCollaborationDiagram (name As String)
As RPCollaborationDiagram

Arguments

name

The name of the collaboration diagram to be added

Return Value
The new collaboration diagram added to this package
C/C++ Prototype

HRESULT addCollaborationDiagram (BSTR name,
IRPCollaborationDiagram** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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addComponentDiagram
Write method

Description

The addComponentDiagram method adds the specified component diagram to the current
package.

Visual Basic
Syntax

addComponentDiagram (name As String)
As RPComponentDiagram

Arguments

name

The name of the component diagram to be added

Return Value
The new component diagram added to this package
C/C++ Prototype

HRESULT addComponentDiagram (BSTR name,
IRPComponentDiagram** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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addDeploymentDiagram
Write method

Description

The addDeploymentDiagram method adds the specified deployment diagram to the current
package.

Visual Basic
Syntax

addDeploymentDiagram (name As String)
As RPDeploymentDiagram

Arguments

name

The name of the deployment diagram to be added

Return Value
The new deployment diagram added to this package
C/C++ Prototype

HRESULT addDeploymentDiagram (BSTR name,
IRPDeploymentDiagram** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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addEvent

Write method

Description

The addEvent method adds the specified event to the current package.

Visual Basic
Syntax

addEvent (name As String) As RPEvent

Arguments

name

The name of the event to be added

Return Value
The new event added to this package
C/C++ Prototype

HRESULT addEvent (BSTR name, IRPEvent** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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addFlowltems
Write method

Description

The addFlowltems method adds the specified flowltem to the flowltems collection.
Visual Basic
Syntax

addFlowItems (name As String) As RPFlowItem

Arguments

name

The name of the flowItem to add to the collection

Return Value
The new flowltem added to this package
C/C++ Prototype

HRESULT addFlowItems (BSTR name,
IRPFlowItem** ppItem)

Return Value

HRESULT (O for success, or asigned integer error code)
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addFlows

Write method

Description

The addFlows method adds the specified flow to the flows collection.

Visual Basic
Syntax

addFlows (name As String) As RPFlow

Arguments

name

The name of the flow to add to the collection

Return Value
The new flow added to this package
C/C++ Prototype

HRESULT addFlows (BSTR name, IRPFlow** ppFlow)

Return Value

HRESULT (O for success, or asigned integer error code)
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addGlobalFunction
Write method

Description

The addGlobalFunction method adds the specified global function to this package.
Visual Basic
Syntax

addGlobalFunction (name As String) As RPOperation

Arguments

name

The global function to be added

Return Value
The new global function added to this package
C/C++ Prototype

HRESULT addGlobalFunction (BSTR name,
IRPOperation** pval)

Return Value

HRESULT (O for success, or asigned integer error code)
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addGlobalObject
Write method

Description

The addGlobalObject method adds a global object (instance) to the current package.
Visual Basic
Syntax

addGlobalObject (name As String,
otherClassName As String,
otherClassPackageName As String) As RPRelation

Arguments
name
The name of the global instance to add
otherClassName
The name of the class-defining instance
otherClassPackageName

The name of the package with the class-defining instance

Return Value
The new global instance in this package
C/C++ Prototype

HRESULT addGlobalObject (BSTR name, BSTR otherClassName,
BSTR otherClassPackageName, IRPRelation** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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addGlobalVariable
Write method

Description

The addGlobalVariable method adds the specified global variable to the current package.
Visual Basic
Syntax

addGlobalVariable (name As String) As RPAttribute

Arguments

name

The name of the global variable to add

Return Value
The new global variable added to this package
C/C++ Prototype

HRESULT addGlobalVariable (BSTR name,
IRPAttribute** pval)

Return Value

HRESULT (O for success, or asigned integer error code)
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addLink
The adarink method adds a link between two objects to the current package.

Syntax

addLink (fromPart As RPInstance, toPart As RPInstance, assoc As RPRelation,
fromPort As RPPort, toPort As RPPort) As RPLink

Arguments

fromPart, toPart

The objects that are being linked.

assocC

Association that is being instantiated (optional).

fromPort, toPort

Ports that are being linked (optional).
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addNestedPackage
Write method

Description

The addNestedPackage method adds a nested package to the current package.
Visual Basic
Syntax

addNestedPackage (name As String) As RPPackage

Arguments

name

The name of the nested package to add

Return Value
The nested package added to this package
C/C++ Prototype

HRESULT addNestedPackage (BSTR name, IRPPackage** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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addNode

Write method

Description

The addNode method adds a node to the current package.

Visual Basic
Syntax

addNode (name As String) As RPNode

Arguments

name

The name of the node to add

Return Value
The new node added to this package
C/C++ Prototype

HRESULT addNode (BSTR name, IRPNode** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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addObjectModelDiagram
Write method

Description

The addObjectModelDiagram method adds the specified OMD to the current package.
Visual Basic
Syntax

addObjectModelDiagram (name As String)
As RPObjectModelDiagram

Arguments

name

The name of the OMD to add

Return Value
The OMD added to this package
C/C++ Prototype

HRESULT addObjectModelDiagram (BSTR name,
IRPObjectModelDiagram** pvVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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addSequenceDiagram
Write method

Description

The addSequenceDiagram method adds the specified sequence diagram to the current package.
Visual Basic
Syntax

addSequenceDiagram (name As String) As RPSequenceDiagram

Arguments

name

The name of the sequence diagram to add

Return Value
The sequence diagram added to this package
C/C++ Prototype

HRESULT addSequenceDiagram (BSTR name,
IRPSequenceDiagram** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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addType
Write method

Description

The addType method adds the specified type to the current package.
Visual Basic
Syntax

addType (name As String) As RPType

Arguments

name

The name of the type to add

Return Value
The new type added to this package
C/C++ Prototype

HRESULT addType (BSTR name, IRPType** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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addUseCase

Write method

Description

The adduseCase method adds the specified use case to the current package.

Visual Basic
Syntax

addUseCase (name As String) As RPUseCase

Arguments

name

The name of the use case to add

Return Value
The use case added to this package
C/C++ Prototype

HRESULT addUseCase (BSTR name, IRPUseCase** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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addUseCaseDiagram
Write method

Description

The addUseCaseDiagram method adds the specified UCD to the current package.
Visual Basic
Syntax

addUseCaseDiagram (name As String) As RPUseCaseDiagram

Arguments

name

The name of the UCD to add

Return Value
The UCD added to this package
C/C++ Prototype

HRESULT addUseCaseDiagram (BSTR name,
IRPUseCaseDiagram** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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deleteActor

Write method

Description

The deleteActor method del etes the specified actor from the current package.

Visual Basic
Syntax

deleteActor (actor As RPActor)
Arguments

actor

The actor to delete

C/C++ Prototype

HRESULT deleteActor (IRPActor *actor)

Return Value

HRESULT (O for success, or asigned integer error code)
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deleteClass
Write method

Description

The deleteClass method deletes the specified class from the current package.

Visual Basic
Syntax
deleteClass (theClass As RPClass)
Arguments
theClass

The class to delete

C/C++ Prototype

HRESULT deleteClass (IRPClass *theClass)

Return Value

HRESULT (O for success, or asigned integer error code)
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deleteCollaborationDiagram
Write method

Description

The deleteCollaborationDiagram method deletes the specified collaboration diagram from the
current package.

Visual Basic
Syntax

deleteCollaborationDiagram (name As String)

Arguments

name

The name of the collaboration diagram to delete

C/C++ Prototype

HRESULT deleteCollaborationDiagram (BSTR name)

Return Value

HRESULT (O for success, or asigned integer error code)
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deleteComponentDiagram
Write method

Description

The deleteComponentDiagram method deletes the specified component diagram from the
current package.

Visual Basic
Syntax

deleteComponentDiagram (name As String)

Arguments

name

The name of the component diagram to delete

C/C++ Prototype

HRESULT deleteComponentDiagram (BSTR name)

Return Value

HRESULT (O for success, or asigned integer error code)
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deleteDeploymentDiagram
Write method

Description

The deleteDeploymentDiagram method deletes the specified deployment diagram from the
current package.

Visual Basic
Syntax

deleteDeploymentDiagram (name As String)

Arguments

name

The name of the deployment diagram to delete

C/C++ Prototype

HRESULT deleteDeploymentDiagram (BSTR name)

Return Value

HRESULT (O for success, or asigned integer error code)
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deleteEvent
Write method

Description

The deleteEvent method del etes the specified event from the current package.
Visual Basic
Syntax

deleteEvent (event As RPEvent)

Arguments

event

The event to delete

C/C++ Prototype

HRESULT deleteEvent (IRPEvent *event)

Return Value

HRESULT (O for success, or asigned integer error code)
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deleteFlowltems
Write method

Description

The deleteFlowltems method deletes the specified flowltem from the flowltems collection.
Visual Basic
Syntax

deleteFlowItems (pItem As RPFlowItem)

Arguments

pItem

The name of the flowItem to remove from the collection

C/C++ Prototype

HRESULT deleteFlowItems (IRPFlowItem* pItem)

Return Value

HRESULT (O for success, or asigned integer error code)
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deleteFlows
Write method

Description

The deleteFlows method deletes the specified flow from the flows collection.
Visual Basic
Syntax

deleteFlows (pFlow As RPFlow)

Arguments

pFlow

The name of the flow to delete from the collection

C/C++ Prototype

HRESULT deleteFlows (IRPFlow* pFlow)

Return Value

HRESULT (O for success, or asigned integer error code)
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deleteGlobalFunction
Write method

Description

The deleteGlobalFunction method deletes the specified global function from the current
package.

Visual Basic
Syntax

deleteGlobalFunction (operation As RPOperation)

Arguments

operation

The global function to delete

C/C++ Prototype

HRESULT deleteGlobalFunction (IRPOperation* operation)

Return Value

HRESULT (O for success, or asigned integer error code)
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deleteGlobalObject
Write method

Description

The deleteGlobalObject method deletes the specified global object from the current package.
Visual Basic
Syntax

deleteGlobalObject (relation As RPRelation)

Arguments

relation

The global object to delete

C/C++ Prototype

HRESULT deleteGlobalObject (IRPRelation* relation)

Return Value

HRESULT (O for success, or asigned integer error code)
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deleteGlobalVariable
Write method

Description

The deleteGlobalVariable method deletes the specified global variable from the current
package.

Visual Basic
Syntax

deleteGlobalVariable (attribute As RPAttribute)

Arguments

attribute

The global variable to delete

C/C++ Prototype

HRESULT deleteGlobalVariable (IRPAttribute* attribute)

Return Value

HRESULT (O for success, or asigned integer error code)
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deleteNode
Write method

Description
The deleteNode method deletes the specified node from the current package.
Visual Basic
Syntax
deleteNode (name As String)
Arguments

name

The name of the node to delete

C/C++ Prototype

HRESULT deleteNode (BSTR name)

Return Value

HRESULT (O for success, or asigned integer error code)
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deleteObjectModelDiagram

Write method

Description

The deleteObjectModelDiagram method del etes the specified OMD from the current package.

Visual Basic
Syntax

deleteObjectModelDiagram (name As String)

Arguments

name

The name of the OMD to delete

C/C++ Prototype

HRESULT deleteObjectModelDiagram (BSTR name)

Return Value

HRESULT (O for success, or asigned integer error code)
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deletePackage
Write method

Description
The deletePackage method deletes the current package.
Visual Basic
Syntax
deletePackage ()
C/C++ Prototype

HRESULT deletePackage ()

Return Value

HRESULT (O for success, or asigned integer error code)
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deleteSequenceDiagram
Write method

Description

The deleteSequenceDiagram method deletes the specified sequence diagram from the current
package.

Visual Basic
Syntax

deleteSequenceDiagram (name As String)

Arguments

name

The name of the sequence diagram to delete

C/C++ Prototype

HRESULT deleteSequenceDiagram (BSTR name)

Return Value

HRESULT (O for success, or asigned integer error code)
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deleteType
Write method

Description

The deleteType method del etes the specified type from the current package.
Visual Basic
Syntax

deleteType (type As RPType)

Arguments

type
The type to delete

C/C++ Prototype

HRESULT deleteType (IRPType *type)

Return Value

HRESULT (O for success, or asigned integer error code)
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deleteUseCase

Write method

Description

The deleteUseCase method del etes the specified use case from the current package.

Visual Basic
Syntax

deleteUseCase (useCase As RPUseCasge)

Arguments

useCase

The use case to delete

C/C++ Prototype

HRESULT deleteUseCase (IRPUseCase *useCase)

Return Value

HRESULT (O for success, or asigned integer error code)
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deleteUseCaseDiagram
Write method

Description

The deleteUseCaseDiagram Mmethod deletes the specified use case diagram from the current
package.

Visual Basic

Syntax
deleteUseCaseDiagram (name As String)

Arguments

name

The name of the UCD to delete

C/C++ Prototype

HRESULT deleteUseCaseDiagram (BSTR name)

Return Value

HRESULT (O for success, or asigned integer error code)
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findActor
Read method

Description

The findActor method retrieves the specified actor, if it belongs to the current package.
Visual Basic
Syntax

findActor (name As String) As RPActor

Arguments

name

The name of the actor to find

Return Value
If found, the RPAct or ; otherwise, NULL.
C/C++ Prototype

HRESULT findActor (BSTR name, IRPActor** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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findAlIByName
Read method

Description

ThefindAllIByName method searches all the e ements and finds the first element of the
specified name and metaclass in the current package.

Visual Basic
Syntax

findAl1ByName (name As String, metaClass As String)
As RPModelElement

Arguments

name
The name of the element to find
metaclass

The name of the metaclass to find

Return Value

Thefirst RPMbdel El enent that matches the specified name and metaclass, or NULL if not
found

C/C++ Prototype

HRESULT findAllByName (BSTR name, BSTR metaClass,
IRPModelElement** pvVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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findClass
Read method

Description

ThefindClass method retrieves the specified class, if it belongsto the current package.
Visual Basic
Syntax

findClass (name As String) As RPClass

Arguments

name

The name of the class to find

Return Value
TheRPd ass, or NULL if not found
C/C++ Prototype

HRESULT findClass (BSTR name, IRPClass** pVal)

Return Value
HRESULT (O for success, or asigned integer error code)
findEvent
Read method
Description
ThefindEvent method retrieves the specified event, if it belongs to the current package.
Visual Basic
Syntax

findEvent (name As String) As RPEvent

Arguments

name

The name of the event to find
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Return Value
The RPEvent *, or NULL if not found

C/C++ Prototype

HRESULT findEvent (BSTR name, IRPEvent** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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findGlobalFunction

Read method

Description

ThefindGlobalFunction method retrieves the specified global function, if it belongs to the

current package.
Visual Basic
Syntax

findGlobalFunction (name As String) As RPOperation

Arguments

name

The name of the global function to find

Return Value
The RPQper at i on, or NULL if not found
C/C++ Prototype

HRESULT findGlobalFunction (BSTR name,
IRPOperation** pval)

Return Value

HRESULT (O for success, or asigned integer error code)
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findGlobalObject
Read method

Description

ThefindGlobalObject method retrieves the specified global object, if it belongs to the current
package.

Visual Basic
Syntax

findGlobalObject (name As String) As RPRelation

Arguments

name

The name of the global object to find

Return Value
The RPRel at i on, or NULL if not found
C/C++ Prototype

HRESULT findGlobalObject (BSTR name, IRPRelation** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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findGlobalVariable

Read method

Description

ThefindGlobalVariable method retrieves the specified global variable, if it belongsto the

current package.
Visual Basic
Syntax

findGlobalVariable (name As String) As RPAttribute

Arguments

name

The name of the global variable to look for

Return Value
TheRPAt t ri but e, or NULL if not found
C/C++ Prototype

HRESULT findGlobalVariable (BSTR name,
IRPAttribute** pval)

Return Value

HRESULT (O for success, or asigned integer error code)
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findNode
Read method

Description

The findNode method retrieves the specified node, if it belongs to the current package.
Visual Basic
Syntax

findNode (name As String) As RPNode

Arguments

name

The name of the node to look for

Return Value
The RPNode, or NULL if not found
C/C++ Prototype

HRESULT findNode (BSTR name, IRPNode** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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findType
Read method

Description

ThefindType method retrieves the specified data type, if it belongs to the current package.
Visual Basic
Syntax

findType (name As String) As RPType

Arguments

name

The name of the type to find

Return Value
The RPType, or NULL if not found
C/C++ Prototype

HRESULT findType (BSTR name, IRPType** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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findUsage
Read method

Description

The findUsage method retrieves the usage of the specified element in the current package.
Visual Basic
Syntax

findUsage (objToFind As IRPModelElement) As RPCollection

Arguments

objToFind

The model element to look for in the current package

Return Value
The collection of model elements that reference obj ToFi nd in this package
C/C++ Prototype

HRESULT findUsage (IRPModelElement* objToFind,
IRPCollection** pVval)

Return Value

HRESULT (O for success, or asigned integer error code)
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findUseCase

Read method

Description

The findUseCase method retrieves the specified use case, if it belongs to the current package.

Visual Basic
Syntax

findUseCase (name As String) As RPUseCase

Arguments

name

The name of the use case to find

Return Value
The RPUseCase, or NULL if not found
C/C++ Prototype

HRESULT findUseCase (BSTR name, IRPUseCase** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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recalculateEventsBaseld
Write method

Description

The recalculateEventsBaseld method recal cul ates the events base 1D of the package.
Visual Basic
Syntax

recalculateEventsBaseId() As Long

Return Value
The events base ID
C/C++ Prototype

HRESULT recalculateEventsBaseId (long *success)

Return Value

HRESULT (O for success, or asigned integer error code)
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IRPPort Interface

The | RPPor t interface represents a Rhapsody port. It inherits from | RPI nst ance.
See the User Guide for detailed information on ports.

VB Properties

Name Type Access Description

contract RPd ass RW Specifies the port contract.

isBehavioral Long RW Determines whether
messages sent to the port
are relayed to the owner
class.

isReversed Long RW If this is equal to 1 (as
opposed to 0), the
provided interfaces
become the required
interfaces, and the
required interfaces
become the provided
interfaces.

providedinterfaces Collection of RO The collection of provided
RPCl asses interfaces for the port.

requiredi nterfaces Collection of RO The collection of required
RPCl asses interfaces for the port.

Method Summary

addProvidedInterface Adds the specified interface to the
collection of provided interfaces

addRequiredInterface Adds the specified interface to the
collection of required interfaces

removeProvidedinterface Removes the specified interface from
the collection of provided interfaces

removeRequiredinterface Removes the specified interface from
the collection of required interfaces

Example

The following script converts a black-box analysis block to awhite-box analysis block, and
viceversa. It simply toggles all the ports of a block to behavioral or non-behavioral.
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Public Sub ConvertPortsBB()
Dim curBlock As RPBlock
Dim port As RPPort

Set curBlock = getSelectedElement

For Each port In curBlock.ObjectAsObjectType.ports
port.isBehavioral = 1

Next

End Sub

Public Sub ConvertPortsWB ()
Dim curBlock As RPBlock
Dim port As RPPort

Set curBlock = getSelectedElement

For Each port In curBlock.ObjectAsObjectType.ports
port.isBehavioral = 0

Next

End Sub
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addProvidedInterface
Write method

Description

The addProvidedinterface method adds the specified interface to the collection of provided
interfaces.

Visual Basic
Syntax

addProvidedInterface (newVal As RPClass)
Arguments

newVal

The name of the class to add to the collection of provided interfaces
for the port

C/C++ Prototype

HRESULT addProvidedInterface (IRPClass* newVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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addRequiredInterface
Write method

Description

The addRequiredinterface method adds the specified interface to the collection of required
interfaces.

Visual Basic
Syntax

addRequiredInterface (newVal As RPClass)
Arguments

newVal

The name of the class to add to the collection of required interfaces
for the port

C/C++ Prototype

HRESULT addRequiredInterface (IRPClass* newVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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removeProvidedinterface
Write method

Description

The removeProvidedinterface method removes the specified interface from the collection of
provided interfaces.

Visual Basic
Syntax

removeProvidedInterface (newVal As RPClass)
Arguments

newVal

The name of the class to remove from the collection of provided
interfaces for the port

C/C++ Prototype

HRESULT removeProvidedInterface (IRPClass* newVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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removeRequiredinterface
Write method

Description

The removeRequiredinterface method removes the specified interface from the collection of
required interfaces.

Visual Basic
Syntax

removeRequiredInterface (newVal As RPClass)
Arguments

newVal

The name of the class to remove from the collection of provided
interfaces for the port

C/C++ Prototype

HRESULT removeRequiredInterface (IRPClass* newVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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IRPProfile Interface

Thel RPPr of i | e interface represents a profile. It inherits from | RPPackage.

See the User Guide for detailed information on profiles and tags.

IRPProject Interface

Thel RPPr oj ect interface represents a Rhapsody project (model). Use the

Appl i cati on. openProj ect () method to obtain a handle to the project. Thel RPPr oj ect

object isa singleton instance that aggregates all other instances. This class inherits from

| RPPackage.

Pr oj ect isaconcrete interface that inherits from | RPPackage.

VB Properties
Name Type Access Description
activeComponent RPConponent RW The active component in
the package.
activeConfiguration RPConf i gur ati on RW The active configuration in
the active component.
The setting must be to a
configuration from the
active component,
otherwise an error is
flagged.
all Stereotypes Collection of RO A collection of all the
RPSt er eot ypes stereotypes used in the
current project.
components Collection of RO A collection of all the
RPConponent s components used in this
project.
defaultDirectoryScheme String RW The default directory
scheme.
profiles Collection of RO The collection of profiles
RPProfi | es used in this project.

Method Summary

addComponent

Adds the specified component to the
current project

addPackage

Adds the specified package to the
current project
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addProfile

Adds the specified profile to the
current project

checkEventsBaseldsSolveCollisions

Checks the values of the events base
IDs for all packages in the model,
detects collisions between the IDs,
and resolves any incorrect values and
collisions

close

Closes the current project

deleteComponent

Deletes the specified component from
the current project

findComponent

Retrieves the specified component
from the current project

GenerateReport

Generates a ReporterPLUS report for
the model.

getNewCollaboration

Retrieves the new collaboration for the
current project

highlightFromCode

Takes a filename and line number as
arguments and then highlights in the
Rhapsody browser the element that is
associated with the line of code
specified.

importPackageFromRose

Imports the specified package from
Rational Rose

importProjectFromRose

Imports the specified project from
Rational Rose

recalculateEventsBaselds

Recalculates the events base IDs
used by Rhapsody 6.1

save

Saves the current project

saveAs

Saves the current project to the
specified file name and location

setActiveComponent

Sets the active configuration for the
current project

setActiveConfiguration

Sets the active configuration for the
current project
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addComponent

Write method

Description

The addComponent method adds the specified component to the current project.

Visual Basic
Syntax

addComponent (name As String) As RPComponent

Arguments

name

The name of the component to add

Return Value
The RPConponent added to the current project
C/C++ Prototype

HRESULT addComponent (BSTR name,
IRPComponent** component)

Return Value

HRESULT (O for success, or asigned integer error code)
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addPackage
Write method

Description

The addPackage method adds the specified package to the current project.
Visual Basic
Syntax

addPackage (name As String) As RPPackage

Arguments

name

The name of the package to add

Return Value
The RPPackage* added to this project
C/C++ Prototype

HRESULT addPackage (BSTR name, IRPPackage** package)

Return Value

HRESULT (O for success, or asigned integer error code)
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addProfile

Write method

Description

The addProfile method adds the specified profile to the current project.

Visual Basic
Syntax

addProfile (name As String) As RPProfile

Arguments

name

The name of the profile to add

Return Value
The RPPr of i | e added to this project
C/C++ Prototype

HRESULT addProfile (BSTR name, IRPProfile** profile)

Return Value

HRESULT (O for success, or asigned integer error code)
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checkEventsBaseldsSolveCollisions
Read method

Description

The checkEventsBaseldsSolveCollisions method checks the values of the events base IDs for
all packagesin the model, detects collisions between the IDs, and resolves any incorrect
values and collisions.

Visual Basic
Syntax

checkEventsBaseIdsSolveCollisions ()

C/C++ Prototype

HRESULT checkEventsBasgseIdsSolveCollisions ()

Return Value

HRESULT (O for success, or asigned integer error code)

Rhapsody 417



Rhapsody API Interfaces

close
Read method

Description
The close method closes the current project.

Note that helper applications might not close the current document. Therefore, you should not
use close in aVBA macro that you specify as a helper.

Visual Basic
Syntax

close ()

C/C++ Prototype

HRESULT close()

Return Value

HRESULT (O for success, or asigned integer error code)
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deleteComponent
Write method

Description

The deleteComponent method del etes the specified component from the current project.

Visual Basic
Syntax

deleteComponent (component As RPComponent)
Arguments

component

The component to delete

C/C++ Prototype

HRESULT deleteComponent (IRPComponent* component)

Return Value

HRESULT (O for success, or asigned integer error code)
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findComponent

Read method

Description

The findComponent method retrieves the specified component from the current project.

Visual Basic
Syntax

findComponent (name As String) As RPComponent

Arguments

name

The name of the component to find

Return Value
The RPConponent , or NULL if not found
C/C++ Prototype

HRESULT findComponent (BSTR name, IRPComponent** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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GenerateReport

GenerateReport (modelscope As String, templatename As String, docType As
String, filename As String, showDocument As Long, silentMode As Long)
Allows you to generate a ReporterPLUS report for the model. (When this method is used to

generate areport, the Rhapsody model is saved before the report is generated.)

model scope—the name of the package for which the report should be generated. If empty, areport
is generated for the entire model. (Thisis similar to the "scope’ command-line option for
ReporterPLUS.)

templatename—the name of the template to use. If empty, then the ReporterPLUS report
generation wizard will be launched and it will display the name of the last template used.

docType—the type of output to generate (doc, html, ppt, txt). If empty, the ReporterPLUS report
generation wizard will be launched and it will display the last output type used.

filename—the filename to use for the generated report. If empty, the ReporterPLUS report
generation wizard will be displayed and it will display the filename of the last generated report.

showDocument—In general, the user will be asked if they want to view the report after generation
only if they have requested this by selecting View > Options > Ask to open after generating report
from the main menu in ReporterPLUS. However, if the user has specified silent generation mode
using the parameter silentM ode, this parameter can be used to request that the generated document
be displayed. To display the report, set this parameter to 1, otherwise use 0.

silentM ode—If the template name, document type, or output file name has not been specified
using the appropriate parameter, the ReporterPLUS report generation wizard is displayed so the
user can provide the missing information. Thisisthe behavior if this parameter is set to 0. If you
want to prevent the wizard from being launched in such cases, you can specify silent generation
mode by setting this parameter to 1. If set to silent mode, no report will be generated if one or more
of the above parameters was not provided. (The report generation status dialog is displayed
regardless of the value of this parameter.)

Sample code:

Dim proj As RPProject
Set proj = getProject

proj.GenerateReport "", "C:\Rhapsody\reporterplus\Templates\Class.tpl",
"html", "C:\testreport.html", 0, O
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getNewCollaboration

Read method

Description

The getNewCollaboration method returns the new collaboration for the current project.

Visual Basic
Syntax

getNewCollaboration () As RPCollaboration

Return Value
The RPCol | abor ati on
C/C++ Prototype

HRESULT getNewCollaboration (
IRPCollaboration** collaboration)

Return Value

HRESULT (O for success, or asigned integer error code)
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highlightFromCode

The method nighlightFromcode takes afilename and line number as arguments and then
highlights in the Rhapsody browser the element that is associated with the line of code
specified.

The filename argument should consist of the absolute path for thefile.

Syntax

highlightFromCode (filename As String, lineNumber As Long) As RPModelElement

Example

Dim proj As RPProject
Dim m As RPModelElement
Set proj = getProject

Set m =
proj.highlightFromCode ("C:\Temp\P\DefaultComponent\DefaultConfig\C.cpp", 30)
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importPackageFromRose
Write method

Description

The importPackageFromRose method imports the specified package from Rational Rose into
Rhapsody 6.1.

Visual Basic
Syntax

importPackageFromRose (projectName As String,
packageName As String, logFileName As String)

Arguments

projectName
The name of the project
packageName
The name of the package
logFileName

The name of the log file

C/C++ Prototype

importPackageFromRose (BSTR projectName,
BSTR packageName, BSTR logFileName)

Return Value

HRESULT (O for success, or asigned integer error code)
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importProjectFromRose
Write method

Description

The importProjectFromRose method imports the specified project from Rational Rose into
Rhapsody 6.1.

Visual Basic
Syntax

importProjectFromRose (projectName As String,
logFileName As String)

Arguments
projectName
The name of the project

logFileName

The name of the log file

C/C++ Prototype

HRESULT importProjectFromRose (BSTR projectName,
BSTR logFileName)

Return Value

HRESULT (O for success, or asigned integer error code)
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recalculateEventsBaselds
Write method

Description

TherecalculateEventsBaselds method recal cul ates the events base I Ds used by the project.
Visual Basic
Syntax

recalculateEventsBaseIds ()

C/C++ Prototype

HRESULT recalculateEventsBaseIds ()

Return Value

HRESULT (O for success, or asigned integer error code)
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save
Read method

Description
The save method saves the current project.
Note: This method flags an error if one occurs.
Visual Basic
Syntax

save ()

C/C++ Prototype

HRESULT save ()

Return Value

HRESULT (O for success, or asigned integer error code)
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saveAs
Read method

Description
The saveAs method saves the current project to the specified file name and location.
Note: This method flags an error if one occurs.
Visual Basic
Syntax

saveAs (filename As String)

Arguments

filename

The name of the file to which to save the project

C/C++ Prototype

HRESULT saveAs (BSTR filename)

Return Value

HRESULT (O for success, or asigned integer error code)
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setActiveComponent
Write method

Description

The setActiveComponent method sets the active component for the current project.

Note: This method flags an error if one occurs.
Visual Basic
Syntax
setActiveComponent (name As String)
Arguments

name

The name of the active component

C/C++ Prototype

HRESULT setActiveComponent (BSTR name)

Return Value

HRESULT (O for success, or asigned integer error code)
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setActiveConfiguration

Write method

Description

The setActiveConfiguration method sets the active configuration for the current project.

Visual Basic
Syntax

setActiveConfiguration (name As String)

Arguments

name

The name of the active configuration

C/C++ Prototype

HRESULT setActiveConfiguration (BSTR name)

Return Value

HRESULT (O for success, or asigned integer error code)
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IRPRelation Interface

Thel RPRel at i on interface represents a relationship between two classes (of Cl ass and
ot her d ass). It inheritsfrom | RPUni t .

VB Properties

Name

Type

Access

Description

inverse

RPRel ati on

RO

If the relation is symmetric,
this is a pointer to the peer
relation.

isNavigable

Long

RW

A flag indicating whether
the relation is navigable.

iSSymmetric

Long

RO

A flag indicating whether
the relation is bidirectional.

If this is equal to 1, the
Navigability property is set
as navigable for both
ends.

If this is equal to 0, the
navigability of the inverse
RPRelation is set to None.

multiplicity

String

RW

The multiplicity of the
relation.

ObjectAsObjectType

RPC ass

RO

If this relation is a
Rhapsody in C object, it is
returned as a class.

An object (in RIiC) plays
two roles: as an instance
of some class and the
class itself. When you get
an object (say by querying
the package owning it), it
comes “wearing” the

| RPRel at i on “hat.” If
you want to use it as a
class (obj ect _type)
invoke this method on it
and the return value is the
same object “wearing” the
| RPCl ass “hat.”

ofClass

RPCl assi fi er

RW

The source class of the
relation.

otherClass

RPCl assi fi er

RW

The target class of the
relation.

qualifier

String

RW

The qualifier of the
relation, if one exists.
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Name Type Access Description

relationL abel String RW The link name given to the
relation.

relationLinkName String RW The name of the relation
link

relationRoleName String RW The name of role of the
participating elements in
the relation.

A relation consists of two
designations: a role name
and a relation name. For
example, two people can
be in a relation called
“marriage” (relation name)
with each person
designated by their role
within the marriage as
“spouse” (role name). For
| RPRel at i on objects,
the relation name is
mapped to the

| RPMVbdel El ermrent
property name and the
property

rel ati onRol eName is
provided for the relation’s
role name.

relationType String RW The relation type
(Association, Aggregation,
or Composition).

visibility String RW The visibility of the relation
(Public, Protected, or
Private).

Method Summary

isTypelessObject Tests an object to see if it is defined explicitly or
implicitly
makeUnidirect Changes the current relation from a unidirectional

(symmetric) one to one that is directional from the ne
of this relation to me’s inverse

setinverse Adds or updates the inverse relation

isTypelessObject
Read method
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Description

TheisTypelessObject method tests an object to seeif it is defined explicitly (“object of type
X") or implicitly (“typeless’ or “unique”).

Visual Basic
Syntax

isTypelessObject () As Long

Return Value
1if therelation is typeless; otherwise 0
C/C++ Prototype

HRESULT isTypelessObject (long *pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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makeUnidirect
Write method

Description

The makeUnidirect method changes the current relation from a unidirectional (symmetric) one
to onethat is directional from the me of thisrelation to me’sinverse.

Visual Basic
Syntax

makeUnidirect ()

C/C++ Prototype

HRESULT makeUnidirect ()

Return Value

HRESULT (O for success, or asigned integer error code)
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setlnverse
Write method

Description

The setinverse method adds or updates the inverse relation. It provides ameans for turning a
unidirectional relation into a symmetric one.

Visual Basic
Syntax

setInverse (roleName As String, linkType As String)
Arguments

roleName
The role name for the relation
linkType

The type of link (unidirectional or symmetric)

C/C++ Prototype

HRESULT setInverse (BSTR roleName, BSTR 1linkType)

Return Value

HRESULT (O for success, or asigned integer error code)
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IRPRequirement Interface

Thel RPRequi r ement interface represents a Rhapsody requirement. It inherits from
| RPAnnot at i on.

See the User Guide for detailed information on requirements and other annotations.

IRPSequenceDiagram Interface

Thel RPSequenceDi agr aminterface represents a sequence diagram. It inherits from
| RPDi agr am

Method Summary

getlLogicalCollaboration Retrieves the logic behind the collaboration
diagram

getRelatedUseCases Retrieves use cases related to the current
sequence diagram

getLogicalCollaboration
Read method

Description

The getLogicalCollaboration method retrieves the logic behind the collaboration diagram.

Visual Basic

Syntax

getLogicalCollaboration() As RPCollaboration

Return Value
The collaboration diagram

C/C++ Prototype

HRESULT getLogicalCollaboration (
IRPCollaboration** collaboration)

Return Value

HRESULT (O for success, or asigned integer error code)
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getRelatedUseCases
Read method

Description

The getRelatedUseCases method retrieves use cases related to the current sequence diagram.
Visual Basic
Syntax

getRelatedUseCases () As RPCollection

Return Value
A collection of use cases related to this sequence diagram
C/C++ Prototype

HRESULT getRelatedUseCases (IRPCollection** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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IRPState Interface

The| RPSt at e interface represents a state in a statechart. It inheritsfrom | RPSt at eVer t ex.

VB Properties
Name Type Access Description

defaultTransition RPTransi ti on* RO The default transition of
this state, if there is one.

entryAction String RW The actions executed
when this state is entered.

exitAction String RW The actions executed
when this state is exited.

isOverridden Long RO If this is equal to 1 (as
opposed to 0), the state is
overridden.
Currently, this property has
not been implemented.

isReferenceActivity | Long RO If this is equal to 1 (as
opposed to 0), the state is
an activity reference.

itsStateChart RPSt at eChart RO The statechart of this
state.

itsSwimlane RPSwi m ane RW The swimlane of this state.
Currently, this property has
not been implemented.

nestedStateChart RPSt at eChart RO The statechart nested
inside of this state.

referenceToActivity | RPMbdel El enent RW The referenced activity or
activity diagram.
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Name Type

Access Description

stateType String

RW The type of this state. The
possible values are as
follows:

* Or—state that
contains no concurrent
states

* And—state that
contains two or more
concurrent states

e LocalTermination
—termination state
element

* Block—action block
element

¢ Action—action
element

* SubActivity—
subactivity element

* ObjectFlow—object
node element

* ReferenceActivit
y—call behavior
element

* CallOperation—
call operation element

* EventState—send
action element

subStateVertices
RPSt at eVert ex

RPCol | ecti on of

RO A collection of transitions
and states that connect to
this state.

Method Summary

addConnector

Adds a connector to the statechart

addState

Adds a state to the statechart

addStaticReaction

Adds a static reaction to the statechart

addTerminationState

Adds a termination state to the statechart

createDefaultTransition

Creates a default transition in the
statechart

createNestedStatechart

Creates a nested statechart

deleteConnector

Deletes the specified connector from the
statechart

deleteStaticReaction

Deletes the specified static reaction from
the statechart
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getFullNamelnStatechart Returns the full text name of this state
within its statecharts

getinheritsFrom Returns the base state from which the
current state inherits

getlLogicalStates Retrieves the list of logical states

getStaticReactions Returns a collection of static reaction
transitions originating from the current
state

getSubStates Returns a collection of substates
belonging to the current state

isAnd Determines whether this state is an And
state

isCompound Determines whether the current state is a
compound state

islL eaf Determines whether the current state is a
leaf state

isRoot Determines whether the current state is a
root state

overridelnheritance Overrides inheritance for the current state

resetEntryActioninheritance Resets the inheritance of the entry action
of the current state

resetExitActioninheritance Resets the inheritance of the exit action of
the current state

setStaticReaction Sets the static reaction for the current
state

unoverridelnheritance Removes the override on inheritance for
this state

addConnector
Write method
Description

The addConnector method adds a connector to the current state.
Visual Basic
Syntax

addConnector (type As String) As RPConnector
Arguments
type

The connector type. The possible values are as follows:

Condition
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Fork
History
Join

Termination

Return Value
The new connector

C/C++ Prototype

HRESULT addConnector (BSTR type,
IRPConnector** connector)

Return Value

HRESULT (O for success, or asigned integer error code)
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addState

Write method
Description

The addState method adds a new state to the statechart.
Visual Basic
Syntax

addState (name As String) As RPState

Arguments

name

The name of the new state

Return Value
The new state added to the statechart
C/C++ Prototype

HRESULT addState (BSTR name, IRPState** state)

Return Value

HRESULT (O for success, or asigned integer error code)
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addStaticReaction
Write method

Description

The addStaticReaction method adds a static reaction to the state.

Visual Basic
Syntax

addStaticReaction (trigger As RPInterfacelItem)
As RPTransition

Arguments

trigger

The trigger to add to the statechart

Return Value
The new static reaction
C/C++ Prototype

HRESULT addStaticReaction (IRPInterfacelItem* trigger,
IRPTransition** pval)

Return Value

HRESULT (O for success, or asigned integer error code)
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addTerminationState

Write method

Description

The addTerminationState method adds a termination state to the statechart.

Visual Basic
Syntax

addTerminationState () As RPState

Return Value
The new termination state
C/C++ Prototype

HRESULT addTerminationState (IRPState** state)

Return Value

HRESULT (O for success, or asigned integer error code)
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createDefaultTransition
Write method

Description

The createDefaultTransition method creates a default transition.

Visual Basic
Syntax

createDefaultTransition (from As RPState) As RPTransition

Arguments

from

The default state to which the default transition points

Return Value
The default transition
C/C++ Prototype

HRESULT createDefaultTransition (IRPState* from,
IRPTransition** transition)

Return Value

HRESULT (O for success, or asigned integer error code)

Rhapsody 445



Rhapsody API Interfaces

createNestedStatechart
Write method

Description

The createNestedStatechart method creates a nested statechart (substatechart).
Visual Basic
Syntax

createNestedStatechart () As RPStatechart

Return Value
The nested statechart
C/C++ Prototype

HRESULT createNestedStatechart (IRPStatechart** pval)

Return Value

HRESULT (O for success, or asigned integer error code)
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deleteConnector
Write method

Description

The deleteConnector method del etes the specified connector from the statechart.
Visual Basic
Syntax

deleteConnector (connector As RPConnector)

Arguments

connector

The connector to delete

C/C++ Prototype

HRESULT deleteConnector (IRPConnector* connector)

Return Value

HRESULT (O for success, or asigned integer error code)
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deleteStaticReaction
Write method

Description

The deleteStaticReaction method del etes the specified static reaction.

Visual Basic
Syntax

deleteStaticReaction (pVal As RPTransition)

Argument

pVal

The static reaction to delete

C/C++ Prototype

HRESULT deleteStaticReaction (IRPTransition *pVal)

Return Value

HRESULT (O for success, or asigned integer error code)

entryAction
Write method

Description

The entryAction method specifies an entry action for the state.

Visual Basic
Syntax

entryAction (body As String)

Arguments

body

The entry action

C/C++ Prototype

HRESULT entryAction (BSTR body)
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Return Value
HRESULT (O for success, or asigned integer error code)
exitAction
Write method
Description
The exitAction method defines an exit action for the state.
Visual Basic
Syntax

exitAction (body As String)

Arguments

body

The exit action

C/C++ Prototype

HRESULT exitAction (BSTR body)

Return Value
HRESULT (O for success, or asigned integer error code)
getFullNamelnStatechart
Read method
Description

The getFullNamelnStatechart method returns the full text name of this state within its
statecharts.

Dot notation is used to indicate statechart nesting. For example, if statechart Cisin statechart
B, which isin statechart A, the full text name of the C statechart is A. B. C.

Visual Basic
Syntax

getFullNameInStatechart () As String
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Return Value
The full textual name of a state within its statecharts

C/C++ Prototype

HRESULT getFullNameInStatechart (BSTR* pVal)

Return Value
HRESULT (O for success, or asigned integer error code)
getinheritsFrom
Read method
Description
The getinheritsFrom method returns the base state from which the current state inherits.
Visual Basic
Syntax

getInheritsFrom() As RPState

Return Value
The base state that this state inherits from

C/C++ Prototype

HRESULT getInheritsFrom (IRPState** pval)

Return Value
HRESULT (O for success, or asigned integer error code)
getLogicalStates
Read method
Description
The getLoagicalStates method retrieves the list of logical states.
Visual Basic
Syntax

getLogicalStates () As RPCollection
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Return Value
Thelist of logical states
C/C++ Prototype

HRESULT getLogicalStates (IRPCollection** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)

getStaticReactions
Read method

Description

The getStaticReactions method returns a collection of static reaction transitions originating
from the current state.

Given atransition with atrigger T, guard condition G and static reactions A, if T occursand Gis
true, the static reactions (also known as reactions in state) are executed while the object is il
initsorigina state.

Visual Basic
Syntax

getStaticReactions () As RPCollection

Return Value
A collection of the static reaction transitions originating from the current state
C/C++ Prototype

HRESULT getStaticReactions (IRPCollection** pVal)

Return Value
HRESULT (O for success, or asigned integer error code)
getSubStates
Read method
Description

The getSubStates method returns a collection of substates belonging to the current state.
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Typically, this method retrieves the state members of a state (“substates’), unless the state
contains a nested statechart. In this case, to see the substates, you must descend further into the
nested statechart.

Visual Basic
Syntax

getSubStates () As RPCollection

Return Value
A collection of nested substates belonging to this state
C/C++ Prototype

HRESULT getSubStates (IRPCollection** pVal)

Return Value
HRESULT (O for success, or asigned integer error code)
isAnd
Read method
Description
TheisAnd method determines whether this state is an And state.
Visual Basic
Syntax

isAnd () As Long

Return Value
1if this stateis an And state; otherwise O
C/C++ Prototype

HRESULT isAnd (long* pVal)

Return Value

HRESULT (O for success, or asigned integer error code)

isCompound
Read method
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Description

TheisCompound method determines whether the current state is a compound state.
Visual Basic
Syntax

isCompound () As Long

Return Value
1if this state is a compound state; otherwise 0
C/C++ Prototype

HRESULT isCompound (long* pVal)

Return Value
HRESULT (O for success, or asigned integer error code)
isLeaf
Read method
Description
The jsLeaf method determines whether the current state is aleaf state.
Visual Basic
Syntax

isLeaf () As Long

Return Value
1if thisstateis aleaf state; otherwise 0
C/C++ Prototype

HRESULT isLeaf (long* pVal)

Return Value

HRESULT (O for success, or asigned integer error code)

isRoot
Read method
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Description

TheisRoot method determines whether the current stateis aroot state.
Visual Basic
Syntax

isRoot () As Long

Return Value
1if this stateis aroot state; otherwise O
C/C++ Prototype

HRESULT isRoot (long* pVal)

Return Value

HRESULT (O for success, or asigned integer error code)

overridelnheritance

Note
Currently, this method has not been implemented.

Write method
Description

The overridelnheritance method overrides inheritance for the current state.

Visual Basic
Syntax
overrideInheritance ()
C/C++ Prototype
HRESULT overrideInheritance ()

Return Value

HRESULT (O for success, or asigned integer error code)
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resetEntryActioninheritance
Write method

Description

TheresetEntryActioninheritance method resets the inheritance of the entry action of the current
state.

Visual Basic
Syntax

resetEntryActionInheritance () As RPState

Return Value
The updated state
C/C++ Prototype

HRESULT resetEntryActionInheritance (IRPState** pvVal)

Return Value

HRESULT (O for success, or asigned integer error code)

resetExitActioninheritance
Write method

Description

The resetExitActioninheritance method resets the inheritance of the exit action for the current
State.

Visual Basic
Syntax

resetExitActionInheritance () As RPState

Return Value
The updated state
C/C++ Prototype

HRESULT resetExitActionInheritance (IRPState** pVal)
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Return Value

HRESULT (O for success, or asigned integer error code)

setStaticReaction
Write method

Description

The setStaticReaction method sets the static reaction for the current state.
Visual Basic
Syntax

setStaticReaction (trigvVal As String, guardvVal As
String, actionVal As String)

Arguments
trigval
The new value for the trigger
guardval
The new value for the guard

actionval

The new value for the action

C/C++ Prototype

HRESULT setStaticReaction (BSTR trigVal, BSTR guardval,
BSTR actionval)

Return Value

HRESULT (O for success, or asigned integer error code)

unoverridelnheritance

Note
Currently, this method has not been implemented.

Write method
Description

The unoverridelnheritance method removes the override on inheritance for the current state.
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Visual Basic
Syntax

unoverrideInheritance ()

C/C++ Prototype

HRESULT unoverrideInheritance ()

Return Value

HRESULT (O for success, or asigned integer error code)
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stateType
Read method

Description
The stateType method specifies the state type of the current state.
Visual Basic
Syntax
stateType (type As String)
Arguments

type

The state type. The possible values are as follows:
+ or—state that contains no concurrent states

+ ang—Sstate that contains two or more concurrent states

®  LocalTermination—termination state el ement

¢ Block—action block element

¢ Action—action element

¢ subActivity—subactivity element

¢  objectFlow—o0bject node element

¢ ReferenceActivity—call behavior element

¢ Ccalloperation—Ccall operation element

* EventState—sSend action element
C/C++ Prototype

HRESULT stateType (BSTR pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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IRPStatechart Interface

Thel RPSt at echart interface represents a statechart diagram. It inherits from | RPDi agr am

Note: You cannot create a statechart using the APIs. The statechart must already exist
for you to usethe APIson it.

VB Properties

Name

Type

Access Description

isOverridden

Long

RO If this is equal to 1 (as
opposed to 0), the state is
overridden.

Currently, this property has
not been implemented.

itsClass

RPd ass

RO The class of this
statechart.

rootState

RPSt at e

RO The default (starting) state
of this statechart.

Method Summary

createGraphics

Creates graphics in the Rhapsody statechart

deleteState

Deletes the specified state from the Rhapsody
statechart

findTrigger Determines whether the current statechart has a
trigger for the specified class interface element
getAllTriggers Returns a collection of all the triggers for the

current statechart

getinheritsFrom

Returns a pointer to the base statechart from which
the current statechart inherits

overridelnheritance

Overrides inheritance for the current state

unoverridelnheritance

Removes the override on inheritance for the current
state
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createGraphics
Write method

Description

The createGraphics method creates graphics in the Rhapsody 6.1 statechart using the
information in the COM APl methods.

Visual Basic

Syntax
createGraphics ()

C/C++ Prototype

HRESULT createGraphics ()

Return Value

HRESULT (O for success, or asigned integer error code)
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deleteState
Write method

Description

The deleteState method del etes the specified state from the statechart.
Visual Basic
Syntax

deleteState (state As RPState)

Arguments

state

The state to delete

C/C++ Prototype

HRESULT deleteState (IRPState* state)

Return Value

HRESULT (O for success, or asigned integer error code)
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findTrigger
Read method

Description

ThefindTrigger method determines whether the current statechart has atrigger for the
specified class interface element.

Visual Basic
Syntax

findTrigger (item As RPInterfaceltem) As Long

Arguments

item
The state to check

Return Value
1if this statechart has atrigger; otherwise O
C/C++ Prototype

HRESULT findTrigger (IRPInterfacelItem* item, long *pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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getAllTriggers
Read method

Description

The getAllTriggers method returns a collection of all the triggers for the current statechart.
Visual Basic
Syntax

getAllTriggers () As RPCollection

Return Value
A collection of all thetriggers (RPI nt er f acel t ens) for this statechart
C/C++ Prototype

HRESULT getAllTriggers (IRPCollection** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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getinheritsFrom

Read method

Description

The getinheritsFrom method returns a pointer to the base statechart from which the current

statechart inherits.
Visual Basic
Syntax

getInheritsFrom() As RPStatechart

Return Value
The base statechart from which this statechart inherits
C/C++ Prototype

HRESULT getInheritsFrom (IRPStatechart** pval)

Return Value

HRESULT (O for success, or asigned integer error code)
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overridelnheritance

Note
Currently, this method has not been implemented.

Write method
Description

The overridelnheritance method overrides inheritance for the current state.

Visual Basic

Syntax
overrideInheritance ()

C/C++ Prototype

HRESULT overrideInheritance ()

Return Value

HRESULT (O for success, or asigned integer error code)
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unoverridelnheritance

Note
Currently, this method has not been implemented.

Write method
Description

The unoverridelnheritance method removes the override on inheritance for the current state.

Visual Basic

Syntax
unoverrideInheritance ()

C/C++ Prototype

HRESULT unoverrideInheritance ()

Return Value

HRESULT (O for success, or asigned integer error code)
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IRPStateVertex Interface

Thel RPSt at eVer t ex interface represents all model elements that can be connectors or
states. It is an abstract interface that inherits from | RPMbdel El enent .

VB Properties
Name Type Access Description
parent RPSt at e RW The parent state or
connector
Method Summary
addTransition Creates a transition
deleteTransition Deletes a transition
getinTransitions Returns a collection of transitions that are directed into

the current state or connector

getOutTransitions Returns a collection of transitions that are directed out
of the current state or connector

addTransition
Write method

Description
The addTransition method creates a transition.
Visual Basic
Syntax
addTransition (to As RPStateVertex) As RPTransition
Arguments

to

The “to” state for the transition

Return Value

The new transition
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C/C++ Prototype

HRESULT addTransition (IRPStateVertex *to,
IRPTransition** transition)

Return Value
HRESULT (O for success, or asigned integer error code)
deleteTransition
Write method
Description
The deleteTransition method deletes the specified transition.
Visual Basic
Syntax

deleteTransition (transition As RPTransition)

Arguments

transition

The transition to delete

C/C++ Prototype

HRESULT deleteTransition (IRPTransition *transition)

Return Value
HRESULT (O for success, or asigned integer error code)
getinTransitions
Read method
Description

ThegetinTransitions method returns a collection of transitionsthat are directed into the current
state or connector.

Visual Basic
Syntax

getInTransitions () As RPCollection
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Return Value
A collection of transitions going into this state or connector

C/C++ Prototype

HRESULT getInTransitions (IRPCollection** pVval)

Return Value

HRESULT (O for success, or asigned integer error code)
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getOutTransitions
Read method

Description

The getOutTransitions method returns a collection of transitions that are directed out of the
current state or connector.

Visual Basic
Syntax

getOutTransitions () As RPCollection

Return Value
A collection of transitions going out of this state or connector
C/C++ Prototype

HRESULT getOutTransitions (IRPCollection** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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parent
Read method

Description

The parent method returns the parent state.
Visual Basic
Syntax

parent (newVal As RPState)

Arguments

newVal

The parent state

C/C++ Prototype

HRESULT parent (IRPState* newVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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IRPStereotype Interface

Thel RPSt er eot ype interface represents a stereotype in the model. It inherits from
| RPModel El enment .

VB Properties
Name Type Access Description
icon String RO The icon string attached to
the stereotype
ofMetaClass String RO The metaclass to which
the stereotype applies

IRPStructureDiagram Interface

Thel RPSt r uct ur eDi agr aminterface represents a Rhapsody structure diagram. It inherits
from | RPDi agr am

See he User Guide for detailed information on structure diagrams.

IRPSwimlane Interface

Thel RPSwi ml ane interface represents a swimlane in an activity diagram. It inherits from
| RPMbdel El enent .

VB Properties
Name Type Access Description
contents RPCol | ecti on RO A collection of states in the
swimlane
represents RPModel El enent RW The object that
implements the swimlane
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IRPTag Interface

Thel RPTag interface represents atag. It inheritsfrom | RPVari abl e.

VB Properties
Name Type Access Description
tagMetaClass String RW The metaclass for the tag
value String RW The default value for the
tag

IRPTemplatelnstantiation Interface

Thel RPTenpl at el nst ant i at i on interface represents aglobal variable in a Rhapsody
model. It inherits from | RPMbdel El enent .

VB Properties
Name Type Access Description
templatel nstantiationParameters | Collection of RO A collection of parameters

RPTenpl at e used for instantiation
Instantiation
Par anet ers
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IRPTemplatelnstantiationParameter Interface

Thel RPTenpl at el nst anti ati onPar anet er interface represents a parameter used in
template instantiation in a Rhapsody model. It inherits from the | RPMbdel El enent .

VB Properties
Name Type Access Description
argValue String RW The argument value for this
parameter of a template
instantiation

IRPTemplateParameter Interface

Thel RPTenpl at ePar anet er interface represents a parameter for atemplate in a Rhapsody
model. It inheritsfrom | RPVari abl e.

VB Properties
Name Type Access Description
typeName RPType RW The type of this template
parameter

Method Summary

setClassType

Sets or changes the current template parameter to a
class type parameter
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setClassType
Write method

Description

The setClassType method sets or changes the current template parameter to a class type
parameter. For example, parameter <i nt X> becomes<cl ass X>.

Visual Basic
Syntax

setClassType ()

C/C++ Prototype

HRESULT setClassType ()

Return Value

HRESULT (O for success, or asigned integer error code)
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IRPTransition Interface

Thel RPTr ansi ti on interface represents atransition in a statechart. It inherits from
| RPModel El enment .

VB Properties

Name

Type

Access

Description

isOverridden

Long

RO

If this is equal to 1 (as

opposed to 0), the
transition is overridden.

Currently, this property
has not been
implemented.

itsLabel

RO The transition label for
this transition.

itsSource

RPSt at eVert ex RW

The source state of this
transition.

itsStateChart

RPSt at echart RW

The statechart of this
transition.

itsTarget

RPSt at eVert ex RW

The target state of this
transition.

Method Summary

getinheritsFrom

Returns the base transition from which the current
transition inherits

etltsAction

Returns the action code of the current transition

getltsGuard Returns the guard condition of the current transition

getltsTrigger Returns the trigger (event or triggered operation) of
the current transition

getOfState Returns the source state for which this transition is

the default transition

isDefaultTransition

Determines whether the current transition is a
default transition

isStaticReaction

Determines whether this is a static reaction

itsCompoundSource

Returns a collection of states that act as multiple
sources for this single transition

overridelnheritance

Overrides inheritance for the current transition

resetlabellnheritance

Resets the label inheritance

setltsAction

Updates the current transition with a new action
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setltsGuard Updates the current transition with a new guard

setltsl abel Updates this transition with a new label
(trigger[guard]/action)

setltsTrigger Updates the current transition with a new trigger

unoverridelnheritance Removes the override on inheritance for the current
transition

getinheritsFrom
Read method

Description

The getinheritsFrom method returns the base transition from which the current transition
inherits.

Visual Basic
Syntax

getInheritsFrom() As RPTransition

Return Value
The base transition from which this transition inherits
C/C++ Prototype

HRESULT getInheritsFrom (IRPTransition** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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getltsAction

Read method

Description

The getltsAction method returns the action code of the current transition.

Visual Basic
Syntax

getItsAction() As RPAction

Return Value
The action code of thistransition
C/C++ Prototype

HRESULT getItsAction (IRPAction** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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getltsGuard
Read method

Description

The getltsGuard method returns the guard condition of the current transition.
Visual Basic
Syntax

getItsGuard() As RPGuard

Return Value
The guard condition of thistransition
C/C++ Prototype

HRESULT getItsGuard (IRPGuard** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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getltsTrigger
Read method

Description

The getltsTrigger method returns the trigger (event or triggered operation) of the current
transition.

Visual Basic
Syntax

getItsTrigger () As RPTrigger

Return Value
Thetrigger of thistransition
C/C++ Prototype

HRESULT getItsTrigger (IRPTrigger** pVal)

Return Value
HRESULT (O for success, or asigned integer error code)
Example

The following macro checks each transition to seeiif it has atrigger.

Sub checkNullTransitions ()
Dim elem As RPModelElement
For Each elem In getProject.getNestedElementsRecursive

If elem.metaClass = "Transition" Then
Dim trans As RPTransition
Set trans = elem
If trans.getItsTrigger Is Nothing Then
Debug.Print "The trigger in transition '" +
trans.getFullPathName + "' is null!"
End If

End If

Next elem

End Sub
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getOfState
Read method

Description

The getOfState method returns the source state for which this transition is the default
transition.

Suppose you want to figure out what event sequences lead to a state A. One way to retrieve
those valuesisto travel backwards from A, looking for all the transitions going into it. If they
are normal transitions, you can continue to their source. If they are default transitions, you
must find the parent using the method get Of St at e.

Visual Basic
Syntax
getOfState () As RPState

Return Value

The parent state for which thistransition isthe default transition. If thistransition is the default
transition of its statechart, this method returns the parent; otherwise, it returnsa NULL value.

C/C++ Prototype

HRESULT getOfState (IRPState** pvVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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isDefaultTransition
Read method

Description

The isDefaultTransition method determines whether the current transition is a default
transition.

Visual Basic
Syntax

isDefaultTransition() As Long

Return Value
1if thistransition is a default transition; otherwise O
C/C++ Prototype

HRESULT isDefaultTransition (long *pVal)

Return Value
HRESULT (O for success, or asigned integer error code)
isStaticReaction
Read method
Description
TheissStaticReaction method determines whether thisis a static reaction.
Visual Basic
Syntax

isStaticReaction() As Long

Return Value
1if thisis a static reaction; otherwise 0
C/C++ Prototype

HRESULT isStaticReaction (long *pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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itsCompoundSource
Read method

Description

The itsCompoundSource method returns a collection of states that act as multiple sources for
this single transition.

For example, consider ajunction connector. There can be many transitions from different
states that are resolved into one transition leaving a junction connector. For the transition
leaving a junction connector, this method gives all the source states.

Visual Basic
Syntax

itsCompoundSource () As RPCollection

Return Value

A collection of source states (RPSt at eVer t exes) for thistransition
C/C++ Prototype

HRESULT itsCompoundSource (IRPCollection** pvVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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overridelnheritance

Note
Currently, this method has not been implemented.

Write method
Description

The overridelnheritance method overrides inheritance for the current transition.

Visual Basic

Syntax
overrideInheritance ()

C/C++ Prototype

HRESULT overrideInheritance ()

Return Value

HRESULT (O for success, or asigned integer error code)
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resetLabellnheritance
Write method

Description

TheresetLabellnheritance method resets the label inheritance.

Visual Basic
Syntax

resetLabelInheritance () As RPTransition

Return Value
The updated RPTr ansi ti on
C/C++ Prototype

HRESULT resetLabelInheritance (IRPTransition** pVal)

Return Value
HRESULT (O for success, or asigned integer error code)
setltsAction
Write method
Description
The setltsAction method updates the current transition with anew action.
Visual Basic
Syntax

setItsAction (action As String) As RPAction

Return Value
The new action for the transition
C/C++ Prototype

HRESULT setItsAction (BSTR action, IRPAction** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)

Rhapsody 485



Rhapsody API Interfaces

setltsGuard
Write method

Description
The setitsGuard method updates the current transition with a new guard.
Visual Basic
Syntax
setItsGuard() As RPGuard
Return Value
The new guard for this transition
C/C++ Prototype
HRESULT setItsGuard (BSTR guard, IRPGuard** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)

setltsLabel
Write method

Description

The setitsLabel method updates this transition with a new label (trigger[guard]/action)
Visual Basic
Syntax

setItsLabel (trigger As String, guard As String,
action As String)

Arguments

trigger

The new trigger value for this transition
guard

The new guard value for this transition
action

The new action value for this transition
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C/C++ Prototype

HRESULT setItsLabel (BSTR trigger, BSTR guard,
BSTR action)

Return Value
HRESULT (O for success, or asigned integer error code)
setltsTrigger
Write method
Description
The setltsTrigger method updates the current transition with a new trigger.
Visual Basic
Syntax

setItsTrigger (trigger As String) As RPTrigger

Return Value
The new trigger for thistransition
C/C++ Prototype

HRESULT setItsTrigger (BSTR trigger, IRPTrigger** pVal)

Return Value

HRESULT (O for success, or asigned integer error code)

unoverridelnheritance

Note

Currently, this method has not been implemented.

Write method
Description

The unoverridelnheritance method removes the override on inheritance for the current
transition.
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Visual Basic
Syntax

unoverrideInheritance ()

C/C++ Prototype

HRESULT unoverrideInheritance ()

Return Value

HRESULT (O for success, or asigned integer error code)
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IRPTrigger Interface

Thel RPTri gger interface represents atrigger of atransition in a statechart. It inherits from
| RPModel El enment .

VB Properties

Name Type Access Description

body String RW The body of this trigger

Method Summary

getltsOperation Returns the event or triggered operation of the current
trigger
isOperation Determines whether the current trigger is an operation

(event or triggered operation)

isTimeout Determines whether the current trigger is a timeout

getltsOperation
Read method

Description
The getitsOperation method returns the event or triggered operation of the current trigger.

If the current trigger’stransition is labeled E[ C] / A (where E is the event (event or triggered
operation) the trigger refersto, Cisthe guard condition, and A is the action), this method
returns the event E to which this trigger refers.

Visual Basic
Syntax

getItsOperation() As RPInterfaceltem

Return Value
The operation of this trigger
C/C++ Prototype

HRESULT getItsOperation (IRPInterfaceltem** pvVal)
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Return Value

HRESULT (O for success, or asigned integer error code)

isOperation

Read method

Description

TheisOperation method determines whether the current trigger is an operation (event or

triggered operation).
Visual Basic
Syntax

isOperation() As Long

Return Value
1if thistrigger is an operation; otherwise O
C/C++ Prototype

HRESULT isOperation (long* pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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isTimeout
Read method

Description

The jsTimeout method determines whether the current trigger is a timeout.
Visual Basic
Syntax

isTimeout () As Long

Return Value
1if thistrigger is atimeout; otherwise O
C/C++ Prototype

HRESULT isTimeout (long* pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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IRPType Interface

The | RPType interface represents Rhapsody 6.1 data types. It inheritsfrom | RPCl assi fi er.

VB Properties

Name Type Access Description

declaration String RW The type declaration.

enumerationLiterals Collection of RO A container that can be
RPEnuner ati on manipulated only if the
Literal s kind of the type is
Enuner at ed

isPredefined Long RO A flag that indicates
whether this type is a
Rhapsody predefined
types. Predefined types
are defined in the package
unit files:

Shar e\ Properti es\
Pr edef i ned<l ang>.
sbs

isTypedef Long RO A flag that indicates
whether this type is
defined with at ypedef

isTypedef Constant Long RW A flag that indicates
whether the t ypedef is
defined as a constant (is
read-only, such as the
const qualifier in C++)

isTypedefOrdered Long RW A flag that indicated
whether the order of the
reference type items is
significant

isTypedefReference Long RW A flag that indicates
whether the t ypedef is
referenced as a reference
(such as a pointer (*) or an
address (&) in C++)

kind String RW Stores the type kind.

typedefBaseType RPC assi fier RW Specifies the basic type of
the t ypedef

typedefMultiplicity String RW Specifies the multiplicity of
the t ypedef
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Method Summary

addEnumerationLiteral

Creates an enumeration literal

isArray Determines whether the current type is an array

ISEnum Determines whether the current type is an
enumerated type

isEqualTo Tests for equality between the type of the type and
the type itself

isimplicit Determines whether the current type is an implicit

type

isKindEnumeration

Determines whether the current type is an
enumeration

isKindLanguage

Determines whether the current type is a language
declaration type

isKindStructure

Determines whether the current type is a structure

isKindTypedef

Determines whether the current type is a
t ypedef

isKindUnion

Determines whether the current type is a union

isPointer

Determines whether the current type is a pointer

isPointerToPointer

Determines whether the current type is a pointer to
another pointer

isReference

Determines whether the current type is a reference

isReferenceToPointer

Determines whether the current type is a reference
to a pointer

isStruct Determines whether the current type is a St r uct
isTemplate Determines whether the current type is a template
isUnion Determines whether the current type is a union

Rhapsody
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addEnumerationLiteral

Write method

Description

The addEnumerationLiteral method creates an enumeration literal.

Visual Basic
Syntax

addEnumerationLiteral (name As String)
As RPEnumerationLiteral

Arguments

name

The name of the enumeration literal to create

Return Value
The new enumeration litera
C/C++ Prototype

HRESULT addEnumerationLiteral (BSTR name,
IRPEnumerationLiteral** pval)

Return Value

HRESULT (O for success, or asigned integer error code)
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iSArray
Read method

Description

The isArray method determines whether the current typeis an array.
Visual Basic
Syntax

isArray () As Long

Return Value
1if thetypeisan array; O otherwise
C/C++ Prototype

HRESULT isArray (long* pVal)

Return Value
HRESULT (O for success, or asigned integer error code)
ISEnum
Read method
Description

TheisEnum method determines whether the current type is an enumerated type.

Visual Basic
Syntax

isEnum() As Long

Return Value
1if thetypeisan array; O otherwise
C/C++ Prototype

HRESULT isEnum (long* pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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isEqualTo

Read method
Description

The isEqualTo method tests for equality between the type of the type and the type itself.
Visual Basic
Syntax

isEqualTo() As Long
Return Value
The method returns 1 if the “type of the type” is equal to the type depended on, otherwise 0.

For example, if the type definitionist ypedef x, thetypeisequal to the typeit depends on.
However, if the type definitionist ypedef x*, thetype of the typeisapointer, andis
therefore different from the type itself.

C/C++ Prototype

HRESULT isEqualTo (long* pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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isimplicit
Read method
Description
The isimplicit method determines whether the current type is an implicit type.
Visual Basic
Syntax
isImplicit () As Long

Return Value
1if thetypeisanimplicit type; O otherwise
C/C++ Prototype

HRESULT isImplicit (long* pVal)

Return Value

HRESULT (O for success, or asigned integer error code)

isKindEnumeration
Read method

Description

TheisKindEnumeration method determines whether the current type is an enumeration.

Visual Basic
Syntax

isKindEnumeration() As Long

Return Value
1if the type is an enumeration; O otherwise
C/C++ Prototype

HRESULT isKindEnumeration (long* pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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isKindLanguage

Read method

Description

TheisKindLanguage method determines whether the current type is a language declaration

type.
Visual Basic
Syntax

isKindLanguage () As Long

Return Value
1if the type is alanguage declaration type; O otherwise
C/C++ Prototype

HRESULT isKindLanguage (long* pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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isKindStructure
Read method

Description

TheisKindsStructure method determines whether the current type is a structure.
Visual Basic
Syntax

isKindStructure () As Long

Return Value
1if the type isastructure; O otherwise
C/C++ Prototype

HRESULT isKindStructure (long* pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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isKindTypedef

Read method

Description

The iskindTypedef method determines whether the current typeisat ypedef .

Visual Basic
Syntax

isKindTypedef () As Long

Return Value
lif thetypeisat ypedef ; O otherwise
C/C++ Prototype

HRESULT isKindTypedef (long* pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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isKindUnion
Read method

Description

TheisKindUnion method determines whether the current typeisaunion.
Visual Basic
Syntax

isKindUnion () As Long

Return Value
1if thetypeisaunion; O otherwise
C/C++ Prototype

HRESULT isKindUnion (long* pVal)

Return Value
HRESULT (O for success, or asigned integer error code)
isPointer
Read method
Description
TheisPointer method determines whether the current type is a pointer.
Visual Basic
Syntax

isPointer () As Long

Return Value
1if thetypeisapointer; O otherwise
C/C++ Prototype

HRESULT isPointer (long* pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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isPointerToPointer

Read method

Description

TheisPointerToPointer method determines whether the current type is a pointer to another

pointer.
Visual Basic
Syntax

isPointerToPointer () As Long

Return Value
1if thetypeisapointer to a pointer; 0 otherwise
C/C++ Prototype

HRESULT isPointerToPointer (long* pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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isReference
Read method

Description

TheisReference method determines whether the current type is areference.
Visual Basic
Syntax

isReference () As Long

Return Value
1if thetypeisareference; O otherwise
C/C++ Prototype

HRESULT isReference (long* pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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isReferenceToPointer

Read method

Description

TheisReferenceToPointer method determines whether the current typeis areferenceto a

pointer.
Visual Basic
Syntax

isReferenceToPointer () As Long

Return Value
1if thistypeis areferenceto a pointer; otherwise 0
C/C++ Prototype

HRESULT isReferenceToPointer (long* pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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isStruct
Read method

Description

The jsstruct method determines whether the current typeisast r uct .
Visual Basic
Syntax

isStruct () As Long

Return Value
lif thistypeisastruct ; otherwise 0
C/C++ Prototype

HRESULT isStruct (long* pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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isTemplate

Write method

Description

TheisTemplate method determines whether the current type is a template.

Visual Basic
Syntax

isTemplate () As Long

Return Value
1if thistypeis atemplate; otherwise O
C/C++ Prototype

HRESULT isTemplate (long* pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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isUnion
Write method

Description

TheisUnion method determines whether the current typeis a union.

Visual Basic
Syntax

isUnion () As Long

Return Value
1if thistypeisaunion; otherwise 0
C/C++ Prototype

HRESULT isUnion (long* pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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IRPUnNiIt Interface

Thel RPUNi t interface represents all model elements that can be stored as units for
configuration management (CM) purposes. It is an abstract interface that inherits from

| RPMbdel El enent .

VB Properties
Name Type Access Description
CMHeader String RW The CM header of this unit
currentDirectory String RO The current directory
filename String RW The name of the file that
stores the unit
includel nNextLoad Long RW Indicates whether or not
the unit should be loaded
the next time the model is
loaded.
isStub Long RO Specifies whether this is a
stub
structureDiagrams Collection of RO Collection of structure
RPSt ruct ure diagrams that can be
Di agrans stored as units

Method Summary

isReadOnly

Determines whether the current unit is read-only

isSeparateSaveUnit

Determines whether the current unit is saved in its own
(separate) file

load Loads the specified unit
save Saves the specified unit
setReadOnly Specifies whether the current unit is read-only

setSeparateSaveUnit

Sets a unit to be stored to its own file
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isReadOnly
Read method

Description

The jsReadOnly method determines whether the current unit is read-only.
Visual Basic
Syntax

isReadOnly () As Long

Return Value
1if thisunit is read-only; otherwise O
C/C++ Prototype

HRESULT isReadOnly (long* pVal)

Return Value
HRESULT (O for success, or asigned integer error code)
isSeparateSaveUnit
Read method
Description

The isSeparateSaveUnit method determines whether the current unit is saved in itsown
(separate) file.

Visual Basic
Syntax

isSeparateUnit () As Long

Return Value
1if thisunit is saved to its own file; otherwise 0
C/C++ Prototype

HRESULT isSeparateSaveUnit (long* pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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load
Write method

Description

The load method |oads the specified unit.
Visual Basic
Syntax

load (withSubs As Long) As RPUnit

Argument

withSubs

Set this to 1 to load the unit’s subunits. Otherwise, set this to 0.

Return Value
The loaded unit
C/C++ Prototype

HRESULT load (long withSubs, IRPUnit** ret)

Return Value

HRESULT (O for success, or asigned integer error code)
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save
Read method

Description

The save method saves the current unit.
Visual Basic
Syntax

save (withSubs As Long)

Argument

withSubs

Set this to 1 to load the unit’s subunits. Otherwise, set this to 0.

C/C++ Prototype
HRESULT save (long withSubs)
Return Value
HRESULT (O for success, or asigned integer error code)
setReadOnly
Write method
Description
The setReadOnly method specifies whether the current unit is read-only.
Visual Basic
Syntax
setReadOnly (pVal As Long)
Arguments

pvVal

Set this argument to 1 to make the unit read-only; set it to 0 to make
the unit read/write.

C/C++ Prototype

HRESULT setReadOnly (long pVal)
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Return Value
HRESULT (O for success, or asigned integer error code)
setSeparateSaveUnit
Write method
Description
The setSeparateSaveUnit method sets a unit to be stored to its own file.
Visual Basic
Syntax
setSeparateSaveUnit (pVal As Long)
Arguments

pval

Set this argument to 1 to have the unit stored to its own file.
Otherwise, set it to 0.

C/C++ Prototype

HRESULT setSeparateSaveUnit (long pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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IRPUseCase Interface

The | RPUseCase interface represents a Rhapsody use case. It inheritsfrom | RPCl assi fi er.

VB Properties
Name Type Access Description
describingDiagrams | Collection of RO A collection of
RPSequenceDi agr am sequence

diagrams that
describe this use
case

entryPoints Collection of strings RO A collection of

entry points into
this use case

extensi onPoints RPCol | ecti on RO A collection of

extension points

Method Summary

addDescribingDiagram

Adds a describing diagram for the current use
case

addExtensionPoint

Adds an extension point to the current use case

deleteDescribingDiagram

Deletes the describing use case or sequence
diagram for the current use case

deleteEntryPoint

Deletes the entry point of the current use case

deleteExtensionPoint

Deletes the specified extension point

findEntryPoint

Deletes the specified entry point

findExtensionPoint

Retrieves the extension point, given the
generalization

getDescribingDiagram

Retrieves the use case diagram or sequence
diagram linked to the current use case
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addDescribingDiagram
Write method

Description

The addDescribingDiagram method adds a describing diagram for the current use case.

Visual Basic
Syntax

addDescribingDiagram (diagram As RPDiagram)

Arguments

diagram

The name for the new, describing diagram

C/C++ Prototype

HRESULT addDescribingDiagram (IRPDiagram* diagram)

Return Value
HRESULT (O for success, or asigned integer error code)
addExtensionPoint
Write method
Description
The addExtensionPoint method adds an extension point to the current use case.
Visual Basic
Syntax

addExtensionPoint (entryPoint As String)

Arguments

entryPoint

The name of the new entry point

C/C++ Prototype

HRESULT addExtensionPoint (BSTR entryPoint)
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Return Value
HRESULT (O for success, or asigned integer error code)
deleteDescribingDiagram
Write method
Description

The deleteDescribingDiagram method del etes the describing use case or sequence diagram for
the current use case.

Visual Basic
Syntax

deleteDescribingDiagram (diagram As RPDiagram)

Arguments

diagram

The use case or sequence diagram that describes the current use case

C/C++ Prototype

HRESULT deleteDescribingDiagram (IRPDiagram* diagram)

Return Value

HRESULT (O for success, or asigned integer error code)
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deleteEntryPoint
Write method

Description

The deleteEntryPoint method deletes the entry point of the current use case.
Visual Basic
Syntax

deleteEntryPoint (entryPoint As String)

Arguments

entryPoint

The name of the entry point to delete

C/C++ Prototype

HRESULT deleteEntryPoint (BSTR entryPoint)

Return Value

HRESULT (O for success, or asigned integer error code)

deleteExtensionPoint
Write method

Description

The deleteExtensionPoint method del etes the specified extension point.

Visual Basic
Syntax

deleteExtensionPoint (point As String)

Arguments

entryPoint

The extension point to delete

C/C++ Prototype

HRESULT deleteExtensionPoint (BSTR entrypoint)
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Return Value

HRESULT (O for success, or asigned integer error code)

findEntryPoint
Read method

The findEntryPoint method returns the specified entry point of the current use case, given the
generalization.

Visual Basic
Syntax

findEntryPoint (gen As RPGeneralization) As String
Arguments
gen
The generalization
Return Value
The entry point

C/C++ Prototype

HRESULT findEntryPoint (IRPGeneralization* gen,
BSTR *pVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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findExtensionPoint
Read method

The findExtensionPoint method returns the specified extension point of the current use case,
given the generalization.

Visual Basic
Syntax

findExtensionPoint (gen As RPGeneralization) As String
Arguments

gen

The generalization

Return Value

The extension point
C/C++ Prototype

HRESULT findExtensionPoint (IRPGeneralization* gen,
BSTR *pVal)

Return Value
HRESULT (O for success, or asigned integer error code)
getDescribingDiagram
Read method
Description

The getDescribingDiagram method retrieves the use case diagram or sequence diagram linked
to the current use case.

Visual Basic
Syntax

getDescribingDiagram (name As String) As RPDiagram
Arguments

name

The name of the use case diagram or sequence diagram that is linked
(for descriptive purposes) to the current use case
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Return Value
The diagram of the specified use case

C/C++ Prototype

HRESULT getDescribingDiagram (BSTR name,
IRPDiagram** diagram)

Return Value

HRESULT (O for success, or asigned integer error code)
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IRPUseCaseDiagram Interface

Thel RPUseCaseDi agr aminterface represents a use case diagram. It inherits from
| RPDi agr am

Currently, it does not expose additional functionality to | RPDi agr am

IRPVariable Interface

Thel RPVari abl e interface represents a variable in a Rhapsody 6.1 model. It represents the
UML TypedEl enent .

| RPVar i abl e inheritsfrom | RPModel El enment .

VB Properties
Name Type Access Description
declaration String RW The declaration statement
for the variable
defaultValue String RW The default value for the
variable
type RPCl assi fier RW The data type of the
variable
typeOf RPType RW The variable’s type
Method Summary
setTypeDeclaration Updates the type declaration for the current attribute
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setTypeDeclaration
Write method

Description

The setTypeDeclaration method updates the type declaration for the current attribute.
Visual Basic
Syntax

setTypeDeclaration (newVal As String)

Arguments

newVal

The type declaration for this attribute

C/C++ Prototype

HRESULT setTypeDeclaration (BSTR newVal)

Return Value

HRESULT (O for success, or asigned integer error code)
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The Calback API consists of anumber of methods that can be used to respond to events that occur
in Rhapsody. This response can consist of actions taken by an external application and/or
preventing Rhapsody from proceeding with a specific action.

Callback API Introduction

The Callback API isimplemented as anumber of COM connection point interfaces. These callback
methods can be used by:

¢ client applications using the Rhapsody COM or Java APIs, in the following languages:
- VB
- VBA
— C++
— Java
¢ client plug-ins to Rhapsody
For the methods that have boolean return values, the client application can return avalue of False

in order to prevent Rhapsody from proceeding with the action connected to the event, for example,
preventing a diagram from being opened.

Clients can receive event notification by registering the corresponding COM connection point
interface using the standard COM mechanism.

Multiple clients can register for any given callback, however, there is no guarantee that the clients
will be notified in a specific order.

In cases where multiple clients have registered, if one client responds by cancelling the associated
Rhapsody action, the remaining clients will not be notified of the event.

Rhapsody can log all callbacks invoked. For Rhapsody actions that can be cancelled by clients, it
also logs the action taken. For details on enabling logging, see Callback Logging.
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Callback notification can be disabled completely, or for specific interfaces by adding appropriate
entriesto the rhapsody.ini file. For details on complete or partial disabling of callback notification,
see Disabling Callback Notification.

When callback notification is enabled, you have the option of disabling the ability of aclient
application to prevent Rhapsody from proceeding with an action. This can be done for all
cancellable actions or just for specific cancellable actions. For details, see Disabling Cancellable
Actions.

Events with Callback Methods

The Rhapsody API includes callback methods for the following Rhapsody events:

¢ project about to be closed

¢ project closed

+ feature dialog about to be opened

¢ diagram about to be opened

¢ Rhapsody about to perform roundtrip
¢ code generation completed

Note

These events can only be responded to by using the Rhapsody API. They are not available
astriggersin the Helpers dialog (Tools > Customize).

API Details

IRPApplicationListener

BeforeProjectClose
BOCL Bef or eProj ect O ose(| RPProj ect Project)

Thisis called before a project is closed. The argument is the project that is to be closed.
If aclient returns False, then the project will not be closed.
Points to take into consideration:

+ If aclient returns False to prevent the closing of the project, other clients that have
registered will not be notified of the event.
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+ When multiple projects areto be closed, the method is called separately for each project. If

aclient prevents the closing of a specific project, this does not affect the calling of the
method for the remaining projects.

AfterProjectClose
voi d AfterProjectC ose(BSTR Proj ect Nane)

Thisis caled after Rhapsody closesa project. The argument is the name of the project that was
closed.

Points to take into consideration:

+*  When multiple projects are closed, the method is called separately for each project.
+ Thismethod is not available for VBA clients. (Thisis because the VBA application is part
of the Rhapsody project so it cannot be run after the project is closed.)
OnDiagramOpen
BOCOL OnDi agr anOpen( | RPDi agr am Di agr am

Thisis called before adiagram is opened. The argument is the diagram that Rhapsody is about to
open.

If aclient returns False, then the diagram will not be opened.

Points to take into consideration:

+ |f aclient returns False to prevent the opening of the diagram, other clients that have
registered will not be notified of the event.

+ Themethodisonly called when adiagram is explicitly opened using the Rhapsody GUI or

the Rhapsody API. It isnot called when a diagram is opened as part of the restoration of
the previous Rhapsody workspace.
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OnFeaturesOpen
BOOL OnFeat ur esOpen( | RPModel El emrent Mbdel El enent)

Thisis caled before the Features dialog is opened for a given element. The argument is the model
element for which the Features dialog is going to be opened.

If aclient returns False, then the Features dialog will not be opened for the element.

Points to take into consideration:

+ [If aclient returns False to prevent the opening of the Features dialog, other clients that
have registered will not be notified of the event.

+ Themethod isonly called when the Features dialog is explicitly opened using the
Rhapsody GUI or the Rhapsody API. It is not called when the Features dialog is opened
as part of the restoration of the previous Rhapsody workspace.
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IRPRoundTripListener

BeforeRoundtrip
voi d Bef oreRoundtrip(lRPCollection fil eNanes)

Thisis caled before source code files are roundtripped into the model.

The argument consists of the files that are going to be roundtripped into the model.

IRPCodeGeneratorListener

CodeGenerationCompleted
voi d CodeGener ati onConpl et ed()

Thisis called after code generation has been compl eted.
Points to take into consideration:
¢ Clients should not modify generated code files in the framework of the callback method.

Thiswill result in timestamp inconsistency in the model-generated code, creating
potentia problems.
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Callback Logging

By default, Rhapsody does not maintain alog file of callback events. To enablelogging of callback
events and cancellable actions, add the entry Enabl eCal | backLoggi ng to a section caled
[ Cal | back] intherhapsody.ini file and set it to TRUE.

If you enable logging, the events and actions will be logged to afile called callback log.txt in the
system temporary directory.

Disabling Callback Notification

Callback functionality can be disabled completely, or for specific interfaces by adding one or more
of the following entriesto a section called [ cal | back] in the rhapsody.ini file:

To disable the callback mechanism for project closing, opening diagrams, and opening the
Features dialog, add the entry Enabl eAppl i cat i onEvent Li st eni ng and set it to FALSE. Rhapsody
will not notify registered clients of these events.

To disable the callback mechanism for roundtripping, add the entry
Enabl eRoundTri pEvent Li st eni ng and set it to FALSE. Rhapsody will not notify registered clients
of roundtripping events.

To disable the callback mechanism for code generation, add the entry
Enabl eCodeGener at i onEvent Li st eni ng and set it to FALSE. Rhapsody will not notify registered
clients of code generation events.

To disable the callback mechanism completely, add the entry Enabl eEvent Li st eni ng and set it to
FALSE. Rhapsody will not notify registered clients of any of the callback events.

Disabling Cancellable Actions

When callback notification is enabled, you can disable the ability of aclient application to prevent
Rhapsody from proceeding with an action by adding one or more of the following entriesto a
section called [ cal | back] in the rhapsody.ini file:

To disable the ability to prevent Rhapsody from closing a project, add the entry
CanCancel Proj ect d ose and set it to FALSE.

To disable the ability to prevent Rhapsody from opening a diagram, add the entry
CanCancel OpenDi agr amand set it to FALSE.

To disable the ability to prevent Rhapsody from opening the Features dialog for an element, add
the entry CanCancel OpenFeat ur esDi al og and set it to FALSE.
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If you don’t want to allow clientsto prevent any of the cancellable actions, add the entry
CanCancel Act i on and set it to FALSE.

Sample Client Applications

Sample client applications that use the callback API to respond to Rhapsody events can be found
in the Rhapsody samples directory ([installation directory]\Samples\ExtensibilitySamples\
CallbackAPI Samples).

The samples provided are written in a number of different languages.
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Quick Reference

This section lists the Rhapsody APl methods and provides a brief description of each. For ease of
use, the methods are presented in alphabetical order.

Method Name

Description

Abort

Is invoked when the user selects the Abort option du
code generation

ring

activeProject

Returns a pointer to the active (open) project

addActivityDiagram

Adds an activity diagram to the current class

addActor

Adds the specified actor to the current package

addAnchor

Adds an anchor from the annotation to the specified
model element

addArgument

Adds an argument for the operation to the end of its
argument list

addArgumentBeforePosition

Adds an argument for the operation at the specified
position in its argument list

addAttribute

Adds an attribute to the current class

addBlock

Adds a block to the current package

addClass

Adds a class to the current class

addClassifierRole

Adds a classifier role

addClassifierRoleByName

Adds a classifier role, given its name

addCollaborationDiagram

Adds a collaboration diagram to the current package

addComponent

Adds the specified component to the current project

addComponentDiagram

Adds a component diagram to the current package

addComponentinstance

Adds a new component instance

addConfiguration

Adds a configuration to this component

addConnector

Adds a connector to the statechart

addConstructor

Adds a constructor to the current class

Rhapsody

531




Quick Reference

Method Name

Description

addConveyed

Adds an information element to the conveyed
collection

addCtor

Adds a constructor

addDependency

Adds a dependency relationship to the specified object

addDependencyTo

Creates a new dependency between two objects

addDeploymentDiagram

Adds the specified deployment diagram to the current
package

addDescribingDiagram

Adds a describing diagram for the current use case

addDestructor Adds a destructor to the current class
addDtor Adds a destructor
addElement Adds an element to the current file

addEnumerationLiteral

Creates an enumeration literal

addEvent

Adds the specified event to the current package

addEventReception

Adds an event reception to the current class

addExtensionPoint

Adds an extension point to the current use case

addFile

Adds an empty file to the current component

addFlowltems

Adds the specified flowltem to the collection of flowltems

addFlows

Adds the specified flow to the collection of flows

addFolder

Adds an empty folder to the current component

addGeneralization

Adds a generalization to the current class

addGlobalFunction

Adds the specified global function to this package

addGlobalObject

Adds a global object (instance) to the current package

addGlobalVariable

Adds the specified global variable to the current package

addlnitiallnstance

Adds an instance to the list of initial instances for the
current configuration

addltem

Adds an item to the collection

addMessage

Adds a message

addNestedComponent Adds a component to the current component

addNestedPackage Adds a nested package to the current package

addNewAaqqgr Used to add a new element to the current element, for
example, adding a new class to a package

addNode Adds the specified node to the current package
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Method Name

Description

addObjectModelDiagram

Adds the specified OMD to the current package

addOperation

Adds an operation to the current class

addPackage

Adds the specified package to the current project

addPackageTolnstrumentationScope

Adds the specified package to the instrumentation scope,
including all its aggregated classes, actors, and nested
packages

addPackageToScope

Adds the specified package to the scope of the file or
folder

addProperty

Adds a new property/value pair for the current element

addProvidedInterface

Adds the specified interface to the collection of provided
interfaces

addReferenceActivity

Adds a reference activity to the activity diagram

addRelation

Adds a symmetric relation between the current class and
another one

addRepresented

Adds a flowltem to the r epr esent ed collection

addReqguiredinterface

Adds the specified interface to the collection of required
interfaces

addScopeElement

Places a model element within the scope of the current
component

addSequenceDiagram

Adds the specified sequence diagram to the current
package

addState

Adds a state to the statechart

addStatechart

Adds a statechart to the current class

addStaticReaction

Adds a static reaction to the statechart

addStereotype

Adds a stereotype relationship to the specified object

addSuperclass

Adds a superclass to the current class

addSwimlane

Adds a swimlane to the activity diagram

addSystemBorder

Adds a system border to the collaboration diagram

addTerminationState

Adds a termination state to the statechart

addTextElement

Adds text to the file

addTimelnterval

Adds a time interval to the diagram

addTimeout

Adds a timeout

addTolnstrumentationScope

Adds explicit initial instances to the instrumentation
scope
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Method Name

Description

addToModel

Adds a Rhapsody unit located in the specified file to the
current model with or without descendant elements

addToModelFromURL

Adds a Rhapsody unit located at the specified URL to the
current model

addToScope

Places the specified file, classes, and packages within
the scope of the current component

addTransition

Creates a transition

addTriggeredOperation

Adds a triggered operation to the current class

addType

Adds a type to the current class

addUnidirectionalRelation

Adds a directional relation from the current class to
another class

addUseCase

Adds the specified use case to the current package

addUseCaseDiagram

Adds the specified UCD to the current package

allElementsinScope

Places all model elements within the scope of the current
component

arcCheckOut

Checks out files from the CM archive into the model

becomeTemplatelnstantiationOf

Creates a template instantiation of another template (of
another template class)

build

Builds the application

checkEventsBaseldsSolveCollisions

Checks the values of the events base IDs for all
packages in the model, detects collisions between the
IDs, and resolves any incorrect values and collisions

checklin Checks in the specified unit within the model into the CM
archive you have already connected to (using
connect ToAr chi ve)

checkModel Checks the current model

checkOut Refreshes a unit in the model by checking it out from the
CM archive

clone Clones the element, names it, and adds it to the new
owner

close Closes a file or project

connectToArchive

Connects the Rhapsody project to the specified CM
archive

createDefaultTransition

Creates a default transition in the statechart

createGraphics

Creates graphics in the Rhapsody statechart

createNestedStatechart

Creates a nested statechart
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Method Name

Description

createNewProject

Creates a new project named <projectName> in
<projectLocation>

deleteActivityDiagram

Deletes the specified activity diagram from the current
class

deleteActor

Deletes the specified actor from the current package

deleteArgument

Deletes an argument from the current operation

deleteAttribute

Deletes the specified attribute from the current class

deleteClass

Deletes a class from the current class

deleteCollaborationDiagram

Deletes the specified collaboration diagram from the
current package

deleteComponent

Deletes the specified component from the current project

deleteComponentDiagram

Deletes the specified component diagram from the
current package

deleteComponentinstance

Deletes the specified component instance

deleteConfiguration

Deletes the specified configuration from the current
component

deleteConnector

Deletes the specified connector from the statechart

deleteConstructor

Deletes a constructor from the current class

deleteDependency

Deletes a dependency

deleteDeploymentDiagram

Deletes the specified deployment diagram from the
current package

deleteDescribingDiagram

Deletes the describing use case or sequence diagram for
the current use case

deleteDestructor

Deletes a destructor from the current class

deleteEntryPoint

Deletes the entry point of the current use case

deleteEvent

Deletes the specified event from the current package

deleteEventReception

Deletes the specified event reception from the current
class

deleteExtensionPoint

Deletes the specified extension point

deleteFile

Deletes the specified file from the current component

deleteFlowchart

Deletes an activity diagram from the current operation

deleteFlowltems

Deletes the specified flowltem from the collection of
flowltems

deleteFlows

Deletes the specified flow from the collection of flows
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Method Name

Description

deleteFromProject

Deletes the current model element from the project open
in Rhapsody

deleteGeneralization

Deletes the specified generalization from the current
class

deleteGlobalFunction

Deletes the specified global function from the current
package

deleteGlobalObject

Deletes the specified global object from the current
package

deleteGlobalVariable

Deletes the specified global variable from the current
package

deletelnitiallnstance

Deletes an instance from the list of build instances for the
current configuration

deleteNode

Deletes the specified node from the current package

deleteObjectModelDiagram

Deletes the specified OMD from the current package

deleteOperation

Deletes the specified operation from the current class

deletePackage

Deletes the current package

deleteRelation

Deletes the specified relation from the current class

deleteSequenceDiagram

Deletes the specified sequence diagram from the current
package

deleteState

Deletes the specified state from the Rhapsody statechart

deleteStatechart

Deletes the specified statechart from the current class

deleteStaticReaction

Deletes the specified static reaction from the statechart

deleteSuperclass

Deletes a superclass from the current class

deleteTransition

Deletes a transition

deleteType

Deletes a type from the current class

deleteUseCase

Deletes the specified use case from the current package

deleteUseCaseDiagram

Deletes the specified use case diagram from the current
package

enterAnimationCommand

Specifies the command to begin animation

errorMessage

Returns the most recent error message

Exit

Is invoked before Rhapsody exits

findActor

Retrieves the specified actor, if it belongs to the current
package

findAlIByName

Searches all the elements and finds the first element of
the specified name and metaclass in the current package

536

API| Reference Manual




Method Name

Description

findAttribute

Retrieves the specified attribute of the classifier

findBaseClassifier

Retrieves a base (parent) classifier of a classifier

findClass

Retrieves the specified class, if it belongs to the current
package

findComponent

Retrieves the specified component from the current
project

findComponentinstance

Retrieves the specified component instance

findConfiguration

Retrieves the specified configuration in the current
component

findDerivedClassifier

Retrieves the specified derived classifier of a classifier

findElementsByFullName

Searches for the specified element

findEntryPoint

Deletes the specified entry point

findEvent

Retrieves the specified event, if it belongs to the current
package

findExtensionPoint

Retrieves the extension point, given the generalization

findGeneralization

Retrieves the specified generalization of a classifier

findGlobalFunction

Retrieves the specified global function, if it belongs to the
current package

findGlobalObject

Retrieves the specified global object, if it belongs to the
current package

findGlobalVariable

Retrieves the specified global variable, if it belongs to the
current package

findinterfaceltem

Retrieves an operation or event reception of the given
signature that belongs to a classifier

findNestedClassifier

Retrieves the specified classifier defined within this
object

findNestedClassifierRecursive

Retrieves the specified classifier defined in this object
and in objects defined within this object

findNestedElement

Retrieves the specified element nested in a model
element

findNestedElementRecursive

Retrieves the specified element from a given model
element at any level of nesting within that element

findNode

Retrieves the specified node, if it belongs to the current
package

findRelation

Retrieves the specified relation that belongs to the
current classifier

findTrigger

Retrieves the specified trigger in the statechart of the
current class
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Method Name Description
findType Retrieves the specified data type, if it belongs to the
current package
findUsage Retrieves the usage of the specified element in the

current package

findUseCase

Retrieves the specified use case, if it belongs to the
current package

forceRoundtrip Forces a roundtrip of the code back into the Rhapsody
model, and vice versa
generate Generates code for the active configuration of the active

component

generateSequence

Generates the specified sequence diagram

getConcurrentGroup

Retrieves the activation messages

getAllGraphicalProperties

Returns the list of graphical properties for the current
diagram

getAllTriggers

Returns a collection of all the triggers for the current
statechart

getAttributesincludingBases

Retrieves the attributes defined for this class and the
ones inherited from its superclasses

getClassifierRole

Retrieves the classifier role for this message point

getClassifierRoles

Returns a collection of | RPCl assi fi er Rol es linked
by the current association role

getConcurrentGroup

Retrieves all the messages concurrent with the input
message, including the input message itself

getDerivedInEdges

Retrieves the incoming transitions for the connector

getDerivedOutEdge

Retrieves the incoming transitions for the connector

getDescribingDiagram

Retrieves the use case diagram or sequence diagram
linked to the current use case

getDiagramOfSelectedElement

Retrieves the diagram of the current element

getDirectory

Retrieves the build directory specified for the current
configuration

getElementsinDiagram

Returns a collection of all the model elements in the
current diagram

getErrorMessage Returns the most recent error message

getEvent Returns the event for the current event reception that
serves as part of the interface for a class

getFile Returns the file in which the specified classifier will be
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Method Name

Description

getFileName

Retrieves the name of the file to which the specified
classifier will be generated in this component

getFormalRelations

Returns a collection of | RPRel at i ons for the current
association role

getFullNamelnStatechart

Returns the full text name of this state within its
statecharts

getFullPathName

Retrieves the full path name of a model element as a
string

getFullPathNameln

Retrieves the full path name of a model element as a
string

getGraphicalProperty

Returns the specified graphical property for the current
diagram

getimpName

Retrieves the name of the current file's implementation
file, including its extension and, if specified, its relative
path

getinheritsFrom

Returns the base state from which the current state
inherits

getinLinks

Returns the list of links for which the instance is the
target instance (identified by the “to” property of the link)

getinterfaceltemslincludingBases

Retrieves the operations and event receptions defined
for this class and the ones it inherited from its
superclasses

getinTransitions

Returns a collection of transitions that are directed into
the current state or connector

getltsAction

Returns the action code of the current transition

getltsComponent

Retrieves the component to which the current
configuration belongs

getltsGuard

Returns the guard condition of the current transition

getltsOperation

Returns the event or triggered operation of the current
trigger

etltsTrigager

Returns the trigger (event or triggered operation) of the
current transition

getlListOfFactoryProperties

Returns the list of properties in the
<l ang>_f actory. pr p file

getListOfInitializerArguments

Returns the list of arguments for the initializer, as defined
by the user in the instance features dialog box

getListOfSelectedElements

Returns the collection of model elements

getlListOfSiteProperties

Returns the list of properties in the
<l ang>_site. prpfile

getLogicalCollaboration

Retrieves the logic behind the collaboration diagram
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Method Name

Description

getLogicalStates

Retrieves the list of logical states

GetMainFileName

Is invoked when Rhapsody needs the main file name and
path for a configuration

getMainName

Retrieves the name of the file where the mai n() routine
for the current configuration resides

getMakefileName

Retrieves the name of the makefile generated for the
current configuration

getMessagePoints

Returns an ordered collection of all messagepoints
occurring on this classifier

getModelElementFileName

Gets the file name of the specified model element

getNestedElements

Retrieves the elements defined in the current object

getNestedElementsRecursive

Recursively retrieves the elements defined in the model
element for the object and for objects defined in it

getNewCollaboration

Retrieves the new collaboration for the current project

getOfState

Returns the state connected to the current connector if it
is a history connector

getOutLinks

Returns the list of links for which the instance is the
source instance (identified by the “from” property of the
link)

etOutTransitions

Returns a collection of transitions that are directed out of
the current state or connector

getOverriddenProperties

Retrieves the list of properties whose default values have
been overridden

getPackageFile

Returns the package file

getPicture

Renders this diagram into the specified extended
metafile

getPictureAsDividedMetafiles

Enables you to split a large diagram into several
metafiles when you export it

getPredecessor

Retrieves the message that precedes the specified
message

getPropertyValue

Returns the value associated with the specified key value

getPropertyValueExplicit

Returns an explicit value if it has been assigned to the
metamodel

getRelationsincludingBases

Retrieves the relations defined for this class and the
ones it inherited from its superclasses

getRelatedUseCases

Retrieves use cases related to the current sequence
diagram

getSelectedElement

Retrieves the current model element
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Method Name

Description

getSignature

Retrieves the prototype of the | RPMessage

getSignatureNoArgNames

Retrieves the signature of the current class interface
element without argument names

getSignatureNoArgTypes

Retrieves the signature of the current class interface
element without argument types

getSpecName

Retrieves the name of the current file's specification file,
including its extension and, if specified, its relative path

getStaticReactions

Returns a collection of static reaction transitions
originating from the current state

getSubStates Returns a collection of substates belonging to the current
state
getSuccessor Retrieves the message that follows the specified

message

GetTargetfileName

Is invoked when Rhapsody needs the target name and
path for a configuration

getTargetName

Retrieves the build name of the file to be generated for
the current configuration

getTheExternalCodeGeneratorinvoker

Returns the invoker for the external code generator

highlightByHandle

Highlights an element, given its handle

highlLightElement

Highlights the specified element

importClasses

Imports classes according to the reverse engineering
setting stored in the current configuration

importPackageFromRose

Imports the specified package from Rational Rose

importProjectFromRose

Imports the specified project from Rational Rose

isAnd Determines whether this state is an And state
isArray Determines whether the current type is an array
isCompound Determines whether the current state is a compound

state

isConditionConnector

Determines whether the current connector is a condition
connector

isDefaultTransition

Determines whether the current transition is a default
transition

isDiagramConnector

Determines whether the current connector is a diagram
connector

isEmpty Determines whether the current file is empty
isEnum Determines whether the current type is an enumerated

type
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Method Name Description
isEqualTo Tests for equality between the type of the type and the
type itself
isForkConnector Determines whether the current connector is a fork synch

bar connector

isHistoryConnector

Determines whether the current connector is a history
connector

isimplicit

Determines whether the type is an implicit type

isJoinConnector

Determines whether the current connector is a join synch
bar connector

isJunctionConnector

Determines whether the current connector is a junction
connector

isKindEnumeration

Determines whether the type is an enumeration

isKindLanguage

Determines whether the type is a language declaration

type

isKindStructure

Determines whether the type is a structure

isKindTypedef

Determines whether the type is at ypedef

isKindUnion Determines whether the type is a union

isLeaf Determines whether the current state is a leaf state

isOperation Determines whether the current trigger is an operation
(event or triggered operation)

isPointer Determines whether the current type is a pointer

isPointerToPointer

Determines whether the current type is a pointer to
another pointer

isReadOnly Determines whether the current unit is read-only
isReference Determines whether the current type is a reference

isReferenceToPointer

Determines whether the current type is a reference to a
pointer

isRoot

Determines whether the current state is a root state

isSeparateSaveUnit

Determines whether the current unit is saved in its own
(separate) file

isStaticReaction

Determines whether this is a static reaction

isStruct Determines whether the current type is a St r uct

isStubConnector Determines whether the current connector is a stub
connector

isTemplate Determines whether the current type is a template
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Method Name

Description

isTerminationConnector

Determines whether the current connector is a
termination connector

isTimeout

Determines whether the current trigger is a timeout

isTypelessObject

Tests an object to see if it is defined explicitly or implicitly

isUnion

Determines whether the current type is a union

itsCompoundSource

Returns a collection of states that act as multiple sources
for this single transition

oad

Loads the specified unit

make

Builds the current component following the current
configuration

makeUnidirect

Changes the current relation from a unidirectional
(symmetric) one to one that is directional from the ne of
this relation to ne’s inverse

matchOnSignature

Determines whether the signature of the current class
interface element matches that of another
| RPI nterfaceltem

notifyGenerationDone

Is called by the external code generator after a
generation session invoked by the gener at e event is
done

open

Opens a file

openProject

Opens a Rhapsody project

openProjectFromURL

Opens the Rhapsody product at the specified URL

openProjectWithl astSession

Opens the project using the settings from the previous
Rhapsody session

openProjectWithoutSubUnits

Opens the Rhapsody project without subunits

overridelnheritance

Overrides inheritance for the current state

quit Closes the active Rhapsody project
rebuild Rebuilds the application

recalculateEventsBaseld

Recalculates the events base ID of the package or
project

refreshAllViews

Refreshes all the views

regenerate

Regenerates the active configuration of the active
component

removeConveyed

Removes an information element from the conveyed
collection

removeFrominstrumentationScope

Removes the classifier from the instrumentation scope
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Method Name

Description

removePackageFromlinstrumentationSc

ope

Removes the specified package from the instrumentation
scope. including all its aggregated classes, actors, and
nested packages

removeProperty

Removes the property from the model element

removeProvidedInterface

Removes the specified interface from the collection of
required interfaces

removeRepresented

Removes a flowltem from the r epr esent ed collection

removeRequiredInterface

Removes the specified interface from the collection of
required interfaces

removeScopeElement

Deletes a scope element

removesStereotype

Removes the stereotype from the model element

report

Generates a report in ASCII or RTF into the specified file

reseteEntryActioninheritance

Resets the inheritance of the entry action of the current
state

resetExitActioninheritance

Resets the inheritance of the exit action of the current
state

resetlLabellnheritance

Resets the label inheritance

roundtrip Roundtrips code changes back into the open model
save Saves the current project
saveAs Saves the current project to the specified file name and

location

setActiveComponent

Sets the active configuration for the current project

setActiveConfiguration

Sets the active configuration for the current project

setClassType

Sets or changes the current template parameter to a
class type parameter

setComponent

Sets the current component for the open project

setConfiguration

Sets the current configuration for the open project

setDirectory

Sets the directory for the current configuration

setEndl1ViaPort Connects end1 of the flow to the specified instance via
the given port (defined by the instance class)
setEnd2ViaPort Connects end?2 of the flow to the specified instance via

the given port (defined by the instance class)

setGraphicalProperty

Allows the setting of graphical properties for a diagram
element.

setinverse

Adds or updates the inverse relation

setltsAction

Updates the current transition with a new action
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Method Name

Description

setltsComponent

Sets the owning component for the current configuration

setltsGuard

Updates the current transition with a new guard

setltsLabel

Updates this transition with a new label (trigger[guard]/
action)

setltsTrigger

Updates the current transition with a new trigger

setLog Creates a log file that records all the information that is
normally displayed in the Rhapsody output window

setOfState Updates the source state of the current connector with a
new state

setPath Sets the path of the application built for this component

setPropertyValue

Modifies the value of the specified property

setReadOnly

Specifies whether the current unit is read-only

setReturnTypeDeclaration

Specifies a new value for the return type declaration

setSeparateSaveUnit

Sets a unit to be stored to its own file

setStaticReaction

Sets the static reaction for the current state

setTypeDeclaration

Sets the C++ type declaration for this argument

synchronizeTemplatelnstantiation

Is used to synchronize between a template and a
template instantiation parameter

unoverridelnheritance

Removes the override inheritance for the current state

version Returns the version of Rhapsody that corresponds to the
current COM API version

WhoAml Is invoked to identify the external code generator

write Writes to the specified file
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